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Eureka
Eureka

OVERVIEW

Eureka is an independent software package used in conjunction with DPAS to enable users the 
capabilities to view pre-existing reports, perform ad hoc queries, analyze data, and create simple to 
sophisticated reports from within a Microsoft Office Desktop environment.

Documents may begin as a simple QuickQuery and evolve into sophisticated FreeForm presentations.

Eureka offers two ways to create documents:

QuickQuery - provides you a set of interactive tools that let you view data as you build your 
query in a spreadsheet-like environment.  It provides the fastest way to build design 
documents whose content is limited to column values and custom calculations.  You can add 
page headers and footers.  You can group data and include totals for each group. QuickQuery 
also lets you define and store multiple query filters and apply them individually or in 
combination with each other.

FreeForm - allows you the ability to lay out your document without the constraints of 
QuickQuery.  You can add page headers and footers, document headers and footers and 
group headers, and other types of document areas.  Using the FreeForm function, you will 
develop a customized report, with the capability to make that report as simple or complex as 
necessary.  FreeForm allows you the freedom to design all aspects of the report.

Both QuickQuery and FreeForm offer a step-by-step Wizard in designing reports.

Design documents can be quick and simple, composed of just a few unformatted database columns 
arranged in rows.  They can be complex, highly formatted documents that include charts and 
crosstabs as well as other documents.  When you create output documents, Eureka creates and 
submits database queries.  A document may include one query or several.

Eureka Reporter Designer comes packaged for DPAS in these editions:

Reporter Designer - gives you both interactive QuickQuery tools and powerful FreeForm 
tools to create queries, reports, charts, and crosstabs.

Reporter Viewer - lets you submit queries for already defined documents and view, print, 
export, and save the results.  The Reporter Viewer is designed for users that do not have 
Eureka installed.
CH 1 385
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Eureka
OBJECTIVES

This course is designed for you to develop progressively greater competencies in the use of the Eureka 
Reporter Designer.

Upon completing this course, you should be proficient in the use of Eureka to retrieve from DPAS, the 
information necessary to accomplish your assigned duties.
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Learning To Use Eureka

The process of creating a document using Eureka is as simple as defining the objects you want to 
appear on your document and placing them on the document.  Eureka also includes many advanced 
query design features.

Terminology

Eureka  has its own set of data base terminology, such as areas, area objects, hot objects, iqo, iqr, 
etc.  These will be explained during the course of this training.

Mouse Terminology

This is the terminology used for mouse actions:

Term Action

Click Move the mouse pointer to an object.  Then press and release the left mouse button (without 
moving the mouse).

In Eureka, clicking an object selects it or deselects it.  When an object is selected, menu items 
and keyboard actions affect that object (unless they are global actions).

Double-click Move the mouse pointer to an object.  Then press and release the left mouse button twice in 
rapid succession, without moving the mouse pointer.

In Eureka, double-clicking opens a dialog box that lets you define or change the object you 
have double-clicked.

Drag Move the mouse pointer to an object, press and hold the left mouse button.  Then move the 
mouse and release the mouse button at a new location.  The object moves to the new location.

In Eureka, you can drag objects to move them, to add them to your document, and use them 
in many dialog boxes

Right-click Move the mouse pointer to an object.  Then press and release the right mouse button without 
moving the mouse.

In Eureka, a right-click opens a shortcut menu.  This is a menu of actions associated with the 
object on which you right-click.

CTRL+click Hold down the CTRL key while you press and release the left mouse button.

In Eureka, this selects an object for further manipulation without deselecting any already  
selected objects.

SHIFT+click Hold down the SHIFT while you press and release the left mouse button.  Whenever you are 
selecting items from a list that allows more than one item to be selected, you can use 
SHIFT+click to select a range of items.  Click the first item and then SHIFT+click the last 
item.  Eureka selects the two items you click and all items in between them in the list.
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On-Line Help

The help system in Eureka includes a list of frequently asked questions.

To view the description and help information for a specific object in an object directory, move 
the mouse pointer to the object and then press and hold down the right mouse button.

To get help in a dialog box, press the F1 Function Key or select the Help button.

To get help in a Eureka window, press the F1 Function Key or select Help from the menu 
bar.

To view the frequently asked questions list, open the help system and select Frequently 
Asked Questions from the contents page.

When you are using the help system, these shortcuts are available:

There is a Chapter menu included as part of the help system menu bar.  Use it to go directly to 
another chapter.

Use CTRL+PAGE UP and CTRL+PAGE DOWN to go through a chapter page by page.  You 
can use the browse buttons on the toolbar (< and >) to do this.

Use the icons above each topic title to help you find topics and navigate the help system.  See 
the help topic Hints for Using Help for information about using these icons.

Using the Context Help Button

To get help on anything that is displayed in the Eureka window, select the Context Help button from 
the toolbar.  When you do so, your pointer changes to look like the Context Help button.  You can 
then click any part of the Eureka window, including a menu selection, toolbar button, an so on, to get 
help on that item.

Object Help

To see a description of a business view, folder, or column shown in the object directory, place the 
mouse pointer on the object.  Eureka displays a help message for the object.
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Changing Your Eureka Password

INTRODUCTION

This process will show you the procedures used to change your password in Eureka  Anytime you 
change your login or password for DPAS, you must also change them to the same for Eureka.  When 
you change your password in DPAS, you will get a pop-up message to change your password in 
Eureka.

OBJECTIVES

To allow the user to understand when and how to change the Eureka password.

APPLICATION

You have just changed your DPAS password and now you need to change it in Eureka.

PREREQUISITES

Eureka Reporter Designer is correctly loaded and configured.

ACTIVITY

Instructor-led demonstration

STEPS TO PERFORM ACTION

1. Select Ad Hoc Reports icon or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

STEP 1:

• If you get the wizard, click Finish; 
otherwise, go to the next step.
CH 1 389
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Changing Your Eureka Password
STEP 2:

a. From the menu bar, select Tools.
b. Select Database Connection Defaults...

STEP 3:

a. Data Source:  Make sure that your DPAS Site 
ID is displayed.

b. Login ID:  Make sure that your DPAS User ID 
is displayed.

c. Password:  Enter your NEW DPAS password.
d. Server Name:  Leave this field blank.
e. Database Name:  Leave this field blank.
f. Prompt For Data Source at Runtime:  Do 

not check this box.  If checked, you will be 
prompted to enter your DPAS Site ID each time 
you run a report.

g. Default Metadata File:  Browse for where 
the DPAS programs reside on you workstation.  
If all the defaults were taken during 
installation, then the path is normally:  
C:\Program Files\DOD\DPAS\DPAS.iqk.

If you are unable to locate the DPAS.iqk file, click on the START button, select Find (or Search if using 
Windows ME or 2000), Files or Folders..., enter dpas.iqk look in the Local Hard Drives.

h. Server Name:  Leave this field blank.
i. Host Name:  Leave this field blank.
j. Click OK.
CH 1 390
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Setting Preferences

INTRODUCTION

Eureka gives you control over your working environment in the following areas:

• Which tools are displayed for use in report design windows
• The appearance of windows and objects in them
• General preferences and database connection preferences

PREREQUISITES

None

STEPS TO PERFORM ACTION

1. Open or create a FreeForm report.
2. Select Tools from the menu bar.
3. Select Preferences… from the program group.

STEP 1:

a. Defaults Group Box:  Make any necessary 
changes.

NOTE:
Preferences in the Eureka dialog box 
are global - they apply to all documents 
by default unless otherwise specified.
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b. Display Group Box:  If desired, make any changes to the display.

Defaults Display

Use 
Query 
Wizard

This controls whether the New Document tool-
bar button starts the Query Wizard or whether 
it opens an empty new window for you to add 
columns and objects directly.  It also controls 
the default for Use Query Wizard in the New 
Document dialog box.

Display Null 
Data As

By default, Eureka displays null values as 
blanks or spaces.  If you want null values 
to be output differently, such as NULL or 
N/A, enter the string you want Eureka to 
output.

Use TM1 
Cube 
Wizard 
On New

This controls whether the New Document tool-
bar button starts the TM1 Cube Wizard or 
whether it opens an empty new window for 
you to add columns and objects directly.  It 
also controls the default for Create TM1 Cube 
in the New Document dialog box.  This option 
is not available in DPAS.

Display Scale This controls the scaling of objects in 
FreeForm windows and output windows.  
Eureka always attempts to display objects 
at actual size.  To compensate for some 
video drivers for your monitor, you might 
need to adjust the scale up or down.  
Values less than 131 reduce the size of 
objects displayed while values greater 
than 131 increase the scale.  Values 
smaller than zero or extremely large will 
probably cause problems.  The value of 
131 is the default.

Manual 
Re-query

This should be used if you do not want Eureka 
to re-query your database automatically every 
time you add another column while working in 
QuickQuery window.

Restore 
File On 
Entry

This controls what Eureka does when it starts 
up.  When this option is active, Eureka opens 
all files that were open when you last ended a 
Eureka session.  When it is not active, your 
session opens a new window depending on 
your setting for Default to QuickQuery View.

Print 
Charts 
Using 
Patterns

This will print colors in a chart as patterns 
when printing to a non-color printer.

Default 
To Quick-
Query 
View

This controls whether the New Document dia-
log box defaults to QuickQuery or FreeForm as 
the window type to open for a new design doc-
ument.  It also controls whether the New Doc-
ument toolbar button creates/opens a 
FreeForm window or a QuickQuery window.

Discon-
nect 
Between 
Queries

This causes Eureka to disconnect from your 
database after each query.  This may make 
each query after the first one in a session take 
a little longer to get started, but may be neces-
sary if your database allows only a limited 
number of connections.  This is not typically 
necessary with DPAS.
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c. Object Placement Group Box:  If desired, change the Object Placement preferences.
d. Query Group Box:  If desired, change the Query preferences.

e. Click OK.

Object Placement Query

Auto Headings This causes Eureka to automatically add 
column headings to your document as 
you add column objects in FreeForm 
windows.  It adds a text object to your 
page heading area(s) each time you 
add an object (text, column, custom, 
and system).  The heading text is the 
object label that can be changed in the 
object's attribute dialog box.

Report Row 
Limit

Acts as a global default for limiting the 
number of rows Eureka gets from DPAS.  
Use zero to indicate that no row limit is to 
be set for your document (zero is the 
default).

Predefined 
Objects

This causes Eureka to open the object 
attributes dialog box for each new 
object as you place it on your docu-
ment.  This makes the process of defin-
ing the object and places the object as 
a single action.  This option applies to 
text, child data, column, custom, user 
prompt, and system objects.

Time Limit Acts as a global default for the time limit 
for query processing.  Use zero to indicate 
that no time limit is to be set.  However, 
DPAS has a time limit on inactivity of 45 
minutes.

Prompt Row 
Limit

This controls how many rows (values) are 
retrieved from the database when a 
dynamic choice list is generated for a user 
prompt.

Use Aliases This controls whether an alias reference 
should be used for all tables queried.  
DPAS uses aliases, so this option should 
remain turned on.

Trace ODBC 
Calls

You can use ODBC call tracing to provide a 
log of ODBC calls and the result of each.  
This may allow you to determine the cause 
for any database access problems you may 
have.

Browse Row 
Limit

This controls how many rows (values) are 
retrieved from the database when you 
select the Browse button in an object 
directory or object source.

Trace File This is the name of the file to which to log 
database calls.  This should be left blank.
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Getting Oriented With The QuickQuery Window

INTRODUCTION

In this Chapter we will begin producing reports and queries using the QuickQuery process.  You will 
see a window and toolbars that may be new to you.  This lesson will familiarize you with the terminol-
ogy and function of the Eureka QuickQuery window environment.

OBJECTIVES

The student will be able to identify the parts and explain the functions of the QuickQuery window and 
the associated toolbars.

APPLICATION

Understanding the QuickQuery window and associated toolbars is necessary for you to further your 
understanding of the QuickQuery process.

PREREQUISITES

Eureka Reporter Designer is correctly loaded and configured.

ACTIVITY

Instructor-led lecture

This is an example of a QuickQuery Window:

Title BarMenu Bar
Standard Toolbar

Formatting Toolbar
QuickQuery Objects Toolbar

QuickQuery Queries Toolbar

Status Bar
CH 2 11
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Opening A New QuickQuery Report

INTRODUCTION

QuickQuery is a fast, interactive way to shape your query/report while viewing the data it returns in a 
spreadsheet-like layout.  QuickQuery is an excellent tool if your intention is to create a query for 
yourself in order to answer a question, or to prepare a report that is to convey information, but will be 
used internally by you and your organization.  It is the easiest and most structured method to develop 
that information.

OBJECTIVES

To create a query/report using the QuickQuery function both with and without the QuickQuery 
Wizard.

APPLICATION

You need to create a basic report quickly.  You do not need anything fancy or complex.  For example, 
you are asked to provide a list of items on your property book that are under the $5000 minor 
property threshold.

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

ACTIVITY

Instructor-led demonstration
CH 2 12
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Opening A New QuickQuery Report
STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

-OR-

3. From you computer desktop, double-click the Eureka Reporter Designer icon.

The Query Wizard will display:

4. Click Finish if you do not want to use the Query Wizard.  This will take you into QuickQuery.

NOTE:
If you do not have a shortcut to Eureka on your desktop, then click Start>Programs> 
Eureka Reporter Designer.
CH 2 13
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If you are already in QuickQuery and you want to open a new report:

STEP 1:

a. Select File from the menu bar.
b. Select New... from the program group.

STEP 2:

a. View As:  The default is QuickQuery.  If you 
want to create a report in FreeForm, select that 
radio button.

b. Create TM1 Cube:  NEVER select this check 
box; DPAS does not support this.

c. Use Wizard:  If you want to create a new 
QuickQuery or FreeForm report using the Wizard, 
then leave this box checked; otherwise, uncheck 
it.

d. Click OK.
CH 2 14
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Building A QuickQuery With The Query Wizard

INTRODUCTION

This section outlines building QuickQuery reports by using the Query Wizard.  The query wizard is the 
easier way to create a query and takes you step-by-step through:

Using the query wizard produces a spreadsheet-type report or query.

OBJECTIVES

Using the QuickQuery Wizard, you will develop a spreadsheet-type of report with columns of data 
(detail) that have been filtered, sorted, and aggregated (totaled for the column).  You will present a 
sample page of this finished report to your instructor.

APPLICATION

This type of query can be used when you need a simple report fast.  For example, you want to build 
a simple report that displays certain data fields for your Hand Receipt Holders.

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

ACTIVITY

Instructor-led demonstration

STEP 1:  Select Query Type STEP 4:  Select Columns to Sort By

STEP 2:  Select Columns STEP 5:  Select Columns to Aggregate

STEP 3:  Setting Column Filters STEP 6:  Select QuickQuery Style Profile
CH 2 15
1 October 2004



Building A QuickQuery With The Query Wizard
REPORT TYPE

A complete asset listing by UIC/Major Hand Receipt Holder showing stock number, bar code, 
nomenclature, and acquisition cost of each asset.

This is a sample of a QuickQuery report that will be built in this demonstration:

STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.
CH 2 16
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Building A QuickQuery With The Query Wizard
STEP 1 Select Query Type:

a. Select the type of query you would like.

b. Click Next>.

STEP 2 Select Columns:

a. From the Object Directory, select the Business 
View you wish to use to build your columns.

To select the fields, you can:

• Double-click each field and the field will 
move to the Column Window at the right.

• Click, drag and drop each field to the 
Column Window at the right.

• To select multiple fields, hold the CTRL 
key down and select the desired fields 
(DO NOT LET UP ON THE CTRL KEY).  
Click, drag and drop to the Column 
Window at the right.

b. Click Next>.

Query Types

Detail Detail queries return detailed data without any 
aggregate functions applied, the aggregate 
functions being average, count, minimum, 
maximum, and sum.

Summary Summary queries are useful when you want to 
summarize data for a number of different items.

Grouped 
Detail

Grouped detail queries let you view the query 
results grouped by one or more columns.

Overall 
Summary

Overall summary queries give the highest level 
view of your data.

Create 
TM1 Cube

This is not available.
CH 2 17
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Eureka Object Directories

Object directories make it easy to add columns to your documents and dialog boxes.  Eureka Reporter 
Designer includes an object directory in QuickQuery and Free Form windows.  The main object directory 
can be docked or floating.  You can hide and unhide it by selecting from the menu bar View>Object 
Directory or by using the F2 key on your keyboard.

Business View.  Business view names are at the top level of the 
tree and are indicated in ALL CAPS.  A business view is an object 
in your Metadata File that corresponds to the data for a particular 
part of your business.

Folders.  A folder can correspond to a table in your database or 
it can be made up of columns from more than one table.  It can 
also include custom objects--objects that are calculated from 
database columns.

Data Objects.  These are the actual data elements that are used to make up your report.

In this class, we will be referring to tables (pictured above) that will direct you to the Business View, 
Folders, and Data Elements that you will use in order to complete any activities and/or exercises.

STEP 3A Select Column Filters:

a. From your list of selected fields, double-click or 
drag and drop the data field(s) you want your 
query to sort on.

NOTE:
You cannot select fields from 2 different Business Views (such as, END ITEM SERIAL and 
END ITEM BULK) on one report unless you are writing a Parent/Child report.

NOTE:
Filters let you limit the data displayed to 
only that which meets the criteria you 
set.  When a query has no filter, you will 
see ALL the data from your database.  
When you define a filter condition, you 
will limit the data that meets the 
condition.  Every additional filter or 
filter condition you apply further 
narrows the view of your data
CH 2 18
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b. The default operator is equal to (=).  If you want to change the default, click on the equal sign (=) 
and you will get a drop down list box which contains the other operators.  To delete a filter condition, 
select it (by clicking the X or check mark under OK) and press the DELETE key.

c. Enter the condition that needs to be met under Value 1.  If you are using the Between operator, 
then you will need to enter values in Value 1 and Value 2.

d. Click Next>.

By default, all the conditions of your query are AND operators (i.e., all conditions have to be met before it 
will return your results).  However, you can connect your statements with OR operators, which divide your 
statements into groups.  For example, if you wanted to set your conditions by Stock Number AND 
Serial Number OR Bar Code, the OR’d Group would be set to 0 (zero) for Stock Number and Serial 
Number, and set to 1 for Bar Code.

The RULE is…If the OR’d Group numbers on any two statements are the same, those two statements 
are connected by the AND condition.  If the OR’d Group numbers on any two statements are different; 
those two statements are connected by the OR condition.

Operators Definitions

Equals (=) When you want the result to equal the value entered.

Not Equal To (<>) When you want the result not equal to the value entered.

Less Than (<) When you want the result to be less than the value entered.

Less Than or Equal To (<=) When you want the result to be less than or equal to the value entered.

Greater Than (>) When you want the result to be greater than the value entered.

Greater Than or Equals To 
(>=)

When you want the result to be greater than or equal to the value entered.

Between When you want the result to be between the range of values entered – this will include 
the values entered.  Example:  Bar Codes between 56012 and 80921.

Like Same as =, but allows the use of wildcards.  (Example:  if you wanted all Stock Nbr start-
ing with 7, the statement would be “STOCK NBR like (operator) and 7*(value 1)).”

Not Like Opposite of Like.

In When looking for specific values in a field (example:  FSC In 7025, 7030.  This will display 
records with those values).  Cannot be used with the wildcard (* or %).  A comma must 
separate inputs (example:  15,16,170).

Not In Opposite of In.

Is Null When you want the result to not have a value. This can be done using numerical fields.  
No value; not even a space, can exist in a field.

Is Not Null When you want the result to contain a value.  This can only be done using numerical 
fields.  Must have a value in the field.

CAUTION!
TURN YOUR CAPS LOCK ON!!!!!  DPAS stores all data in uppercase.

ALL VALUES ARE CASE-SENSITIVE!!
CH 2 19
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STEP 4 Select Columns to Sort By:

a. From your list of selected fields, double-click on 
the data field(s) you want your query to be sorted 
by.  To de-select a field, highlight the field you 
want to de-select and click on the arrow that 
points to the left.

b. Click Next>.

STEP 5 Select Columns to 
Aggregate:

a. Click Entire Document.  You will not be able to 
click any of the check boxes unless this step is 
performed.

b. Check the field(s) you want to total.
c. Click Next>.

HINT!
Once you have selected your columns, you 
can click on Order button and change how 
you want your query to sort.  For example, it 
would be either A-Z or Z-A.

NOTE:
Only pure numeric fields can be summed or averaged.

When using the Count, you will get the total number of records returned from your query.

When you are counting a data field, if you desire to get a count of ALL assets, you must count 
on a mandatory data field, such as Acq Cost.  You would ony count on an optional field, such as 
Bar Cd, if you wanted to know how many bar codes you had.

Use this to de-select a field
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Building A QuickQuery With The Query Wizard
STEP 6:

This screen will allow you to choose from a style 
profile that was previously created.

• Click Finish.

Your report should look similar to the following:
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Saving Your Query
Saving Your Query

INTRODUCTION

When you have created a file, which is useful, you might want to save that file to use the format 
again.  By using the Save command, you can save the active window to a new or the same name.  By 
using the Save As command, you can save the active report to a new name.

OBJECTIVES

Use Save and Save As to create and update your files.

APPLICATION

Self-explanatory

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

Understand the layout of DPAS file structure, and complete the Orientation section of this manual.

ACTIVITY

Instructor-led demonstration.

STEPS TO PERFORM ACTION

1. Select File from the menu bar.

2. Select  or select Save… from the program group.

NOTE:
There are two ways to save your query.  You can save the design (report format) or the output 
(data).

If you save the design, this will allow you to update and rerun your query at a later time.  If you 
save the output, then you are essentially saving the data and it cannot be updated.
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Printing Your Query

INTRODUCTION

If you want a hard copy printout of your query, you will need to use the print function.  Eureka uses 
the Windows common dialog box, the same as any other Windows-based product.

OBJECTIVES

To learn how to, and to print out a copy of a Eureka report.

APPLICATION

Self-explanatory

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

Understand the layout of DPAS file structure, and complete the Orientation section of this manual.

ACTIVITY

Instructor-led demonstration

CAUTION!!
Before you print your report, you will need to click the last page button to ensure that ALL 
pages of your report are printed.
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Printing Your Query
STEPS TO PERFORM ACTION

1. Open or create a QuickQuery.
2. Select File from the menu bar.
3. Select Print… from the program group.

-OR-

4. Select the print icon .

NOTE:
If you want to review the output of your query before you print it, you can do this 2 ways:

• Select File from the menu bar.

• Select Print Preview from the program group.

-OR-

• Select the print preview icon .

You can use the Print Setup to change the printer, print orientation, and paper and source.
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Activity: QuickQuery With The Query Wizard
Activity:  QuickQuery With The Query Wizard

Student Hands-On With Instructor Direction

Unit of Study:  QuickQuery (with the Wizard)

Application:  This type of query can be used when you need a simple report fast.

Report Type:  This is a report by your UIC listing by Stock Number, Bar Code, and Nomen.  This 
report will also list the Acquisition Cost for each asset and give you the total sum of the assets.

Instructions:

STEP 1: Detail
STEP 2: Select the following fields for your QuickQuery Wizard report:

STEP 3: Filter by the UIC given to you by your instructor.
STEP 4: Sort by the Nomen field.
STEP 5A: Click on Entire Document.
STEP 5B: Set the Columns to Aggregate to sum for the Acq Cost.
STEP 6: Select Finish to process your report.

Example of Finished report:

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

!Quick_Start Acq Cost Nomen
Bar Cd Stock Nbr
HRH Nbr Mjr UIC
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Skill Builder:  QuickQuery With The Query Wizard

Objectives:  You will:

Review Building a QuickQuery With The Query Wizard (Word 

Exercise)

Discussion Questions

Practical Exercise to build a QuickQuery with the Query Wizard

Complete the following exercise:

1. Name the type of queries you can select when building a QuickQuery with the Query Wizard?

2. List the 6 steps of the Query Wizard (in order).

3. The ____________  ___________ contains the business views, folders and data fields for building 
your report.

4. All values entered in Eureka are case sensitive.  (True or False)

True  _______ False  _______

5. List five types of operators.

6. What is a structured pathway for a new user to build a report?

_______________________________________________________________

a. _______________________________ c. _________________________________

b. _______________________________ d. _________________________________

a. _______________________________ d. _________________________________

b. _______________________________ e. _________________________________

c. _______________________________ f. _________________________________

a. _______________________________ d. _________________________________

b. _______________________________ e. _________________________________

c. _______________________________
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7. In Step 5 Select Columns to Aggregate name 3 aggregate functions you can perform.

8. When working with QuickQuery, you can only work in one business view at one time?  (True or 
False)

True  _______ False  _______

Discussion Questions:

1. Review the use of the Business Views and Folders.
2. Why is it important to use the filter function in some reports?
3. Discuss the different types of queries and what would be an example of how you 

would use them.

a. _______________________________ c. _________________________________

b. _______________________________
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Practical Exercise:  QuickQuery With The Query Wizard

Independent Student Report

Unit of Study:  Building a QuickQuery With The Query Wizard

Application:  This type of query can be used when you need a simple report fast.

Report Type:  Accounting report, filtered by UIC displaying serial number, stock number, fund code 
and dollar amount with sum and average.

Instructions:

1. Create a new report using the QuickQuery Wizard.
2. Select the following fields for your QuickQuery Wizard report:

3. Filter:

Column: Stock Nbr
Operator: Like
Value1: 70*

4. Sort:  Stock Nbr
5. Click on Entire Document.
6. Aggregate:  Stock Nbr using Count

BUSINESS VIEW: CATALOG

FOLDER(S) DATA ELEMENT(S)

Catalog Stock Nbr
Generic Nomen

Mfr._Model/Part_Number Mfr_Name
Mfr Part Nbr

HINT!
For your Filter:  Remember to use the value of “like” because we are using the wildcard to look 
for Stock Numbers that begin with “70”.  Refer to the list of operators on page 19 .
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Example of the finished report:
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Building A QuickQuery Without The Query Wizard

INTRODUCTION

This section outlines building a QuickQuery report without using the query wizard.

OBJECTIVES

Learn how to build a QuickQuery without the Wizard to include functions and processes that could be 
used in any QuickQuery that you build.

APPLICATION

This type of query can be used to generate simple reports “on the fly” without having to use the 
query wizard.  For example, you could create a listing of all your hand receipt holders by UIC, stock 
number and acquisition cost.  In this report we will be using different functions to manipulate our 
data.

REPORT TYPE

A listing of all your HRH Nbrs by UIC displaying nomenclature, stock number and acquisition cost.  We 
will use different functions to practice manipulating the data.

PREREQUISITES

Eureka Reporter Designer is accurately loaded and configured on your system.

ACTIVITY

Instructor-led demonstration

Example of the finished report:
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Building A QuickQuery Without The Query Wizard
STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.
3. If the Wizard is displayed, click Finish.
4. Select New from the file menu.

STEP 1:

a. Uncheck the Use Wizard choice on the new 
document dialog box.

b. Click OK.

STEP 2:

a. Depress the F2 Key on your keyboard to 
display your Object Directory (if it isn’t 
already displayed).

b. Use the scroll bars to select the appropriate 
Business View from which you will select the 
columns you want displayed on your report.

c. Select the following fields for your QuickQuery report:

HINTS!
It may be a good idea to change your 
Preferences to do a Manual Re-Query.  
See page C7-15, Setting Preferences, 
for more information.

To select MULTIPLE fields, hold the 
CTRL key down and select the desired 
fields (DO NOT LET UP ON THE CTRL 
KEY).  Click, “drag and drop” to any 
place in the working window.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

!Quick_Start Nomen Bar Cd
Stock Nbr Acq Cost
HRH Nbr Mjr UIC

In order to get your data fields to your
working window, you must click on the
field and while holding the click, drag and
drop the field to any place in the working
window.
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Building A QuickQuery Without The Query Wizard
Changing The Name Of A Column Heading

If the name of a particular column is not useful or clear to you or used by your Activity, you have the 
capability to change the name of that column heading.

STEP 1:

• Double-click on the column heading you 
wish to change.  In this exercise, we will 
change the Acq Cost field.

STEP 2:

a. The current name of the column is displayed.  
Change the Object Label to Actual Cost.

b. Folder:  This displays the folder your data field 
was chosen from.  This field cannot be changed.

c. Business View:  This displays the Business View 
your data field was chosen from.  This field cannot 
be changed.

d. Column:  This displays the system column 
heading from the object directory.  This field 
cannot be changed.

e. Type:  This field displays the characteristics of the data (string, numeric, or date).

NOTE:
If your report is not working, you may want 
to check each of your data elements to see 
if they are from the same Business View.  
To do this, you will need to double-click on 
each column heading to make ensure that 
all data elements are from the same 
Business View.
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f. Format:  If you selected to change a cost field, you can change the format of that field.  Change the 
Format to Windows Currency.

g. Charater Width:  This field defaults to the actual field length, but can be changed.  Keep in mind 
that if you make the length shorter that the actual field length, it will truncate the field.

h. Aggregate Function:  Select if you want to an average, count, maximum value, minimum value, or 
sum for your data field.

Format Functions

FORMAT SAMPLE DATA VALUE FORMATTED APPEARANCE

####0.00 1234.5 1234.50

#,###.## 1234.5 1,234.5

#.## 1234.5 1234.5

#0 1234.56 1235

$#,###,##0.00 1234.5 $1,234.56

$#,##0.00 100.5
0
2500.25
-145.10

$100.50
$0.00
$2,500.25
-$145.10

$#,##0.00;($#,##0.00) 100.503
-145.10

$100.50
($145.10)

$#,##0.00"CR";$#,##0.00 $1,234.50CR
-1234.5

1234.5
$1,234.50

0[S/1000] 12375
199

12
0

dd Mmmm yyyy Oct 1, 1966 10 October 1966

dd-MMM-yy Oct 1, 1966 01-OCT-66

mm/dd/yy Jan 15,1991 01/15/91

dddd Oct 1, 1966 Saturday

hh:mm 9:43am 09:43

hh:mm AM/PM 9:43am 09:43 AM

hh:mm:ss 9:43am 09:43:00

hh:mm:ss.ssssss 09:43am 09:43:00.000000

Click on the pick list to review additional Format Functions

HINT!
If you select the Sum Aggregate Function, after you change the Format, the Format is set back 
to the default.  Therefore, set the Aggregate Function before the Format.
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Example of the finished report:
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Changing The Fonts

You can change the font attributes for the column headings in your report.

STEP:

a. Click on the column heading you wish to 
change.  In this exercise, click on the 
Actual_Cost column heading.

b. Using the Formatting toolbar, change the 
type of font you wish to use.

c. You can also use the Formatting toolbar to 
change the size, alignment, style, and color 
of the font.

You can also double-click on the column heading.  It will display the Column Dialog box for the the column 
you selected.

1. Click on the Font tab to display the font attributes.
2. Make any necessary changes.  Notice that in the Sample box, a sampling will be displayed.
3. Click OK.

Example of the finished report:
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Moving Columns

If you decide that you do not like where a column is displayed in your query, you can simply move it.

1. Highlight the UIC column by clicking in the UIC column heading.  Your cursor will change to a black 
arrow when you place the cursor on the heading.

2. Click and drag the column (while still holding the click) into the first position of your report.  As you 
move across the screen, you will notice that there is a red line.  Use this as a guide to where you want 
to position the column.

3. Once you have positioned the red line to where you want the column to be located, release the click 
on the mouse.

Example of the finished report:
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Deleting Columns

If you decide that you do not want a column to be displayed in your query, you can simply delete it.

1. Highlight the Bar Cd by clicking once in the heading area.
2. Depress the Delete key on your keyboard.

Example of the finished report:
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Freezing/Unfreezing Column Headings

When your query has numerous columns, it may be impossible to view them all at one time.  Freezing a 
column(s) helps you identify the content(s) of the row(s).  When you freeze a column(s), they are moved 
to the left-most position of your query.  As you scroll to the right, the column(s) that you freeze will stay in 
place, but the other columns will move.  Unfreezing will return your query to its original state.

1. Using the table below, add the following fields:

2. Highlight the HRH Nbr Mjr field by clicking once in the heading area.
3. Right-mouse click to display the shortcut attributes menu.
4. Select Freeze Column.

The HRH Nbr Mjr field is moved to the left-most position and there is a fine blue line separating the frozen 
column with the unfrozen columns.

5. Scroll to the right.

Notice how the HRH Nbr Mjr field does not move but the other fields move.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Serial_Hand_Receipt Serial Nbr Fund Cd
Loc

Unit Activity Name
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Adding Custom Columns

1. Select the custom column icon  or select Insert from the menu bar, and then select Custom.
2. Enter an Object Label of your choice.

3. User Function:  Check this box if you want to 
pull in calculations that are not defined by the 
database administrator.

4. Double-click on the Detail folder.
5. Double-click on the Actual Cost field.  You can 

choose values for your custom column either by 
selecting the Columns tab (this is the Object 
Directory) or clicking on the Detail folder (these 
are the fields you selected for your report) or a 
combination of both.

6. Click on the X (multiply) button.
7. Enter .03 (this is just the inflation amount).  If 

you want the total inflated cost, the formula must 
be Actual_Cost * 1.03.

Example of the finished report:
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Applying Filters

Apply filter conditions to help narrow down database output so that it includes only the relevant data that 
you selected.

Filters are defined in the QuickQuery window using displayed values.

1. Click on the  icon.

2. Double-click on Actual_Cost.
3. Set the Operator to <= (less than or equal to).
4. Enter 5000 in Value1.

5. Click Add to activate the filter.  If you have an 
existing filter and you need to change it, highlight 
the condition, change the condition and then click 
Modify.  If you have an existing filter that you no 
longer need, highlight the condition and click 
Delete.

6. Distinct Values Only:  Check this box when you want to eliminate any duplicate rows.
7. Custom Override:  This displays any overriden SQL statements.

8. Click OK.

NOTE:
Remember the RULE for OR’d Group 
numbers on any two statements are the 
same, those two statements are connected 
by the AND condition.  If the OR’d Group 
numbers on any two statements are 
different, those two statements are 
connected by the OR condition.

Filter Types

Current Displays the current filter(s) that is in effect.

Base These are always in effect and have no conditions defined, and perform no filtering.

Ad Hoc These are defined in the QuickQuery window using displayed values.

Quick These are given a name and saved.  These filters can only be created using the QuickQuery window.
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Example of the finished report:
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Sorting Columns

Use the Sort function when you want your data sorted in a particular order (ascending or descending).

1. Highlight the Nomen field by clicking once in the heading area.

2. Click on the  (to sort in ascending order) or  (to sort in descending order) from the toolbar.

Example of the finished report:
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Grouping/Ungrouping Columns

Use the Group function when you want your data grouped by like items.

1. Highlight the HRH Nbr Mjr by clicking once in the heading area.
2. Right-mouse click to display the shortcut attributes menu.
3. Select Group.

- OR -

4. Click on the  button from the toolbar.  (If you want to ungroup, simply highlight the grouped 

column and click on the  button.
5. Save your report as QQGROUP.
6. Close your report.

Example of the finished report:
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Activity:  QuickQuery Without The Query Wizard

Student Hands-On With Instructor Direction

Unit of Study:  QuickQuery (without the Wizard)

Application:  This activity will be used to apply what you have learned in the previous lesson.  You will 
build a query without the wizard and then use various functions to manipulate your data.

Report Type:  This report will display assets with acquisition cost, filtered by major hand receipt 
holder number and grouped by nomenclature.

Instructions:

1. Open a new QuickQuery report without the Wizard.
2. Select the following fields for your QuickQuery report:

3. Change the name of Acq Cost to Actual Cost or a comparable term.
4. Delete the ARC.
5. Group on the Nomen.
6. Count on the Nomen.
7. Build a Custom Column labeled Over/Short.
8. Subtract the Qty On Hand from Auth Qty, which will equal the Over/Short column.
9. Filter for HRH Nbr Mjr Like W*.
10. Sum on the Acq Cost.
11. Save the report in the Eureka folder on your Desktop as QQACTY.
12. Close the report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog ARC Stock Nbr

Nomen
Hand_Receipt_Holder HRH Nbr Mjr
Serial_Hand_Rcpt.-Auth Acq Cost Auth Qty

Cond Cd Qty On Hand
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Activity: QuickQuery Without The Query Wizard
Example of finished report:
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Skill Builder:  QuickQuery Without The Query Wizard

Objectives:  You will:

• Review Building a QuickQuery Without The Query Wizard (Exercise below)
• Discussion Questions
• Practical Exercise to build a QuickQuery Without The Query Wizard

Complete the following exercise:

1. Outline the steps to perform when setting your preference for Manual Re-Query

2. What action(s) take place when you depress the F2 key?

3. You cannot change the name of a column heading.  (True or False)

True  _______ False  _______

4. To delete a column, you first ___________________ the column then depress the _______ key on 
your keyboard.

5. When your query has too many columns, it may be impossible to view them all at one time.  
_______________________ a column helps you identify the content(s) of the row(s).

6. ____________  _____________ are used when you want to apply values to a query that are not avail-
able in the database.

7. You display the shortcut attributes menu by doing a ____________________ 
______________________ with your ____________________.

8. Where is the keypad located that enables you to create numerical calculations?

___________________________________________________________________________

Discussion Questions:

1. Review the Grouping/Ungrouping Column Function.
2. Discuss why you would use and what are the advantages of QuickQuery without using the 

Query Wizard.
3. Describe the Ad Hoc Filtering process.

a. _______________________________ c. _________________________________

b. _______________________________ d. _________________________________
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Practical Exercise:  QuickQuery Without The Query Wizard

Independent Student Report

Unit of Study:  Building A QuickQuery Without The Query Wizard

Application:  This activity will be used to apply what you have learned in the previous lesson.  You will 
build a query without the wizard and then use various functions to manipulate your data.

Report Type:  Asset listing by major hand receipt holders beginning with “W”, grouped by 
nomenclature, displaying actual dollars or quantity on hand.

Instructions:

1. Open a new QuickQuery report without the Wizard.
2. Select the following fields for your QuickQuery report:

3. Change the name of the Acq Cost column.
4. Delete the Local Use column.
5. Group on Nomen.
6. Build a Custom column labeled Total Cost.
7. Multiply Qty On Hand by Acq Cost.
8. Change the Format to Windows Numeric.
9. Filter on HRH Nbr Mjr Like W*.
10. Sum for on the Custom column.
11. Save the report to the Eureka folder on your Desktop as QQPE.
12. Close your report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Catalog Nomen Local Use
Stock Nbr

Hand_Receipt_Holder HRH Nbr Mjr
Serial_Hand_Receipt Acq Cost
Serial_Hand_Rcpt.-Auth. Qty On Hand
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Example of the finished Report:
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Building A Summary QuickQuery

Unit of Study:  Creating Summary Documents.  A Summary Document provides summary information 
instead of detailed information.  This reduces the amount of detail—multiple rows are aggregated 
together.

Application:  This report is used when only summary information is requested.

Report Type:  A summary report of all Hand Receipt Holders showing the total value of all their 
assets.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open a new QuickQuery report without the Wizard.
2. Depress the F2 Function Key if your object directory is not open.
3. Select the following fields for your QuickQuery report:

4. Double-click on the Acq Cost column heading.
5. Click on the drop down arrow for the Aggregate Function.
6. Scroll and select Sum.
7. Click OK.
8. View report.
9. Close the report.
10. DO NOT save the report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! HRH Nbr Mjr
Acq Cost
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Example of the finished report:
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Building A Quick Filter In QuickQuery

Unit of Study:  Creating Quick Filters in your QuickQuery Documents.

Application:  Use this function when you want to reduce the amount of detail information on your 
query.

Report Type:  UIC total dollar amounts under each individual fund code.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open a new QuickQuery report without the wizard.
2. Depress the F2 Function Key if your object directory is not open.
3. Select the following fields for your QuickQuery report:

4. In the Fund Code Column, highlight one cell of Fund Code PA.

5. Click on  (Apply Filter Icon).  This will apply a filter to the current section.  This action will 
automatically filter your report to show only the assets with the fund code of PA.

BUSINESS VIEW:  DEPRECIATION EXPENSE

FOLDER DATA ELEMENTS

Catalog Stock Nbr

Serial_Hand_Receipt Acq Cst Serial Nbr
Fund Cd UIC
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Example of the finished report:

6. At the menu bar, select Query>Filter>Save As.

7. The Filter Name Screen will come up.  Enter Fund Code PA in the window.

8. Click OK.

9. Click on  (Clear Filter Icon). This action will clear your document of the Quick Filter.
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10. At the menu bar select Query>Quick Filters…

This will bring up the Quick Filter Screen that will list your Quick Filter.  From here you can select the listed 
filter and it will apply it to your document.

11. Highlight Fund Code 98.
12. Click OK.  Your document is now filtered again by the fund code of 98.

13. Clear the filter by using the Clear Filter Icon.
14. Repeat the process for Fund Code PA (start at Step 4 through Step 8).
15. After filtering by PA, save your report as QQFILTER, we will be using it in the next exercise.
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Building Translate Values Using QuickQuery

Unit of Study:  Creating Translate Values within a Document.

Application: Value translations allow you to substitute one value for another.

You can use value translations to:

• Replace a technical term or code with a familiar term
• Draw attention to a significant value
• Add more information about certain values
• Express a numerical month as an alphabetic month

Report Type:  Continuation of fund code report (QQFILTER) translating dollar amount.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. If closed, open QQFILTER report.
2. Double-click on the Dollar Amt column heading.
3. The Column Dollar Amt window will appear.
4. Select the Translate tab.
5. Double-click on the Detail folder in the Object Source.
6. Double-click on Dollar Amt to move it to the Object field.
7. Set the Operator to >= (greater than or equal to).
8. Enter 100000 in Value1.
9. Then Become:  Enter “CAPITAL ASSET”.
10. Click Add Case.
11. Otherwise Become:  Enter “NON-CAPITAL”.

Cases

Add Case Activates your condition.

Delete Case This will remove an 
existing condition.  You 
will need to highlight the 
case first before you 
select this button.

Modify Case This will allow you to 
make a change to an 
existing condition. You 
will need to highlight the 
case first before you 
select this button.
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12. Click OK.
13. Save your report.
14. DO NOT close the report – we will continue to use it in the next Unit of Study.

Example of the finished report:
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Exporting Your Query

INTRODUCTION

If you want to share your query or output document with someone who does not have the Eureka 
software, then you can export the data to another application.

Exporting a document creates a file in the format you choose. You can export from QuickQuery 
windows, FreeForm windows, and output windows. 

When you export from a FreeForm window or QuickQuery window, Eureka Reporter Designer submits 
the query, formats the data if necessary, and exports your document. 

When you export from an output window, Eureka Reporter Designer exports the already-created 
output.

Reports or data can be sent to a comma-delimited files, or most commonly to a text, Excel, or HTML 
file.

OBJECTIVES

To show how a user can provide the results of a Eureka Report electronically to someone who does 
not have Eureka on their PC.

APPLICATION

The most common use of this function is to send information which a user pulls out of Eureka , and 
wants to share it electronically with someone who does not have Eureka installed, but does use a type 
of file, like Excel or an Internet Browser (HTML).

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

ACTIVITY

Student Hands-On with Instructor direction

REPORT TYPE

We will use the Fund Code report (QQFILTER) for exporting.
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STEPS TO PERFORM ACTION

1. If closed, open the report named QQFILTER.

2. Select the Export icon .

-OR-

3. Select File from the menu bar.
4. Select Export… from the program group.
5. Change Save in to Desktop.
6. Change Save as type to Excel File (*.xls).
7. Click Export.

If you have any quick filters in your report, the Quick Filter selection window will display.  If this happens, 
just click OK.

8. Close your report.
9. Double-click on QQFILTER.xls from your Desktop.

Example of the finished report:

NOTE:
There are several different formats that you can export to (i.e., HTML, text file, Excel file).
CH 2 57
1 October 2004



Emailing Your Query
Emailing Your Query

INTRODUCTION

It is possible to share query/report results with others by attaching the query/report to an electronic 
mail.

OBJECTIVES

To practice and learn how to attach files to electronic mail.

APPLICATION

Used to email your queries to other users.

REPORT TYPE

Fund Code report (QQFILTER).

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

ACTIVITY

Instructor-led lecture

STEPS TO PERFORM ACTION

If the recipient is located on your email server, use these steps:

1. Open the QQFILTER report.
2. Select File from the menu bar.
3. Select Send Mail… from the program group.

If the recipient is NOT located on your email server, you will need to open your email application and 
type in the recipient’s email address and send the query as an attachment.
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Page Setup

INTRODUCTION

Setting up your page allows you to control the appearance of your document through several page 
options, including titles, page numbers, layout, margins, borders, headers and footers, background 
images, etc.

OBJECTIVES

To practice and learn how to change the page setup.

APPLICATION

Used to set up page headers, footers, page numbers, etc.

REPORT TYPE

None

PREREQUISITES

None

ACTIVITY

Instructor-led lecture

STEPS TO PERFORM ACTION

1. Select File from the menu bar.
2. Select Page Setup… from the program group.

STEP 1:

a. Page Size:  This option is not available in 
QuickQuery.

b. Page Margins:  Your page margins are 
defaulted to the current Windows settings, 
but you can change, if needed.

c. Page Layout:  Page layout controls how 
documents that are wider than your 
printer’s page size are printed (when they 
are not scaled to fit the page).

d. Printing:  This option is not available in 
QuickQuery.

e. Center on Page:  Select how you want 
your output displayed on you page.

f. Orientation:  This option is not available 
in QuickQuery.
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g. Grid:  This option is not available in QuickQuery.
h. Select the Header/Footer tab.

STEP 2:

a. Click the location where you want to insert the 
item (for example, if you want it centered on the 
first line of the header, select the header page 
and click in the first cell under Centered.

b. Use the tools along the side of the screen to 
change the font, enter the application name, file 
name, add page numbers, and add the date to 
your report.

c. Click the Footer tab.

STEP 3:

The default is to print the date and time on the 
bottom left and then the page number on the 
right.  These can be changed.

a. Delete the page number from Right Aligned.
b. Click in the first cell of the Centered column.
c. Enter Page and then add a space.

d. Click on .
e. Position your cursor after the $P.
f. Enter Of and add a space.

g. Click on .  This will cause your page 
numbers to read:  Page X of XX.

h. Distance to Frame:  To change the distance between the header or footer and the frame containing 
the QuickQuery, enter the distance you need in the Header and Footer boxes.

i. Page Numbering:  If you wish the page numbering to begin with a specific number other than 1, 
enter it in this box.

j. Select the QuickQuery tab.
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STEP 4:

a. Titles and Gridlines:  Check or 
uncheck the desired title or gridline box 
to control the appearance of your query 
for printing.

b. Save As Defaults:  If you want to save 
your settings to use with future queries, 
click this button.

c. Click OK.
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Introduction To FreeForm

INTRODUCTION

FreeForm is a powerful tool set that lets you:

Add text and columns as well as other objects to different areas of your design document:  
document header and footer; page footer and header; group header and footer; and detail.

Use multiple areas of the same type (for example, you can have two detail areas or more than 
one group header).

Specify Output When conditions that determine, row by row, when objects (and areas) should 
or should not be included in your output.

Specify borders and backgrounds for an object.

Create user prompts objects, child document objects, chart objects, crosstab objects, system 
objects, and graphic objects.

FreeForm allows you to develop customized reports, making the report as simple or complex as you 
need.  In FreeForm you have the freedom to design all aspects of the report.

FreeForm vs QuickQuery

In addition to the additional object types and object attributes you can use in FreeForm, the following 
are features that distinguish it from QuickQuery:

You are able to position objects anywhere on a grid.
FreeForm is not interactive.  To view data while you are working in a FreeForm window, you 
must select the print preview.  When you do this, Eureka submits your query and opens an 
output window with the information returned from your database.

OBJECTIVES

You will demonstrate an understanding of FreeForm by showing the steps necessary to create a cus-
tomized report.

Units of Study:

FreeForm Orientation
Designing A Customized FreeForm Report
FreeForm Area Objects
FreeForm Query Design
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APPLICATION

N/A

PREREQUISITES

Complete Chapters 1 and 2 of this manual.

Example of a FreeForm Report:
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Getting Oriented With FreeForm

INTRODUCTION

We will begin producing reports and queries using the FreeForm process, and gradually add more 
sophisticated functions.  You will see a window and toolbars that may be new to you.  This lesson will 
familiarize you with the terminology and function of the Eureka FreeForm environment.

OBJECTIVES

The student will be able to identify the parts and explain the functions of the FreeForm window and 
the associated toolbars.

APPLICATION

N/A

PREREQUISITES

Complete Chapters 1 and 2 of this manual.

ACTIVITY

Instructor-led lecture

For an explanation of each tool on the toolbars, refer to the References section of this manual.

FreeForm Toolbars

Toolbars

FreeForm Objects Allows you to quickly 
insert new objects, 
such as the date, 
time, page number, 
graphics, etc.

FreeForm Queries This allows you to 
sort, filter, add docu-
ment header/foot-
ers, page header/ 
footers, and group 
header/footers.

FreeForm Queries ToolbarFreeForm Objects Toolbar
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Document Windows And Object Directories

Document window is a term used to describe windows that an application opens to display documents, 
files, views of data, reports, and so on.  Document windows always exist inside program's application win-
dow and share the application window's menu bar.  Because Eureka follows the Multiple Document Inter-
face (MDI) standard, you can have several design and viewer windows open at one time, limited only by 
the amount of available memory.

Eureka uses the same interface used by other Windows applications and makes use of standard graphical-
interface options-move, resize, close, minimize, maximize, and drag-and-drop.

Document Window Types

Eureka has three types of document windows:

QuickQuery window
FreeForm windows
Document output window

 
Floating Windows

Floating windows are specially used windows that can be positioned any-
where on the screen.  All floating windows can be displayed by selecting 
them from the view menu or hidden by de-selecting them.  The object direc-
tory is a good example of a floating window.

NOTE:
Floating windows are not applicable when using the Query 
Wizard.  They are only available in QuickQuery and FreeForm.
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FreeForm Windows

FreeForm windows give you access to all object types and object attributes that Eureka supports.

Changing Area Attributes

By double-clicking an Area, you can change certain attributes.

a. Area Level:  Change this when you use the 
same area multiple times.  This will designate 
the process order.  For example, you may 
have two detail areas.

b. Area Description:  This is the description of 
the area.  This description does not print on 
the report.

c. Print Options:  This is used in conjunction 
with multiple area levels.  This will tell when 
certain rows to print.

d. Area Height:  This sets the area height of 
your report.

e. Reset Page Number to:  This will reset the 
page number after each page break, area, or 
group.  For example, if your report breaks for 
each Hand Receipt Holder Number, it would 
reset the page back to whatever page 
number you specify.

FreeForm Window

Areas These are defined as area objects that 
make up each Eureka document.  Each 
area object serves as a container for 
output objects such as text objects, col-
umn objects, graphic objects, etc.

Object 
Alignment 
Grid

Eureka Reporter Designer provides a 
grid that is used to align your output 
objects.

Page 
Header 
Area

A page header is included at the top of 
each page.  When you move an object 
(field) in this area Eureka outputs the 
value of that column, taken from the 
first row, on the page.

Detail Area The output for a detail area is once for 
each database row included on your 
document.

Page Footer 
Area 

A page footer is included at the bottom 
of each page.  When you move an object 
(field) in this area, Eureka outputs the 
value of that column, taken from the last 
row, on the page.
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f. Spacing:  If you want to leave space before or after an area object, enter the amount of space you 
want.

g. Page Skip:  Use these controls to have Eureka skip to the top of the next page before or after this 
area is output.  A value of 1 causes output to skip to the next page. A value of 2 causes a blank page 
to be output.  A value of 3 causes 2 blank pages to be output, etc.

h. Click OK.

Object Directory

The Object Directory makes it easy to:

Add columns to your documents and dialog boxes
Add copies of existing objects to your document
View database values for a column and insert them in dialog boxes

Eureka Reporter Designer includes an Object Directory in the FreeForm windows.  You can open and close 
it by selecting View>Object Directory (F2 Function Key) from the menu bar.  Many Eureka dialog 
boxes also have Object Directories built into them.

Object Directories let you select:

Objects from your Metadata file (that is, column objects and custom objects that are defined in 
the Metadata file).
Objects that are already in place on your design document.

Many Object Directories also let you browse database values for a column.

Business View.  Business view names are at the top level of the tree and 
are indicated in ALL CAPS.  A business view is an object in your Metadata 
File that corresponds to the data for a particular part of your business.

Folders.  A folder can correspond to a table in your database or it can be 
made up of columns from more than one table.  It can also include custom 
objects--objects that are calculated from database columns.

Data Objects.  These are the actual data elements that are used to make up 
your report.

Object Directory Toolbar

Columns.  This displays the Object Directory.

Document Objects.  This displays the data fields that you selected on 
your report.

Browse.  This browses your database for a selected data field (this is 
only accessible if a data object is selected).
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Area Object List

The Area Object List (F4 Function Key) is a tool that allows you to view area 
objects that are shown in your current FreeForm window.  The Area Object List 
is displayed above your Object Directory.

Data Object Placement

When dropping data objects on your report, column headings (the gray) will be placed in the page header 
area.  Data objects (the turquoise), will be placed in the detail area.  This is done by placing your mouse 
arrow on top of the data object in the object directory, holding down the left mouse button, dragging over 
to the grid area, and placing the tip of the arrow INSIDE the detail area.  Let go of the mouse button.  If 
the tip of the arrow is not inside the detail area, a column header will not be produced.

Detail Areas

Placing data objects in the 
detail area will result in 
output once for each 
database row included on 
your document.  If an 
aggregate function (sum, 
average, etc.) is applied to 
any of the columns in the 
detail area object, each row 
returned from the database is 
a summary row.
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Page Setup

Setting up your page allows you to do several page options, including titles, page numbers, layout, 
margins, borders, headers and footers, background images, etc.

a. Select File from the menu bar.
b. Select Page Setup from the program 

group.
c. Page Size:  Allows you to adjust the size 

of your page.  Your page size is defaulted to 
the current Windows settings, but you can 
change if needed.

d. Page Margins:  Your page margins are 
defaulted to the current Windows settings, 
but you can change if needed.

e. Page Layout:  Allows you to use multiple 
columns.

f. Center on Page:  Select how you want 
your output displayed on your page.

g. Orientation:  This will allow you set how 
you want your page to print.

Printing Group Box:

h. Scale to Fit:  Controls what happens when you print your document to paper with different 
dimensions than are specified for your document.  When Scale to Fit is checked, Eureka scales the 
document to fit the page.  It either enlarges or reduces all of the objects.

i. Scale:  Allows you to select al exact scaling percentage.

j. Use Grid:  To assist in creating FreeForm documents with a neat appearance, you can specify that 
objects are to be placed on an alignment grid which appears only in the FreeForm window (and not in 
output).

k. Cell Height:  You can enter the vertical spacing for objects.
l. Cell Width:  Enter the horizontal spacing.

m. Save As Defaults:  To have your changes from the Page tab apply to future documents as well as to 
the current document, select Save As Defaults after making your changes.  To have your changes 
apply only to future documents, select Cancel after you select Save As Defaults.

n. Click OK.

HINT!
If you plan to exchange documents between people with American and European printers, it is a 
good idea to turn on Scale to Fit.

HINT!
A good starting point for cell height and width is 20% greater than the size of the font you plan 
to use most.  For instance, if you plan to use a 10-point font, enter 12 points as the grid setting.
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Building A FreeForm With The Query Wizard

INTRODUCTION

This section outlines building FreeForm reports by using the Query Wizard.  The query wizard is the 
easier way to create a query and takes you step-by-step through:

OBJECTIVES

OBJECTIVES

Using the FreeForm Wizard, you will develop a spreadsheet-type of report with columns of data 
(detail) that have been filtered, sorted, and aggregated (totaled for the column).  You will present a 
sample page of this finished report to your instructor.

APPLICATION

This type of query can be used when you need a simple report fast.  For example, you want to build 
a simple report that displays certain data fields for your Hand Receipt Holders.

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

Complete Chapters 1 and 2 of this manual.

ACTIVITY

Student Hands-On with Instructor direction

REPORT TYPE

A complete asset listing by UIC/Major Hand Receipt Holder showing stock number, bar code, nomen-
clature, and acquisition cost of each asset.

STEP 1:  Select Query Type STEP 4:  Select Columns to Sort By

STEP 2:  Select Columns STEP 5:  Select Columns to Aggregate

STEP 3:  Setting Column Filters
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This is a sample of a FreeForm report that you will build in this lesson:

STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

 ADD AD HOC REPORTS ICON HERE
ADD EUREKA MENU HERE
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 STEP 1:
a. Select Detail.
b. Click Next>.

STEP 2:

a. Select the following fields from the table below:

b. Click Next>.

Query Types

Detail Detail queries return detailed data without any 
aggregate functions applied, the aggregate func-
tions being average, count, minimum, maximum, 
and sum.

Summary Summary queries are useful when you want to 
summarize data for a number of different items.

Grouped 
Detail

Grouped detail queries let you view the query 
results grouped by one or more columns.

Overall 
Summary

Overall summary queries give the highest level 
view of your data.

Create 
TM1 Cube

This is not available.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Hand_Receipt_Holder HRH Nbr Mjr

Serial_Hand_Receipt Acq Cost

Catalog Stock Nbr
Nomen

HINT!
To select MULTIPLE fields, hold the CTRL key down and select the desired fields (DO NOT LET UP 
ON THE CTRL KEY).  Click, "drag and drop" to any place in the working window.

Select the type of query you would like.

From the Objects Direct-
ory select the Business
View you wish to use to
build you columns.
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STEP 3:
a. We are going to filter on a field that we are not dis-

playing in our report.  To do this, click on the    
icon.

b. Scroll up to the END ITEM SERIAL Business 
View.

c. Open the Unit Folder.
d. Select the UIC field.
e. Make sure that the operator is set to equal (=).
f. Filter on UIC W0U6AA.  Remember to turn your 

CAPS LOCK on!
g. Click Next>.

STEP 4:

a. Double-click on Nomen.
b. The sort order defaults to Ascending, but if 

you want to change it, click on the A->Z but-
ton.

c. Click Next>.

HINT!
Filters let you limit the data displayed to only that which meets the criteria you set.  When a 
query has no filter, you will see ALL the data from your database. When you define a filter con-
dition, you will limit the data that meets the condition.  Every additional filter or filter condition 
you apply further narrows the view of your data.

HINT!
Once you have selected your columns, you 
can click on Order button and change 
how you want your query to sort.  For 
example, it would be either A-Z or Z-A.

From your list of selected
fields, double-click or drag
and drop the data field you
want your query to filter on.

From your list of selected fields, double-
click or drag and drop the data field you
want your query to be sorted by.  To de-
select a field, highlight the field you want
to de-select and click on the arrow that
points to the left.
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STEP 5:

a. Click on Entire Document.
b. Sum on the Acq Cost.
c. Click Finish.
 

Example of the Design Document:

a. Delete the UIC column heading.

b. Click the  Print Preview button to 
process your report.

NOTE:
Only pure numeric fields can be 
summed or averaged.

When using the Count, you will get the 
total number of records returned from 
your query.
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Example of the finished report:

a. Click on the   to close your output window.
b. Close your report without saving it.
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Designing A Customized FreeForm Report Without The Query 
Wizard

INTRODUCTION

FreeForm is a powerful tool set that allows more complex design of reports, or when the user wants 
to include any of the objects that are not supported by QuickQuery.  It allows the user to:

Add areas to the document

Add text and columns as well as other objects to different areas of the design document: doc-
ument header and footer; page header and footer; group header and footer; and detail object 
areas.

Specify font types, alignment, point size and colors to customize an object.

OBJECTIVES

We will design a series of progressively more complex FreeForm documents, using this effective tool 
to output information from DPAS.

APPLICATION

FreeForm is an excellent tool if your intention is to create a query or printed report which will most 
likely be used to present to others outside of your organization, to those who are not necessarily 
familiar with DPAS terms, or that requires more sophistication than QuickQuery.  We say that Free-
Form is more sophisticated, but it can be easy to use once you learn the fundamentals.  It allows 
more creativity in design and presentation of information.

PREREQUISITES

Complete Chapters 1 and 2 of this manual.

ACTIVITY

Student Hands-On with Instructor direction

REPORT TYPE

Depreciation report listing accumulated depreciation and activation date by UIC
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This is a sample of a finished FreeForm Report:

STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group or from you computer desktop, double-click the Eureka 

Reporter Designer icon.
3. If the Wizard displays, click Finish.
4. Select Tools from the menu bar.
5. Select Preferences… from the program group.
6. Uncheck Use Query Wizard and Default To QuickQuery View.
7. Click OK.

8. Select File from the menu bar.

NOTE:
If you do not have a shortcut to Eureka on your desktop, then click Start>Programs> Eureka 
Reporter Designer.
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STEP 1:

Refer to Getting Oriented With FreeForm for 
information on  Page Setup.

If you have numerous columns that you will be 
adding in your report, it is always a good idea to 
widen your report lengthwise to add more room.  
Keep in mind that if you change the width of 
your page size to greater than 11, make sure 
that you have paper in you printer to 
accommodate the wider page; otherwise, your 
report may not print properly.

a. Make any necessary changes.
b. Click Save As Defaults.
c. Click OK.

d. If your Object Directory is not displayed, depress the F2 Function Key to display it.
e. Select the data fields from the table below. Click, drag, and drop the field(s) to the Detail Area of your 

FreeForm report.  Remember, if the tip of the arrow is not inside the Detail Area, a column header will 
not be produced.

You cannot select fields from 2 different Business Views (such as, END ITEM SERIAL and END ITEM 
BULK) on one report unless you are writing a Parent/Child report.

For more information on Parent/Child reports, see Chapter 4.

BUSINESS VIEW:  DEPRECIATION EXPENSE

FOLDER(S) DATA ELEMENT(S)

Catalog Nomen Stock Nbr

Serial_Hand_Receipt Acq Cost Serial Nbr
Bar Cd UIC

Depreciation Accumd Deprn Activation Dt
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STEP 2:

a. After you have selected your data objects, 
depress the F2 Function Key to remove 
the object directory because it covers part 
of your design document.

b. Save your report as FFQUERY before pre-
viewing it.

Eureka uses output windows to show you the results of queries that you are working with.  In order to 

view all pages of your report, you should click the Last Page icon  .

STEP 3:

a. Close the output window by clicking on the   icon.
b. DO NOT close the report - we will continue to use it in the next Unit of Study.

SHORTCUT!
If you want to select multiple data 
fields, hold the CTRL Key down while 
highlighting the desired fields.  While 
still holding the CTRL Key down, 
drag and drop the fields into the 
Detail area of the FreeForm Window.
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Page Header/Footer Areas

A Page Header/Footer area outputs for each page within the document.  Placing objects in these areas will 
result in output values for each page of the document (i.e., average, sum, text, etc.).

The Page Header/Footer is already the default in the FreeForm window.  If you wish to add additional page 
headers/footers, use the Insert>Area>Page Header or Page Footer.  If you prefer, you can simply 

select the Page Header/Footer icon  .  If you select this icon, it will produce both a Page Header and 
a Page Footer!

If you are going to be adding a lot of items to the page header area, it may be a good idea to resize the 
area to make it larger.  To do this:

1. Click in the area.  The area will be surrounded in blue with black handles (small blocks).
2. There is one handle that is solid in color.  Click on that handle (it will change to a two-way arrow).
3. Hold the click, and the drag down to make as large as you want.  If you do this, you will need to move 

your objects to where you want them.
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Selecting Multiple Objects

This process will show you how to select multiple objects at one time.  This procedure is referred to as 
"rubberbanding".

Position the mouse at a
point just outside of the
outermost object to be
selected.

Hold down the mouse button and drag the pointer
to create a rectangular “container”.

When the container includes at least part of each
object to be selected, release the mouse button.  All
of the objects will be selected and you can move or
delete all data objects together.
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Below is an example of items that were "rubberbanded":  GET UPDATED SCREEN!!

Notice how the items you
rubberbanded have handles
around each object.  You can
now drag the items to where you
want to place them.
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Adding Document File Name Objects

Use this process when you want to add the file name of your document that you are saving.

1. Click on the Document Name icon.

-OR-

2. Select Insert from the menu bar.
3. Select System from the program group.
4. Select Report Name from the program list.

5. Place the object on the left side of the Page Footer area.

NOTE:
It is recommended that 
report name objects be 
placed in the Page Footer 
area (if you want the name 
of the report to appear on 
each page of your report).  
If you want the name of 
your report will appear on 
the first page of your 
report only, place the 
object in the Document 
Header area.

Report Name Icon
CH 2 84
1 October 2004



Designing A Customized FreeForm Report Without The Query Wizard
6. Double-click on the report name object.

7. Make any necessary changes.

Type:  This displays the type of object.
Object Label:  This determines the type of value 
that is output for the object.
Character Width:  Controls the length of the 
object for output purposes.  Eureka always pro-
vides a default width.  If you enter a number 
smaller than the width of the system object as 
formatted by Eureka, the output will be truncated.
Format:  When you same your report, the file 
name will be displayed in the area where you 
placed the object.

• Name Only displays just the file name 
(for example, UICRPT).

• Name and Extension displays the entire 
file name including the extension (for 
example, UICRPT.iqr).

• Full Path displays the entire path and file 
name including the extension (for exam-
ple, C:/Program Files/Reports/UICRPT.iqr).

NOTE:
For the Character Width, truncation will also occur if the size of the object's output is larger 
than the object size.  Factors that affect this include the typeface style and size, and the format 
applied to the object.  You can avoid this truncation by selecting Word Wrap.

Double-click on the report name object.
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Appearance:  Select the appearance option(s) for your report.

8. Click OK.

9. Process your report.

Below is a sample of a finished FreeForm report displaying the document file name:

10. Save your report.

Appearance

Suppress Duplicates Outputs the same object contents only one time. When there is more than one consecutive 
row that has the same data for your object, Eureka suppresses output of duplicate values.

Word Wrap If you want output that exceeds the object width to be printed on successive lines.  The spac-
ing between lines when objects wrap is based on the font you are using.  When you select 
Word Wrap, be sure that there is enough room between the object you are defining and any 
objects directly below it in the same area to allow for multiple lines of text.  Eureka does not 
add space under objects when they wrap.

Snap To Grid If you want your object always to be placed on the alignment grid (when Use Grid is turned 
on).  When Snap to Grid is not selected, you can place your object at any location.

Hide If you want your object to be moved to a hidden area object.  If you do so, your object will 
not be included in your output.

HINT!
Remember…you can change the characteristics of your report name object (such as font size, 
color, add borders, etc.).
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Changing Column Headings

Eureka will allow you to change the column headings of your data object to make them understandable to 
you and others that will be reviewing your report.

Changing attributes is not a mandatory process.

1. Double-click on the Acq Cost field.

2. Enter Actual Cost over the displayed value.
3. Import File:  Click this button to import text 

into the value field.
4. Appearance:  Select the appearance 

option(s) for your report.  Refer to Adding 
Document File Name Objects for defini-
tions of the Appearance options.

5. Click OK.
6. Process your report.

Double-click on the column
heading (the gray object) for
which you are changing the
attributes.

Type over the existing value
to generate the column
heading you want to display
on your report.
CH 2 87
1 October 2004



Designing A Customized FreeForm Report Without The Query Wizard
Below is an example of a finished FreeForm report with the column headings changed:

7. Save your report.

Notice how the column
heading reflects your
change.
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Changing Fonts

Eureka will allow you to change the font of your data object(s) for your report.

If you want to change the font of the column heading, then double-click on the column heading (gray 
object).  If you want to change the font of the output for a particular object, then double-click on the detail 
object (turquoise object).

Changing fonts is not a mandatory process.

1. Click on the Actual Cost column heading.

2. Using the Formatting Toolbar change the font, point size, color, alignment, and characteristics of 
your font.

HINT!
You can also double-click on the object to display the fonts attributes.  Once you double-click on 
the object, click on the Font tab.  Here you can change all the font attributes of your object.  As 
you change your font attributes, it will be displayed in the Sample box.

The alignment feature aligns within the object, not the object itself.

The selections shown are the default for the column headers.

Click on the object for
which you are changing the
attributes.
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3. Process your report.

Example of the finished design document and report:

4. Save your report.
5. DO NOT close the report - we will continue to use it in the next Unit of Study.
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Document Header/Footer Areas

A Document Header/Footer area outputs for the entire document.  Placing objects in these areas will result 
in output values for the document as a whole (i.e., average, sum, text, etc.).  Document header outputs 
for the first page only.  The document footer outputs for the last page only.

1. Click on the Document Header/Footer icon.

-OR-

2. Select Insert from the menu bar.
3. Select Area from the program group.
4. Select Document Header or Document Footer from the program list; this will allow you to insert 

either the document header or the document footer, depending on which area you selected.

This is the Document Header/
Footer icon.  Selecting this icon
will create both the document
header and footer.

Notice how both the document
header and footer is created.
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Adding Text Objects

Use this process when you want to add your own text to your report.  For example, use a text object to 
add titles, signature blocks, etc.

1. Click on the text icon.

-OR-

2. Select Insert from the menu bar.
3. Select Text from the program group.

4. Do not change the Object Label.
5. In the Value window, enter the desired title 

for your report.
6. Click OK.
7. Place the text object in the center of the Page 

Header area of your report.

This is the text object icon.

If it is desired to have two lines of text, 
before typing in your text, first click

on Word Wrap and then click back in the
text box and enter your text.  Enter your
text.  Once this is done, you can
enhance the text by clicking on the
Border or Font tab(s).
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When you place a multi-line text object you will only see the top line.  To display all lines:

a. Click the text object once.  Notice the solid black box in the center of the bottom of the box.
b. Place the tip of your mouse arrow on the black box until you get a two-way arrow.
c. Hold down the left mouse button and pull down, enlarging the box until the lower lines are dis-

played.  If Word Wrap was not selected, then doing this will only enlarge the font of your text.

4. Save your report.
5. DO NOT close the report -- we will continue to useit in the next Unit of Study.

Place your text where
you want it displayed
on your report.
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Adding Date Objects

Use this process when you want to add the system date to your report.

1. Click on the date icon.

-OR-

2. Select Insert from the menu bar.
3. Select System from the program group.
4. Select Date from the program list.

5. Place the date object on the left side of the Page Header area.

It is recommended that date objects be placed in the Page Header area.  This is so that the date will 
appear on each page of your report.

If it is desired to re-format the date presentation, double-click on the date object, click the down arrow on 
the format box of the dialog box and select the desired format.  The DPAS format is on the bottom of the 
list.

This is the date object icon.
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6. Process your report.

7. Close the report viewer.
8. Save your report.
9. DO NOT close the report – we will continue to use it in the next Unit of Study.
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Adding Time Objects

Use this process when you want to add the system time to your report.

1. Click on the time icon.

OR-

2. Select Insert from the menu bar.
3. Select System from the program group.
4. Select Time from the program list.

5. Place the time object below the date object in the Page Header area.

It is recommended that time objects be placed in the Page Header area. This is so that the time will 
appear on each page of your report.

If it is desired to re-format the time presentation, double-click on the time object, click the down arrow on 
the format box of the dialog box and select the desired format.

This is the time object icon.
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6. Process your report.

7. Close the report viewer.
8. Save your report.
9. DO NOT close the report -- we will continue to use it in the next Unit of Study.
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Adding Page Number Objects

Use this process when you want to add a page number to your report.

1. Click on the page number icon.

-OR-

2. Select Insert from the menu bar.
3. Select System from the program group.
4. Select Page Number from the program list.

5. Place the page number object in the center of the Page Footer area.

It is recommended that page number objects be placed in the Page Footer area.  This is so that the page 
number will appear on the bottom of each page of your report.

If it is desired to re-format the page presentation, double-click on the page object, click the down arrow on 
the format box of the dialog box and select the desired format.

This is the page number
object icon.
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6. Process your report.

7. Close the report viewer.
8. Save your report.
9. DO NOT close the report – we will continue to use it in the next Unit of Study.

Place your page number
object where you want it to
be displayed on your report.
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Adding Counter Objects

Use this process when you want to count each row of your report.

1. Since we are going to add the counter object in the first column, you will need to move all of your col-
umn headings and detail objects over to the right.

2. Click on the counter icon.

-OR-

3. Select Insert from the menu bar.
4. Select System from the program group.
5. Select Count from the program list.

6. Place the counter object to the left of your columns in the Detail area.
7. Delete the Counter column heading.

It is recommended that counter objects be placed in the Detail area.  This is so that each row of the 
report will be numbered.

This is the counter
object icon.
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8. Process your report.

9. Close the report viewer.
10. Save your report.
11. Close your report.

HINT!
If you place the counter object in the detail area, you may want to delete the column heading.

Place your page number
object where you want it to
be displayed on your report.
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Activity:  Designing A Customized FreeForm Report Without The 
Query Wizard

Student Hands-On With Instructor Direction

Unit of Study:  Designing A Customized FreeForm Report

Application:  In this activity, your instructor will guide you through building a listing of Hand Receipt 
Holders for a specified UIC using the FreeForm method of query and functions to customize your report.

Report Type:  Hand Receipt Holder By UIC

Instructions:

1. Create a new FreeForm report.
2. Enlarge your Page Header.
3. Using the counter icon insert counter in the Detail area.
4. Delete the Counter column heading.
5. Select the following fields for your FreeForm report:

6. Insert the date and time in the Page Header area.
7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in 

the Page Header area.
8. Add a Document Footer area.
9. Add “End of Report” in the Document Footer.
10. Insert the document name, using the document name icon, in the Page Footer area.
11. Using the page number icon, insert a page number in the page footer.

BUSINESS VIEW:  HAND RECEIPT HOLDER

FOLDER(S) DATA ELEMENT(S)

Hand Receipt Holder HRH Nbr Mjr Office Name
HRH Name

Unit UIC
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12. Save your report as FFACTY for later use.
13. Close your report.

Example of finished report:
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Skill Builder:  Designing A Customized FreeForm Report Without 
The Query Wizard

Objectives:  You will:
• Review, Introduction to FreeForm & Designing a Customized FreeForm Report 

(Exercise Below)
• Discussion Questions
• Practical Exercise to build a Customized FreeForm Report

Complete the following exercise:

1. Name any two features that distinguish FreeForm from QuickQuery.

2. FreeForm is a powerful tool set that allows you to:  (Circle all that apply)

a. Use multiple areas of the same type.
b. Specify Output when conditions that determine, row by row, when objects (and areas) should or 

should not be included in your output.
c. Add date and time to your reports
d. All of the above
e. None of the above

3. The F4 Function Key opens the ________________  ______________  ______________.

4. Folder Names are at the top level of the tree and are indicated in all caps? (True or False)

True  _______ False  _______

5. Why is it important when dropping data objects inside the detail area to make sure the tip of the arrow 
is inside the detail area?

_______________________________________________________________________________

_______________________________________________________________________________

6. Name the three areas your FreeForm window defaults to when it is opened.

7. Eureka will not allow you to change the column headings of your data objects.  (True or False)

True  _______ False  _______

a. _______________________________ b. _________________________________

a. _______________________________ c. _________________________________

b. _______________________________
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8. Match the Tool Bar Icons with the correct definition.  Insert the alpha character on the blank line.

Example:A.     _7_ 1. Time Object

B.  _____ 2. Counter Object

C. _____ 3. Document Name Object

D. _____ 4. Page Number Object

E. _____ 5. Date Object

F. _____ 6. Text Object

G. _____ 7. Page Header/Footer Icon

H. _____ 8. Document Header/ Footer Icon

Discussion Questions:

1. Discuss the advantages of using FreeForm.
2. Summarize the process of the report you completed in the previous activity.
3. What types of reports are needed at your facility?
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Practical Exercise:  Designing A Customized FreeForm Report 
Without The Query Wizard

Independent Student Report

Unit of Study:  Building and customizing a report using FreeForm

Application:  In this activity you will build a customized accounting report using processes learned in 
this unit of study.

Report Type:  A customized Accounting Report by UIC, showing the stock number, serial number, 
dollar amount of the assets, the fund codes used to procure the asset and the acquisition date of the 
asset.

Instructions:

1. Create a new FreeForm report.
2. Enlarge your Page Header area.
3. Using the counter icon, insert the counter object in the detail area
4. Delete the Counter column heading.
5. Select the following fields for your FreeForm report:

6. Insert the date and time in the Page Header area.
7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in 

the Page Header area.
8. Add a Document Footer.
9. Add “End of Report”. in the Document Footer.
10. Insert the document name, using the document name icon, in the Page Footer area.
11. Using the page number icon, insert page number in the page footer.

BUSINESS VIEW:  ACCOUNTING TRANSACTIONS

FOLDER(S) DATA ELEMENT(S)

Accounting UIC Dollar Amt
Stock Nbr Fund Cd
Serial Nbr Acq Dt
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12. Save the report as FFPE1 for later use.

13. Print (if a printer is available) the report for the Instructor.
14. Close your report.

Example of the finished report:
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Building A Sort Order In A FreeForm Report

Unit of Study:  Building a sort order in a FreeForm report when you want to sort items in your report.  
Eureka Reporter Designer lets you sort your document or chart by any column or columns that you use in 
it. By default, sorts are ascending. If you wish to define a descending sort, you will have to select it by one 
of the methods you will learn in this course.

Application:  This will show you how to sort in ascending or descending order, any field in your report.

Report Type:  Asset listing by UIC and major hand receipt holder number.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Create a new FreeForm report.
2. If your object directory is not open, depress the F2 Function Key.
3. Select the following fields for your FreeForm report:

4. Process report for viewing.
5. Close the output window.

6. Click .
7. Highlight the HRH Nbr Mjr field.

BUSINESS VIEW:  HISTORIES

FOLDER(S) DATA ELEMENT(S)

History UIC Serial Nbr
HRH Nbr Mjr Pgm Desc
Stock Nbr
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8. Click the arrow to move the field into the Ordered Objects window.

9. Click OK.
10. Process the report for viewing (go to the second page of the report; this is where the HRH Nbr Mjr 

starts).
11. Try sorting on different fields and processing the report to see how your report will look.
12. Close and DO NOT save the report.

NOTE:
To deselect an item to sort, highlight the field in the Ordered Objects window and click the 

 button.

Use the  or  buttons to move the ordered objects in the order you want them to start 
sorting.

Use the  to sort the field in Ascending or Descending order.
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Example of the finished report:
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Group Header/Footer Areas

INTRODUCTION

When you format a document, you can output information quickly and easily through group headers 
and footers.

Group Header Areas are output at the beginning of each group of rows that have the same value in 
a column you specify.  When you place a column object in this area, Eureka outputs the value of that 
column, taken from the first row in the group.  However, if you use an aggregate function for the col-
umn, Eureka outputs the value for the group as a whole, i.e., the average, sum, etc., for that column 
for all rows included in the group.

Group Footer Areas are output at the end of each group of rows that have the same value in a col-
umn you specify.  When you place a column object in this area, Eureka outputs the value of that col-
umn, taken from the last row in the group.  However, if you use an aggregate function for the column, 
Eureka outputs the value for the group as a whole, i.e., the average, sum, etc., for the column for all 
rows included in the group.

Group headers (and group footers) have a special relationship with the sort order for your document:

When you add a group header or footer, Eureka automatically sets the document sort order 
based on the object associated with the group header.

When you have more than one group header or footer, Eureka sets the document sort order to 
use each of the columns for which you have group header or footer areas.  It sets the sort 
order to match the order in which you add the area objects.

If you change the sort order for your document, Eureka rearranges the order of the group headers 
and footers to match the new sort order.

OBJECTIVES

In learning how to create and use group headers and footers, you will also learn why to use them.

APPLICATION

There are advantages to grouping your data within your report.  For example, by grouping stock 
numbers, the user can see all examples of the specified stock number in one, order place.

PREREQUISITES

Complete Chapters 1 and 2 of this manual.

NOTE:
You must select a column or custom object before you can add a group header area.  The 
group header area is based on the object that is selected at the time the group header is cre-
ated.  The object can be in any area.
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ACTIVITY

Student Hands On with Instructor direction

REPORT TYPE

Open the HRH by UIC report, page FFACTY.

STEPS TO PERFORM ACTION

1. Open the FFACTY report.
2. From the Detail Area, click once on the field you want to group. We will be grouping on the UIC.
3. Select Insert from the menu bar.
4. Select Area from the program group.
5. Select Group Header from the program list.

- OR -

6. Select the Group Header icon  .
7. Move the field(s) that you want in the Group Header from the Detail area.  We will be grouping by 

UIC.
8. Move the UIC column heading to the far left of the Group Header area.
9. Move the UIC data object (blue object) next to the UIC column heading (gray object).

10. Process the report and view.
11. Close the report viewer.
12. Save the report.
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13. DO NOT close the report – we will continue to use it in the next Unit of Study.
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Building A Page Break In A FreeForm Report

Unit of Study:  Often a single document consists of sections that need to have individual page 
numbers.  For instance, a single document might consist of hundreds of (HRH) Hand Receipt Holder 
Reports, each to be distributed to a different HRH.  When you do this, you would probably want to have:

1. Each HRH Report  or UIC report starting at the top of a new page.
2. Each time a new UIC is reached, page numbering re-starting from one.

You can do this in a FreeForm window by including a group header area based on HRH Mjr. Nbr.  For that 
area object, you would enter 1 under Page Skip Before Area on the Area tab of the Area dialog box.  
This causes one page break before the area is output.  You would also check the Reset Page Number To 
box and then enter 1 as the number to which to reset the page numbering.

You can use these controls for a variety of purposes.  For instance, if you want group footers on a page 
without any other area objects, you could enter 1 under both Page Skip Before Area and Page Skip 
After Area.  If you wanted document totals on a separate page, you could enter 1 under Page Skip 
Before Area in the Area dialog box for the document footer area.

Application:  This report will show you how to insert a page break every time a new UIC is 
encountered.

Report Type:  Hand Receipt Holder by UIC (FFACTY)

Activity:  Student Hands-On with Instructor direction

Instructions:

1. If closed, open the FFACTY report.
2. Double-click in the blank portion of the UIC Group Header area.
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3. In the Page Skip group, change Before Area from 0 to 1.

4. Click OK.
5. Save your report.
6. Process your report to view the results.

7. Close your report.

Select whether you want the page to
break before or after the group.
Use the spin button to select the
number of blank pages you want to
print between groups.
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Inserting A Filter In A FreeForm Report

Unit of Study:  Each document always has a single base filter.  This base filter is always in effect and 
initially has no conditions defined for it and performs no filtering.  You can add conditions incrementally to 
narrow the focus of your query.  Unless query filtering conditions are applied, Eureka presents all of the 
rows in the database as part of the output.  If the database is large, however, such output can be difficult 
to present and understand.  Filter conditions help to narrow down output so that it included only relevant 
database rows.

Application:  Filtering conditions to narrow down output so that only relevant data base rows are 
presented in the document output.

Report Type:  This report will list only computers that were manufactured by DELL and/or GATEWAY.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open a new FreeForm report.
2. In Page Setup, make sure that the Height is set to 8.5 and the Width is set to 11.
3. Enlarge the Page Header area an additional 3 blocks.
4. Select the following fields for your FreeForm report:

5. Add a title for your report, date, and time for your report to the Page Header area.
6. Add the document name and the page number to the Page Footer area.
7. Add a Group Header for the MfrName.
8. Move the MfrName column heading and data object into the Group Header area.
9. Select the filter icon  to display the filter dialog box.
10. Double-click on the Detail folder.
11. Double-click on UIC to move it to the Object Window.
12. Select the drop down arrow and chose “like” for the operator.
13. Enter W* for the value.  Remember to turn your Caps Lock on.
14. Click Add.
15. Double-click on MfrName Group Header.
16. Double-click on MfrName to move it to the Object Window.
17. Select the drop down arrow and chose “like” for the operator.
18. Enter *DELL* for the value.  Remember to turn your Caps Lock on.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Mfr._Model/Part_Number Mfr Name
Catalog Nomen

Stock Nbr
Serial_Hand_Receipt Acq Cost

Serial Nbr
Unit UIC
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19. Click Add.

20. Click OK.
21. Save your report as FFFILTER.
22. Process and view your report.

Example of finished report:

Once your condition is set, click Add to activate it.  If
you have an existing filter and you need to change it,
highlight the condition you wish to change, make the
change to the condition and then click Modify.
If you have an existing filter that you no longer need,
highlight the condition and click Delete.
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23. Close the output window.

Now, if we wanted to put another filter in to display information where the UIC began with W and the 
MfrName was Gateway, we would have to put in an OR condition.

24. Select the filter icon  to display the filter dialog box.
25. Double-click on UIC, from the Detail folder, to move it to the Object Window.
26. Select the drop down arrow and chose “like” for the operator.
27. Enter W* for the value.  Remember to turn your Caps Lock on.
28. Change the OR’d Group from 0 to 1.  This will set an OR condition.
29. Click Add.
30. Double-click on MfrName, from the MfrName Group Header, to move it to the Object Window.
31. Select the drop down arrow and chose “like” for the operator.
32. Enter *GATEWAY* for the value.  Remember to turn your Caps Lock on.

The OR’d Group should already be set to 1 since we changed it in the previous condition.

33. Click Add.

34. Click OK.

NOTE:
By default, all the conditions of your query are AND operators (i.e., all conditions have to be 
met before it will return your results).  However, you can connect your statements with OR 
operators, which divide your statements into groups.  For example, if you wanted to set your 
conditions by Stock Number AND Serial Number OR Bar Code, the OR’d Group would be 
set to 0 (zero) for Stock Number and Serial Number, and set to 1 for Bar Code.

Remember, the RULE is…If the OR’d Group numbers on any two statements are the same, 
those two statements are connected by the AND condition.  If the OR’d Group numbers on 
any two statements are different, those two statements are connected by the OR condition.
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35. Save your report.
36. Process and view report.
37. Close your report.

Example of the finished report:
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Hiding An Object In A FreeForm Report

Unit of Study:  If you choose to hide an object on your document, Eureka automatically creates a 
hidden area object to hold it.  These area objects are visible only in FreeForm windows.  They are not 
output as part of your document.  Hidden areas are also created when you base Output When, prompts, 
query filter, or value translation conditions on columns that are not included in your output.

Application:  In this activity, you will take the query from the previous exercise and hide the prompt so 
it will not be printed out on your report.

Report Type:  Asset listing by major hand receipt holder number (FFACTY).

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Select the Prompt object in your Page Footer area as the object to be hidden.
2. Right-mouse click to display shortcut commands.
3. Select Hide Toggle.
4. You can see the hidden prompt by displaying your Area Object List by depressing the F4 Function 

Key.
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5. Click on Hidden Document and your prompt will display in the Hidden Document area of your 
design document.

6. To hide it again, simply click on Hidden Page in the Area Object List.
7. Save your report.
8. Process your report.
9. Close your report.
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Inserting A Prompt In A FreeForm Report

Unit of Study:  A user prompt is an effective tool which allows input from the user to query the 
database.  There are varied user prompts you can utilize in FreeForm to add to your report and permit the 
user to access information promptly.  The objective of this lesson is to add a user prompt to a report.

When working with large databases, it may be a good idea to adjust the Prompt Row Limit.  Do this by 
choosing Tools > Preferences.  The default is 100 rows.   A value of 0 retrieves all rows (but this is not 
recommended for large databases).

Application:  In this activity, your instructor will guide you through creating a simple Hand Receipt in 
FreeForm.  After creating the query you will then insert a prompt which will ask the user which Hand 
Receipt Holder they would like to view.

Report Type:  Complete listing of assets by major hand receipt holder number.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open a new FreeForm report.
2. Enlarge the Page Header area.
3. Select the following fields for your FreeForm report:

4. Add a title, date, and time for your report to the Page Header area and customize with fonts, etc.
5. Add the document name, using the document name icon, to the Page Footer area.
6. Add the page number to the Page Footer area.
7. Add a Document Footer area.
8. Add “End of Report” in the Document Footer area.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Unit UIC
Activity Name

Hand_Receipt_Holder HRH Nbr Mjr
Serial_Hand_Receipt Acq Cost
Catalog Nomen
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9. Save your report as FFPROMPT.

10. Select the prompt icon  from the tool bar.

11. Object Label:  Enter HRH Prompt 
in the Object Label.  This is where 
you would enter the descriptive name 
for your prompt.

12. Sequence Number:  Accept the 
default of 1.  If you have more than 
one prompt, you can designate the 
order in which it will run by changing 
the sequence number.

13. Prompt:  Enter “Enter HRH”.  This 
is the prompt instruction.

14. Type:  Accept the default of String.  
If you selected a cost or date field,  
you can change the format of that 
field.
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15. Format:  The field displays the characteristics of the data (string, numeric, or date).  These come 
from the database file structure.

16. Character Width:  Select the amount of characters you want to display.
17. Choice Value To Add:  Leave this field blank.  This field will allow you to enter the fields that the 

user will select.  The choices will display in the window to the left.
18. Use Choices Only:  Do not select this radio button for this report.  Use this field to only select 

choices from a choice list.  You cannot type an entry for the prompt.  The choice list will consist of the 
entries you add to the Choice List.

19. Allow User Input:  Accept this default radio button for this report.  This radio button allows you to 
type an entry for the prompt or make a selection from a drop down box.  If you have defined a choice 
list, you can choose from the choice list or type an entry.

20. Allow Multiple Choices:  Do not check this box for this report.  Check this box to select multiple 
items from the choice list.  Each choice is added to the value of the user prompt object.  Choices are 
separated by semi-colons (;) or commas (,).  This option works in conjunction with the above two 
options.

21. Require Input:  Do not check this box for this report.

Type

String These are alphanumeric characters.

Numeric These are pure numeric characters.

Date Self-explanatory.

HINT!
To add an item to the Choice List, enter the choice in the Choice Value To Add field and click 
Add.

If you want to delete a value from the Choice List, highlight the value in the Choice Value To 
Add field and click Delete.

HINT!
Dynamic Choice List - A dynamic choice list is a list of choices that is generated at the time 
Eureka presents a prompt to the user, that is, at the time a user selects to preview, print, or 
export the document. It is created from the values returned by a database query, that is, it is a 
list of current database values

Steps to create a Dynamic Choice list:

1.  Use the Object Directory to find the column you want to use.
2.  Double-click or drag the column to the unlabeled choice list.  You can choose more than one column 

underneath one Business View.

Steps to create a Static Choice list:

1.  Use the Object Directory to find the column you want to use.
2.  Highlight the column and click on the Browse button from the Choice List.
3.  Add your values to the unlabeled choice list by double-clicking on the items one at a time.
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22. Appearance:  Refer to Designing A Customized FreeForm Report Without The Query Wiz-
ard for definitions for the appearance options.

23. Default Choice:  Leave the Default Choice blank for this report.  If you want a specific value to be 
defaulted in the prompt, enter the default choice.

24. Click OK.
25. Place the prompt in the Document Footer area.

In order to get the data you want from the prompt, you will need to apply a filter.  Filters make prompts 
active

1. Select Filter icon.
2. In the Objects window, double-click the Detail folder.
3. Double-click on HRHNbrMjr to move it to Object.
4. Set the Operator to = (equal).
5. In the Objects window, double-click on the Document Footer folder.
6. Double-click HRH_Prompt to move it to Value1.
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7. Click Add.

8. Click OK.
9. Save your report.

10. Process your report.
11. When prompted, enter W1NW54.
12. Click OK.

NOTE:
When adding the filter, you will need to select the data element as the Object and the prompt 
as the Value.
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13. Close the output window.
14. Save your report.
15. DO NOT close the report – we will continue to use it in the next Unit of Study.
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Designing A FreeForm Report Using Double Detail Areas

Unit of Study:  Designing a FreeForm Report

Introduction:  It is possible using Eureka to have multiple detail areas.  If you want to have extra 
information printed for certain rows, you can use a second detail area for the extra information.  You can 
also use multiple detail areas when you want to include detail about only some of the data returned.  For 
example, if you want to see a list of all computer monitors but were only interested in the cost for those 
that were manufactured by Dell, you would create a second detail area.  If adding a second detail area, 
you would want to use Output When (this is discussed later), otherwise, objects in the second detail area 
alternate output within original detail area.  Using Double Detail ensures that you will be able to print on 
standard paper, because you can limit your margins to the 8½” and use the second detail area for the 
additional information.

Application:  When designing a report where you need extra information printed for certain rows you 
can use the double detail process.

Report Type:  A Property listing showing the additional information Stock Nbr., Mfr Name, and Qty. On 
Hand in the double detail area.

Activity:  Student Hands-On with Instructor direction

Example of the Design Document:
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Example of the finished report:

INSTRUCTIONS:

STEP I.  BUILDING THE BASICS

1. Create a new FreeForm report.
2. Save your as FFDOUBLEDETAIL.

STEP II: DOCUMENT DESIGN WINDOW

1. Insert a Document Header area.
2. Insert a Document Footer area.
3. Insert a Detail Area:

a. Click on Insert from the menu bar.
b. Click on Area from the program group.
c. Click on Detail Area from the program list.

4. Enlarge the Page Header area 2 more blocks (for a total of 5 blocks).
5. Enlarge the first Detail area 3 more blocks (for a total of 4 blocks).
6. Enlarge the second Detail area 2 more blocks (for a total of 5 blocks).

7. Click on the text icon  and type a title that will go in the Document Header area; remem-
ber, to use the font tab and enlarge and bold the text plus add any other preferences you 
may want.

8. Repeat Step 7 for the Page Header area.
9. Add “End of Report” in the Document Footer area.

10. Insert the date in the Page Header area.
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11. Insert the page number in the Page Footer area.

STEP III:  DATA FIELDS FROM THE BUSINESS VIEW END ITEM SERIAL

1. Make sure your Object Directory is displayed (F2 Function Key).  Use the screen print 
on the first page of this handout for placement reference.

2. Select the data fields listed below:  You will be inserting these data fields in the 1st Detail 
area on the top line of that detail area, so the gray box is in the page header.

3. Close the Quick_Start! folder.
4. Open the Serial Hand Rcpt.-Auth folder.
5. Select the data fields listed below:  Insert Auth Qty in the 1st Detail area.

6. Move Auth Qty object (blue object) down one row and bring the Auth Qty column header 
(gray object) down to the row above the detail object.

7. Insert Qty On Hand in the 5th row of the 2nd Detail area, positioned in line with Auth Qty.
8. Move the column header (gray object) to be above the detail object (blue object).
9. Open the Quick_Start!folder.

10. Select the data fields listed below:  You will be inserting these data fields in the 2nd  detail 
area, lining them up under the 1¼” margin.

11. Bring the detail object (blue object) down to the 5th line.
12. Bring the column header (gray object) and line it up above the 4th line.

STEP IV:  ADDING A PROMPT AND FILTER

1. Insert a Prompt.
2. In the Prompt Label, enter “HRH Prompt”.
3. In the Prompt line, enter “Enter HRH Mjr Nbr”.
4. Click OK.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! Acq Cost Serial Nbr

HRH Nbr Mjr LIN
Nomen

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Serial_Hand_Rcpt.-Auth Auth Qty

Qty On Hand

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! Stock Nbr

Mfr Name
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5. Insert the prompt in the Page Footer area.
6. Click once on the prompt.
7. Right-mouse click and select Hide Toggle.
8. Insert a filter.
9. In the Object area pull from the Detail(1) folder the HRH Nbr Mjr.

10. Select = (equal) for the Operator.
11. From the Hidden Page folder, select HRH Prompt for Value1.
12. Click Add.
13. Click OK.
14. Save your report.
15. Process your report.
16. At the prompt, enter one of the following HRH numbers:

17. Click OK.

Example of the finished report:

W1NW55 W3VS10

W1V5U6 W46919

W1V5U7 W46920

W0U28A W4T809

W2MKJ2 W4T810

W2MKJ3 W4XQ85

W3VS09
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Using Translate Values In A FreeForm Report

Unit of Study:  Value translations allow you to substitute one value for another.  Translate Value is 
similar to a CASE structure of “If – Then – Else” logic.

You can use value translations to:

Replace a technical term or code with a familiar term
Draw attention to a significant value
Add more information about certain values

Application:  In this activity, you will still use the Hand Receipt report.  You will create a new custom 
column and a condition that will substitute the words “CAPITAL ASSET” in the custom column field, any 
time the cost is equal to or exceeds $100,000.

Report Type:  Complete listing of assets by major hand receipt holder number (FFPROMPT).

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open FFPROMPT.
2. Scroll over to the right of your report to display the last field.
3. Click on the Custom icon.
4. Double-click on the Detail folder.
5. Double-click on the AcqCost field to move to the Value window.
6. Using the calculator on the right of the window, click on x (multiply).
7. Click on 1.
8. Change the Character Width to 15.

9. Click OK.
10. Place the custom object into the detail area.
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11. Change the Custom column heading to Capital/Non-Capital.

12. Double-click on the CUSTOM field.
13. Select the Translate tab.
14. Double-click on the CUSTOM field in the Detail folder.
15. Set the Operator to >= (greater than or equal to).
16. Enter 100000 in Value1.
17. Enter CAPITAL in then Become.
18. Click Add Case.
19. Change Otherwise Become to NON-CAPITAL.

20. Click OK.
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21. Save you report.
22. Process your report (using S701 in your HRH prompt).

23. DO NOT close the report – we will continue to use it in the next Unit of Study.
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Using Output When In A FreeForm Report

Unit of Study:  Output When conditions allow you to set up the condition under which certain objects 
are included in your output.

Application:  We will be using Output When to set specific conditions under which an output object 
will be included in your report.

Report Type:  Accounting report that shows all assets for the major hand receipt holders, but only 
displays the acquisition cost when the condition is met.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. If closed, open FFPROMPT.
2. Double-click on the AcqCost data object (blue color).
3. Select the Output When tab.
4. Set the Operator to <= (less than or equal to).
5. Enter 5000 for Value1.
6. Insert Space When Not Output:  Check this box to determine whether or not Eureka 

inserts a space in your output when the object for which you are setting the condition is not 
output.

7. Click OK.
8. Save your report.

NOTE:
Output When works best when using multiple areas.  For example, if you have two detail 
areas, you may only what certain data objects to output when the condition you set is met.
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9. Process your report using S701 at the prompt.

Notice that the Acq Cost only displays the cost when the condition is met.
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Skill Builder:  Introduction To FreeForm And Designing A Custom-
ized FreeForm Report

Objectives:  You will:

Review, Introduction to FreeForm & Designing a Customized FreeForm 
Report (Exercise Below)
Discussion Questions
Practical Exercise to build a Customized FreeForm Report

Complete the following exercise:

1. Filters are used to (Please choose one):

a. Generate duplicate records.
b. Control which rows of detail data for output.
c. Include spaces in your report.

2. Is it possible to build a Prompt without a Filter?  (Yes or No)

Yes  _______ No  _______

3. I am a prompt and I allow the user only to select choices, which prompt type am I?

________________________________________________________________________

4. I am a prompt and I allow the user to select from a choice list, which prompt type am I?

________________________________________________________________________

5. I am a prompt and I allow the user to select multiple choice items, which prompt type am I?

________________________________________________________________________

6. Translate Value is similar to a CASE structure of "If - Then - Else" logic? (True or False)

True  _______ False  _______

7. When you do not set any Output When condition, every object is output all the time?  (True or 
False)

True  _______ False  _______

8. The F2 Function Key provides information regarding hidden objects?  (True or False)

True  _______ False  _______
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9. You must be in a FreeForm window to add or edit a user prompt object?   (True or False)

True  _______ False  _______

Discussion Questions:

1. Discuss the Prompt process:
a. Object label, what goes there.  Why is it important to signify it is a prompt?
b. Prompt label, what is entered here?

2. Why do you insert prompts in a report?
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Practical Exercise:  Introduction to FreeForm And Designing A 
Customized FreeForm Report

Unit of Study:  Introduction to FreeForm and designing a customized FreeForm report.

Application:  This process is used to allow the user to enter a designated value in the dialog box that 
is presented when your document is processed.  This prompt consists of text you have entered as a part of 
the object definition when building the prompt (i.e., ENTER HRH NBR MJR).

Report Type:  A customized Accounting Report by UIC or Mjr HRH to identify assets with a dollar 
amount of $1.00.

Instructions:

1. Open a new FreeForm report.
2. Expand the Page Header area an additional 4 blocks.
3. Select the following fields for your FreeForm report:

4. Add a title, date, time for your report and place the objects in the Page Header area (you can custom-
ize with fonts, etc.).

5. Add a page number to the Page Footer area.
6. Add a prompt for UIC and HRH Nbr Mjr and place in the Page Footer area.
7. Click on the UIC Prompt object.
8. Right-mouse click and select Hide Toggle to hide the prompt object.
9. Repeat to hide the HRH Prompt object.
10. Select the filter icon.
11. If the Detail folder is not open, double-click on it to open it.
12. Double-click on the UIC object.
13. Set the operator to = (equal).
14. Double-click on the Hidden Page folder to open.
15. Double-click on the UIC_Prompt to place it in the Value.
16. Click Add.
17. Repeat steps 12 through 16 for the HRH_Prompt.
18. Double-click on the Acq_Cost field.
19. Set the operator or <= (less than or equal to).
20. Set the value to 1 (for $1.00).
21. Click Add.
22. Click OK.
23. Click on the Print Preview icon.
24. Enter S710 for the HRH Nbr.
25. Enter HQ1010 for the UIC.
26. Click OK.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! UIC Acq Cost
HRH Nbr Mjr Nomen
Serial Nbr
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27. Save your report as FFPE2.
28. Close your report.

The report results will vary based on how you choose to develop the format.

Example of the finished report:
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Building A FreeForm Query Using The Parent/Child Function

INTRODUCTION

When we use the Parent/Child function, we create at least two documents.  The main document is 
the “Parent”.  A “Child” document is an attachment and an extension of the parent document.  This is 
done dynamically -- the query for the child document is submitted by the parent whenever it needs to 
include output from the child.  Any Eureka design document can be used as a child or as a parent 
document.  The primary reason for including data from another business view is whatever business 
view you are using for your report does not contain the data needed in the report.

There are two types of child objects in Eureka

1. Child Document Objects.  Each of these represents an entire document.

Child objects must first be created in a separate query design window and saved as a 
query design file (.iqr).
Child document objects permit the reuse of documents over and over as part of other 
documents.  These are building blocks that can speed up the development of queries.
Child document objects generate a query that is completely separate from the parent 
query.  Child objects submits a separate SELECT, SORT, and FILTERS to the database.
Child document objects query can also have a child document attached to it.

2. Child Data Objects.  Each of these represents a single object from a document.

Child Document Objects

The child document object represents one or more documents whose output is included as a part of the 
main document, the parent.

Child documents are used almost exclusively for two reasons:

To pull data from different business views into one report
To stop repeating of identical rows caused by mixing certain data fields

Passing values from a parent document to a child document is required when you need a row of 
information from the child document for each row in the parent document.  If you were using the child 
document to provide only a total cost, and you placed it in the document footer of the parent document, 
you would not need to pass the values from the parent.

However in most cases you want information from the child document for each row the parent selects, and 
you want to make sure the child is looking at the same row as the parent document.  That is, if the parent 
document is looking at serial number 105, then the parent wants child data for serial number 105.  This is 
done by passing values to the child document.

The parent can pass the serial number to the child to synchronize the child to the parent, it can also pass 
information the child uses to calculate custom data fields, and return them to the parent.

The child document is usually placed on the detail line of the parent document so it will output for each 
row in the parent document. 

Insert the child document object in the desired area.
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If you place the object in the Document Header or Document Footer area, the child object will 
appear only once at the beginning of the document or at the end of the document.  When a 
parent includes detail, this is a more efficient way to include summary data at the beginning or 
end of the parent rather than mingled with the detail.

If you place the object in the Page Header or Page Footer area, the child will appear once at the 
beginning or end of each page.  When a document is used as a child object, page header and 
footer areas do not appear in child documents.  It is recommended to only use these two areas for 
small child documents.

If you place the object in the Group Header or Group Footer areas, the child will appear once for 
each row that appears on your document.  This is useful when you want to represent data from 
more than one source and database that is different from the parent.

If you want the child to show only certain rows, place it in its own detail area, separate from the 
other columns in the parent document and set the Output When conditions for the area.

OBJECTIVES

Understand and demonstrate the ability to pass information between parent and child objects.  Using 
a Parent/Child document, you will draw data elements from two separate business views (or data 
sources) into a single report.  You will present a sample page of this .iqo (finished report) to your 
instructor.

APPLICATION

The parent/child function is the only way to pull data from two different business views into a single 
report.  For example, to generate your own hand receipt that contains both END ITEM SERIAL and 
END ITEM BULK business views.

REPORT TYPE

Asset listing with acquisition date and user IDs.

PREREQUISITES

Must be able to create a design document using FreeForm.

Complete the Chapters 1, 2 and 3 of this manual.

CAUTION!!
Take special care in deciding where to place the child document object.  Placing it in a detail 
area can result in the child document object being created numerous times and in the 
consumption of large amounts of system resources (depending on the nature of the query 
generated).  Depending on your needs, this may or may not be effective.  Similarly, if the child 
document object is in a page header or group header area, it is generated once for each page 
or group.
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ACTIVITY

Student Hands-On with Instructor direction.

Example of a Parent/Child Report:

STEPS TO PERFORM ACTION (Parent Document)

1. Create a new FreeForm report.
2. In the parent document, add the name of report and the date to the Page Header.

3. Add the page number and the document name of the report to the Page Footer.

NOTE:
It is always good practice to end the file name of the parent report with “par” and end the 
child report file name with “ch”.  If you have more than one child report, you may want to have 
the file names with “ch1”, “ch2”, and so on.
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4. Select the following fields for your Parent report from the table below.  Make sure that you put them to 
the left side of your design document:

5. Save the parent report as PC-Parent.

Child Document

1. Create a new FreeForm report.  If the parent report has been set to landscape, the child report must 
be set to landscape also.  Otherwise, when you attach the Child to the Parent, it will not show up.

2. Select the following fields for your Child report from the table below.  Make sure that the fields are 
placed approximately to the right of where the last field in parent was placed:

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog Stock Nbr

Nomen
Serial_Hand_Receipt Serial Nbr

BUSINESS VIEW:  HISTORIES

FOLDER(S) DATA ELEMENT(S)
History Acq Dt

User ID
144



Building A FreeForm Query Using The Parent/Child Function
3. Using the document name icon, insert the report name to the Page Footer.

4. Save the report as PC-Child.
5. Process the report.

Child Prompts

To make sure the child document returns information for the same row that the parent is looking at, a 
prompt is placed in the child document.  The prompt input comes from the parent for each row.  Visualize 
the parent looking for a row for serial number 105, it gives the serial number to the child prompt and the 
child pulls information for that row at the same time the parent is looking at that row.

1. Click on the Prompt icon.
2. For the Object Label, enter Serial Number Prompt.
3. For the Prompt message, enter “Enter Serial Number”.

NOTE:
Notice that the last field in 
the parent report, to the right 
ends at around 5½, so the 
child data field should start 
around 6½.

Figure 1 (Parent Report)

Figure 2 (Child Report)
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4. Change the Character Width to 20.

5. Click OK and place anywhere in the Page Footer.
6. Right-click on the Prompt object.
7. Select Hide Toggle.  Hiding the Prompt is optional.  If you want it displayed on the report, do not 

hide.

Child Filters

Once a prompt has been established, we must tell the child report how to limit data to the one serial 
number the parent has provided the child prompt for each row the parent report retrieves.  The child 
filter is used for this purpose.

1. Click on the Filter icon.
2. Click on the Columns tab, scroll to the HISTORIES Business View.
3. Double-click on the History folder.
4. Double-click on Serial Nbr to move it to the Object field.
5. Set the Operator to = (equal).
6. Click on the Objects tab.
7. Double-click on Hidden Page Folder.
8. Double-click on Serial_Number_Prompt to move it to Object 1.
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9. Click Add.

In this report, we are interested in the date and who posted this item to the property book.  The history 
file has a data field called PgmDesc.  There is a PgmDesc for all property book transactions.  These include 
EI INC L/T, EI DEC TI, EI INC RCPT, etc. and must be entered exactly as they appear in the History table.  
When this filter is added, this will restrict the child data to postings to the property book only.

10. Click on the Columns button.
11. Scroll to the HISTORIES business view.
12. Double-click on the History folder.
13. Double-click on PgmDesc to move it to Object field.
14. Set the Operator to = (equal).
15. For Value 1, type in EI INC RCPT.  Remember to turn your CAPS LOCK on.
16. Click Add.

17. Click OK.
18. Save the report.
19. Close the child report.
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Inserting the Child Document

1. If closed, open the Parent document.
2. From the menu bar, click Insert>Child Document.

-OR-

3. Click on the child document icon .
4. Place the child document object in the Detail area, to the right of the other objects.

NOTE:
In almost all cases, the child is anchored to the detail line.  In some special reports, the child 
document may be anchored to the group header or footer.
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5. Double-click on the Child Document icon in 
the detail area.

6. Object Label:  You can label your object if 
you wish.

7. Click the drop down box under File Name 
and click the Child Document that you cre-
ated.

8. Under Parent Objects, click the drop down 
box and select  SerialNbr on Detail[Area].  
This is telling you what data fields the Parent 
document is selecting.  It is also the common 
field between the parent and child docu-
ments.  If there are any prompts for the child 
report, they will be displayed in this window.

9. Select the radio button, Merge Child.  This insures the data from the child document will use the 
same size and font style as the parent.

10. Click OK.
11. Save your report.  The child document is now attached.

Since only the data from the child document Detail area is inserted into the parent, you may want to add 
column headings in the parent document for the data from the child document.

12. Click on the Text Box icon and add a column heading for the Acquisition Date and place it in the 
Page Header area at around the same place as where you placed it in the child document.

13. Repeat for the User ID.

NOTE:
Once you select the data field, it will be displayed in the Child’s User Prompts window.  This 
means that the child report will receive the selected field that the parent is looking at for each 
row of information.  This locks the reports together.

Scale to Object Scales the child document to the size of the child document object

Concatenate Creates a single text string from objects in the child document. Scaling is not 
used.

NOTE:
If you do not see the child data, check to ensure that the child data block on the child report is 
to the right of the most right hand block on the parent report.  Even though the data from the 
child report will appear on the parent report printout, the column header from the child report 
does not get displayed.  You must go into the text box and create a column header on the 
parent report.  Moving the child report icon to the left and right on the parent report will not 
move where the child data prints out.  This must be done on the child report by moving the 
data block.
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14. Save your report.
15. Process your report.

Example of the finished Parent/Child report:

Notice that the data from
the child report is displayed.
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Activity:  Designing A Parent/Child FreeForm Report

Unit of Study:  Designing a Parent/Child FreeForm Report

Application:  The parent/child function is the only way to pull data from two different business views 
into a single report.

Report Type:  A listing by UIC of the assets over $100,000 with information from both the End Item 
Serial Business View (UIC, Nomen, AcqCost, and StockNbr) and the Accounting Business View (Asset Cd, 
Acq Dt, Effective Dt. SerialNbr, and DolAmt.

Activity:  Student Hands-On with Instructor direction

Example of the finished Report:

Instructions:

Parent Document

1. Open a new FreeForm report.
2. Save your report as PC-Acty-Parent in the folder designated by your instructor.
3. Click to select the Page Header area.  Widen the Page Header Area area to 3 blocks high.
4. Add the Name of report (text) and the Date to the Page Header area.
5. Add the document name to the Page Footer area.
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6. Select the following fields for your report from the table below.  (Place to the left as far as 
possible).

7. Save your report.

Parent Filter

1. Click on the Filter icon.
2. Click on the Objects Tab.
3. Double-click on the Detail Folder.
4. Double-click on AcqCost to place it in the Object cell.
5. Set the Operator to >= (greater than or equal to).
6. Enter 100000 in Value1.
7. Click Add.
  

8. Click OK.
9. Save your report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! UIC
Nomen
Acq Cost
Stock Nbr
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Activity: Designing A Parent/Child FreeForm Report
10. Remember where the last data field is on your report.

Example of Your Parent Design Document:

Child Document:

1. Create a new FreeForm report.
2. Save your report as PC-Acty-Child  in the same folder as the PC-Acty-Parent document.
3. Select the following fields from the table below.  (Place these objects in the Detail area begin-

ning at the 6” mark on the ruler.  Otherwise, when you attach the Child to the Parent, it will 
not show up.

Summarized Report

4. Right-click on the Stock Nbr data field (blue object).
5. Select Hide Toggle.  This will be used for our Prompt and Filter.
6. Delete the column heading for Stock Nbr.
7. Double-click on each data object (blue object).
8. When the Attributes box comes up, check the Suppress Duplicates box.

BUSINESS VIEW:  ACCOUNTING TRANSACTIONS

FOLDER(S) DATA ELEMENT(S)

Accounting Stock Nbr Serial Nbr
Asset Cd Eff Dt
Acq Dt Dollar Amt
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9. Save your query.

Example of the Child Document Design:

Child Prompts:

To make sure the Child Document returns information for the same row that the Parent is looking at, a 
prompt is placed in the Child Document, the prompt input comes from the Parent for each row.  
Visualize the Parent looking for a Row for Stock Number 1234, it gives the Stock Number to the child 
prompt and child pulls information for that row at the same time the parent is looking at that row.

1. Click on the Prompt icon.
2. Enter StockNbrPrompt for the Object Label.
3. Enter “Enter Stock Number” for the Prompt message.
4. Change the Character Width to 15.
5. Click OK.

6. Place the prompt object anywhere in the Page Footer area.
7. Right-click on the prompt.
8. Select Hide Toggle to hide your prompt.
9. Save your report.
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Activity: Designing A Parent/Child FreeForm Report
Child Filters:

Once a prompt has been established, we must tell the child report how to limit data to the one Stock 
Number the parent has provided the child prompt for each row the parent report retrieves.  The Child 
filter is used for this purpose.

1. Click on the Filter icon.
2. Click on the Columns tab.
3. Scroll to the ACCOUNTING TRANSACTIONS business view.
4. Double-click on the Accounting folder.
5. Double-click on Stock Nbr to move it to Object.
6. Set the Operator to = (equal).
7. Click on the Objects tab.
8. Double-click on Hidden Page.
9. Double-click on StockNbrPrompt to move to Object.

10. Click Add.

Additional Child Filter:

We want our Child to return the Accounting information for items with a value greater than or equal to  
$100,000 only.  To do this, we need to filter our Child Data before it is returned to the Parent.

1. Double-click on the Detail Folder.
2. Double-click on DollarAmt to move it to Object.
3. Set the Operator to >= (greater than or equal to).
4. Enter 100000 in Value1.
5. Click Add.
6. Click OK.
7. Save your report.
8. Close your report.
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Activity: Designing A Parent/Child FreeForm Report
Inserting the Child Document:

1. Open the Parent Capital document.
2. Click Insert>Child Document from the menu Bar.
3. Place the Child Document object in the Detail area, to the right of the other objects.
4. Double-click on the Child Document icon.
5. Click the drop down button under File Name and select the Child Document that you created.
6. Click the drop down box for Parent Objects.
7. Select StockNbr on Detail (Area).  This is what the Parent will answer with when the Child 

asks the Prompt.
8. Select the radio button Merge Child.  This will maintain the font style and size between the 

Parent and Child.

9. Click OK.
10. Save and view the report.  Do not click on the last page icon as this report is very long.
11. Close the report.
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Activity: Designing A Parent/Child FreeForm Report
Adding Headers to the Parent/Child Report:

1. Open the parent report.
2. Click on the text icon and add headers for the following:

Asset Cd Eff Dt
Acq Dt Dollar Amt
Serial Nbr

3. Process your report.
4. To place columns where you want them to print out on the parent document, go to the child 

document and move the data fields to the left or right on the detail line.  You may need to re-
align the headers after processing the report.

5. Save your report.
6. Process your report to view.

7. Close your report.
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Skill Builder:  Building A Parent/Child FreeForm Report

Objectives:  You will:

Review Building a Parent/Child FreeForm Report (Word Exercise)
Discussion Questions

Practical Exercise to build a Parent/Child FreeForm Report

Complete the following exercise:

1. Child Documents are used almost exclusively for:

2. Each document always pulls from different business views.  (True or False)

True  _______ False  _______

3. If you place the object in Document Header or Document Footer area, the child object will appear 
only_________at the _____________or _____________of the report.

4. Insert the Child document object in the desired area. (Circle all that apply)

a. If you place the object in the Page Header or Page Footer area, the child will appear once at the begin-
ning or end of each page.

b. If you place the object in the Group Header or Group Footer areas, the child will appear once for each 
row that appears on your document.

c. If you place the object in the Document Header or Document Footer area, the child object will appear 
on every page of the document.

d. If you want the child to show only certain rows, place it in its own detail area, separate from the other 
columns in the parent document and set the Output When conditions for the area.

5. It is recommended, but not mandatory, for Parent/Child reports that you change the orientation to 
___________.

6. How do you insert the Child Document in the Parent Document?

__________________________________________________________________________________
__________________________________________________________________________________

7. To make sure the child document returns information for the same row that the parent is looking at, a 
_______________ is placed in the child document.

a. _______________________________________________________________________________

b. _______________________________________________________________________________
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Skill Builder: Building A Parent/Child FreeForm Report
8. When you select the radio button Merge Child, this insures the data from the child document will use 
the same size and font style as the parent.  (True or False)

True  _______ False  _______

Discussion Question:

• Review the Parent/Child function from beginning to completion.  Name the different pro-
cesses involved.
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Practical Exercise:  Designing A Parent/Child FreeForm Report

Independent Student Report

Unit of Study:  Designing a Parent/Child FreeForm Report

Type Of Report:  For this practical exercise we will be designing a report that uses the Parent/Child 
function to combine two reports. These two reports can be from the same  or different Business Views.  
For this report we will be using the same business view. This report will first summarize all assets of each 
HRH Name listed in the database.  That  information will be combined with a HRH Name listing of all 
assets with the Nomen, StockNbr, SerialNbr, and AcqCost on individual pages.

Instructions:  Use the table listed below to build an Accounting Report.

Example of the finished report:

Parent Document:

1. Create a new FreeForm report.
2. Save your report as PC-PE-Parent in the folder designated by your instructor.
3. Expand the Page Header area an additional 2 blocks.
4. Using the document name icon, add the report name to the Page Footer area.

Summarized Report
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Practical Exercise: Designing A Parent/Child FreeForm Report
5. Select the fields from the table below and place them to the left in the detail area.

6. Expand the Detail area to 2 blocks.
7. Save your report.
8. Using the text icon, enter “Detail Report” (enhance the title using the font, border, etc. tabs).
9. Double-click on each data object (blue object) and check the check box for “Suppress Dupli-

cates”.
10. Highlight the HRH Name (blue object), go to the tool bar and click on group header icon.
11. Move both HRH Name objects into the HRHName Group Header area.
12. Expand the HRH Name Group Header area to 6 blocks.

13. Move the HRHName data object (blue object) below the HRHName text object (gray object).
14. Move all of your object boxes over to the right where the HRHName stops.
15. Rubberband all the object boxes (gray objects) and move into the HRHName Group Header 

area.
16. Rubberband all the data objects (blue objects) that are in the Detail area and move them up 

to the top of the Detail area.
17. Double-click in the blank area of the HRHName Group Header area.
18. In the Page Skip group box, set Before Area to 1.
19. Click OK.  This will create a page break.
20. Add a Document Header area.
21. Add a second Document Header area.
22. Expand the new Document Header area to a total of 8 blocks.
23. Save your report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! HRH Name Serial Nbr
Nomen Acq Cost
Stock Nbr
161



Practical Exercise: Designing A Parent/Child FreeForm Report
Child Document:

1. Create a new FreeForm report.
2. Save your report as PC-PE-Child in the same folder as PC-PE-Parent.
3. Select the data elements from the table below:

4. Widen the Detail area to 2 more blocks.
5. Double-click on each data element (blue object) and check the check box for “Suppress Dupli-

cates”.
6. Double-click on the blue Acq Cost.
7. Click on the drop down box for the Aggregate function and select sum.
8. Click OK.
9. Save your report.

10. Close your report.

Example of the Child Document Design:

Parent Document:

1. Open PC-PE-Parent.
2. Click on Child Document icon.
3. Insert the child document icon in the Document Header(1) area.
4. Double-click on the Child Document icon.
5. In the File Name, click the browse button and go to the directory where the child report is 

saved.
6. Select the PC-PE-Child document to insert your Child Summary report.
7. Click radio button for Merge Child.
8. Click OK.
9. Save your report.

10. Process your report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! HRH Name
Acq Cost
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Child Data Objects

INTRODUCTION

A child data object represents the data fields from one document (a child document) that you include 
as part of another document (a parent document).  Two or more reports must be written.  The parent 
report must contain the child document object (which should be hidden)

OBJECTIVES

Understand and demonstrate the ability to pass information between parent and child objects. Using 
a Parent/Child document, you will draw data elements from two separate business views (or data 
sources) into a single report.

APPLICATION

For this report you will demonstrate the ability to use one data field and incorporate it into the Parent 
Report. You have been asked to design a report. In this report we will use Document Number from 
the Document Register Business View.

REPORT TYPE

Asset Listing, by HRH Nbr Mjr, listing Nomen, Stock Nbr, Serial Nbr with Acq Cost plus listing the doc-
ument nbr from the document register.

PREREQUISITES

Two (or more) reports must be written.  The parent report must contain the child document object 
(which should be hidden).

ACTIVITY

Student Hands-On with Instructor direction
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Example of the finished child data report:

Example of the design document:
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STEPS TO PERFORM ACTION (PARENT DOCUMENT)

1. Create a new FreeForm report.
2. If not the default, change the orientation to Landscape.
3. In the parent document, add the name of report and the date to the Page Header.

4. Add the page number and the document name you will assign to the report to the Page Footer area.
5. Select the following fields for your Parent report from the table below.  Make sure that you put them to 

the left side of your design document:

6. To limit the information to the HRH Nbr Mjr of choice, we will filter on the HRH Nbr Mjr.
7. Click on the Filter icon.
8. Open the Detail folder.
9. Double-click on HRH Nbr Mjr to move it to the Object field.
10. Set the Operator to “Like”.
11. Enter W* (cap locks on) in Value1.
12. Click Add.
13. Click OK.
14. Save your report as PC-CDO-Parent.
15. Process your report.

Child Document

1. Create a new FreeForm report.  If the parent report has been set to landscape, the child report must 
be set to landscape also.  Otherwise, when you attach the Child to the Parent, it will not show up.

2. Select the following fields for your Child report from the table below.  Make sure that the fields are 
placed approximately to the right of where the last field in parent was placed:

NOTE:
It is always good practice to end the file name of the parent report with “par” and end the child 
report file name with “ch”.  If you have more than one child report, you may want to have the 
file names with “ch1”, “ch2”, and so on.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Catalog Stock Nbr Nomen

Serial_Hand_Receipt-Auth Serial Nbr Acq Cost

Hand_Receipt_Holder HRH Nbr Mjr

BUSINESS VIEW:  DOCUMENT REGISTER

FOLDER(S) DATA ELEMENT(S)

Doc_Nbr_HRH Doc Nbr
HRH Nbr Mjr
Stock Nbr
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3. Add the file name you will assign to the report to the Page Footer area.
4. Save your report as PC-CDO-Child.
5. Process your report.

Child Prompts

To make sure the child document returns information for the same row that the parent is looking at, a 
prompt is placed in the child document.  The prompt input comes from the parent for each row.  Visualize 
the parent looking for a row for serial number 105.  The parent gives the serial number to the child prompt 
and the child pulls information for that row at the same time the parent is looking at that row.

We will be using HRH Nbr Mjr and Stock Nbr for the prompts.

1. Click on the Prompt icon.
2. For the Object Label, enter HRH Nbr Mjr Prompt
3. For the Prompt message, enter “Enter HRH Nbr Mjr”.
4. Change the Character width to 6.
5. Click OK and place anywhere in the Page Footer area.
6. Right-click on the Prompt icon and Hide Toggle.
7. Click on the Prompt icon.
8. For the Object Label, enter “Stock Nbr Prompt”.
9. For the Prompt Message, enter “Enter Stock Nbr”.
10. Change the Character Width to 15”.
11. Click OK and place anywhere in Page Footer area.
12. Right-click on the Prompt and Hide Toggle

Child Filters

Once a prompt has been established, we must tell the child report how to limit data to the one serial 
number the parent has provided to the child prompt for each row the parent report retrieves.  The child 
filter is used for this purpose.

1. Click on the Filter icon.
2. If not open, click on the Objects tab and open the Detail and Hidden Page folders.
3. In the Detail folder, double-click on the HRH Nbr Mjr to move it to the Object field.
4. Set the Operator to = (equal).
5. In the Hidden Page Folder, double- click on HRH Nbr Mjr Prompt to move to Value1.
6. Click Add.
7. In the Detail folder, double-click on Stock Nbr to move it to the Object field.
8. Set the Operator to = (equal).
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9. In the Hidden Page folder, double-click on Stock Nbr Prompt to move it to Value1.
10. Click Add.

11. Click OK.
12. Save your report.
13. Close the Child report.

Inserting the Child Document

1. If closed, open the Parent document.

2. From the menu bar, click Insert>Child Document OR Click on the child document icon .
3. Place the child document object in the Detail area, to the right of the other objects.
4. Double-click on the Child Document icon in the Detail area.
5. Click the drop down box under File Name and click the Child document that you created.
6. Under Parent Objects, click the drop down box and select HRH Nbr Mjr on Detail (Area).  This is 

telling you what data fields the Parent document is selecting.
7. In the Child’s User Prompts window, highlight Stock Nbr Prompt.
8. Under Parent Objects, click the drop down box and select Stock Nbr on Detail (Area).  This is tell-

ing you what data fields the Parent document is selecting.
9. Mark the radio button, Merge Child.  This insures the data from the child document will use the 

same size and font style as the parent.
10. Click OK, it is now attached, save the report.

Inserting Child Data

1. On the parent report, highlight the child document icon, right click and select Hide Toggle.
2. Select Insert>Child Data from the menu bar or click on the Child Data icon from the menu bar.
3. The Child Object window appears.  In the child document area, click on the drop down arrow and 

select the child report you designed.  This will open up the Object In Query Area.
4. In the Object Label, enter “Doc Nbr”.
5. Change the Character Width to 14”.
6. For the Object Query, click on the drop down arrow and select Doc Nbr on Detail (Area).
7. Click OK.
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8. Your cursor becomes a precision pointer.  Drop the pointer in the detail area next to the last data 
object.

9. Click on the text icon (abc).
10. Enter “Document Nbr”.  In the Font tab, check the radio buttons for bold and underline.
11. Place in the Page Header area above the Child Data Object.
12. Save your report.
13. Process your report.

This may take a few minutes to process.
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Hot Objects

Unit of Study:  A hot object is an object on your document that is linked to a second document.  
When you are viewing the output, clicking the hot object tells Eureka to process the linked-to document 
and to display its output in a new window.  A hot object is not a Eureka object type; any component object 
can be made hot by filling out entries on the Hot Object tab for that object.  Columns in a report that have 
been designated as hot object columns will be blue in color.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open or create a FreeForm report.
2. Expand the Page Header area 2 more blocks.
3. Select the following fields for your FreeForm report:

4. Using the text icon, add the title of the report and date to the Page Header area.
5. Using the Document Name icon, add the document name to the Page Footer area.
6. Add the page number to the Page Footer area.
7. Process your report.
8. Save the report as PC-HOTOBJ-Parent.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! Stock Nbr
Nomen
Serial Nbr
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Hot Objects
Creating a Child for Hot Objects

Instructions:

1. Open a new FreeForm report.
2. Select the following fields for your FreeForm report:

3. Drag Document Number to the Detail area.
4. Using the text icon, add a title for your report and place in the Page Header area.  Enhance your title 

using the font, border, etc. tabs.
5. Add the date to the Page Header area.

BUSINESS VIEW:  HISTORIES

FOLDER(S) DATA ELEMENT(S)

History Doc Nbr
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Creating a Prompt for a Hot Object Child

To make sure the child pulls up the information that is needed, a prompt will need to be created.

1. Click on the prompt icon.
2. Enter “SerialNbrPrompt” in the Object Label.
3. Enter “Enter Serial Number” in the Prompt.
4. Change the Character Width to 20.

5. Click OK.
6. Place the prompt object in the Page Footer area.
7. Right-click on SerialNbrPrompt and click Hide Toggle.

Adding a Filter to the Hot Object Child

Now you must tell the child what to do with the prompt information that the parent will send.

1. Click on the filter icon.
2. From the Object directory, click on the Columns tab.
3. Scroll to the HISTORIES business view.
4. Select the History folder.
5. Double-click on Serial Nbr to move it to the Object.
6. Set the operator to = (equal).
7. Click on the Objects tab.
8. Double-click on the Hidden Page folder.
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9. Double-click on SerialNbrPrompt to move it to Object1.
10. Click Add.

11. Click OK.
12. Save your report as PC- HOTOBJ -Child.
13. Close the report.

Creating the Hot Object

1. Open the Parent report, if you previously closed it.
2. Double-click on the Serial Nbr object in the Detail area.
3. Click on the Hot Object tab.
4. File Name:  Click the drop down box and select the Hot Object child that was created.
5. Parent Objects:  Click the drop down box and select SerialNbr on Detail (Area).
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6. Click OK.
7. Save your report.
8. Process your report.
9. Click on a BLUE serial number to obtain additional information about the item.
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Introduction To Enhanced Eureka

This section of the Eureka training and reference manual describes some of those functions which in 
most cases are not “routine” to the every day user.  Among the topics covered are inserting charts 
and crosstabs into your reports and queries.  You will also learn how to generate labels with informa-
tion drawn from your DPAS data.  Finally, you will learn how to create and use a Personal Data Mart.

OBJECTIVES

You will gain a familiarity with the advanced functions found in this chapter, so that you can use them 
when the occasion arises.

APPLICATION

A chart may be an excellent way to represent items on your Property Book, for example, number of 
items entered into the property book per month, in order to show trends in how work is distributed.  
A Personal Data Mart can be a tool used to facilitate your work in developing reports remotely from 
your on-line database, or to limit the amount of data which your report will look at. 

PREREQUISITES

A fundamental understanding of FreeForm documents.

ACTIVITY

Student Hands-On with Instructor direction



Charts
Charts

Unit of Study:  Chart objects generate their own query that is completely separate from the initial 
main document query.  A chart object is used to illustrate graphically your report output.

Eureka allows you to include eight different types of charts in your document:

Three-dimensional area charts
Two-dimensional and three-dimensional bar charts
Two-dimensional and three-dimensional line charts
Two-dimensional and three-dimensional pie charts
Scatter chart

Experiment with different chart types for displaying your data. As a general rule, the more complex your 
data, the simpler a chart type you should start with.

Application:  Property listing with output to include a chart object to illustrate graphically your data 
results.

Report Type:  Asset listing by HRH Nbr Mjr, HRH Name with Bar Cd and Acq Cost.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Create a new FreeForm report.
2. Select the following fields for your FreeForm report:

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Hand_Receipt_Holder HRH Nbr Mjr
HRH Name

Serial_Hand_Receipt Bar Cd
Acq Cost
CH 2 176
1 October 2004



Charts
3. Save your report as CHART.
4. Process your query.

5. Close the report viewer.

6. Select the chart icon  from the tool bar.
7. Place the chart object into the Page Footer area of your document.
8. Click on the chart object and drag out to enlarge the icon to about half a page.

9. Double-click on the chart icon.

NOTE:
A chart is only as big as the chart object that is placed on your report.  You will need to resize 
the object by grabbing the handles (click on the object once to get the handles) and drag the 
object to the desired size.
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10. Select the Chart Types button.
11. Select 3D Pie.

12. Title:  Enter $ By HRH Nbr Mjr.
13. Click on the Objects button.
14. Double-click on the Detail folder.
15. Click, drag and drop the Acq Cost field to the Pie Slice Values.  This field is grayed out, but you will 

still be allowed to drag the object into the field.
16. Click, drag and drop the HRH Nbr Mjr to Pie Slice Labels.  This field is grayed out, but you will still 

be allowed to drag the object into the field.
17. In the Chart Attributes group, check Display Legend.
18. In the Gradient group, accept the default of None.

Gradient

Top Down White at the top blending to black at the bottom.

Center Out White in the center blending to black at the outside.

Bottom Up White at the bottom blending to black at the top.

NOTE:
Background gradients take precedence over other chart backgrounds.  They are always white-
to-black blends.
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19. In the Summary group, select Sum.

20. Do not change Appearance.

21. Select the Filter tab.
22. Click on the Objects tab.
23. Double-click on the HRH Nbr Mjr to add to the Object.
24. Set the Operator to Between.
25. Set Value1 to W1DC03.
26. Set Value2 to W1NW54.

Chart Attributes

Draw Grid Select this check box to include grid lines in the output.

Percentile Bar Chart Select this check box to have calculations expressed as a percentage of the overall total.  For pie 
charts, which are always percentile charts, this item is called “% of Total” Labels and controls 
whether labels are shown as totals or percentages.

Display Labels Select this check box if you wish to output labels along the axes of the chart.  (Horizontal axis labels 
appear only when you use a Group By object.)

Display Legend Select to show an index of the colors/patterns corresponding to different Area Labels column values.  
(Only available when you use a Group By object.)

Appearance

Snap To Grid This has been defined in Chapter 3.

Hide This has been defined in Chapter 3.

Append Parent’s Filter This has been defined in Chapter 4, Parent/Child.

If you use the chart dialog box’s Filter tab to define a filter, selecting this check box 
combines the two filters using an AND relationship – rows must meet both filters in order 
to be included in the chart.

Unless you tell it otherwise, Eureka includes all database rows.  To have your chart include 
only those rows that are included in your document, make sure that the Append Parent’s 
Filter option is selected.

Native SQL Translate Value This check box controls whether Eureka Reporter Designer

Includes value translation requests as part of its query for chart information, or
Performs value translations itself

By default, Eureka does not include value translation requests as part of its query.  Check 
this box to have it do so.  When this is done, sorting and grouping are based on the 
translated value (when your database manager or ODBC database driver supports the SQL 
syntax required to do this).  If you want sorting and grouping based on the untranslated 
value, make sure this box is not checked.
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27. Click Add.

28. Click OK.
29. Save your report.
30. Process your report.

31. Close your report.

NOTE:
You can set a specific query filter to control which rows are included in the chart.  To do this, 
select the Filter tab from the Chart dialog box.

The entries you make on this tab affect which rows are included in your chart.  They do not 
affect when the chart is included in your document.  To set the conditions that affect when the 
chart is included, select the Output When tab.

If you both select Append Parent’s Filter and set up a query filter using the filter tab on the 
Chart dialog box, the two filters work together.  Only rows satisfying both filters will appear.
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Crosstabs

Unit of Study:  A crosstab object is an object that outputs an entire cross-tabulation document.  It 
uses three component objects:  columns, rows, and aggregate.  The crosstab provides an aggregate 
calculation, such as total, count, etc. for the aggregate object for each different combination of values in 
the other two objects.

Crosstabs are similar in appearance and function to a matrix, or spreadsheet-style, document.  Like chart 
objects, crosstab objects generate a query that is completely separate from the original document query.

A chart object is used to illustrate graphically your report output.

Think of a crosstab as a special type chart.  It is similar to appearance and function to a matrix or 
spreadsheet-style document.  The rules which applied to creating a chart object, generally are the same 
for a crosstab object.

A crosstab object outputs an entire cross-tabulation document (a crosstab, for short) (think of an Excel 
spreadsheet).  In its simplest form, a crosstab uses three component objects. Each must be a column or a 
custom object from your Metadata file.

An object defined in your Metadata file for the crosstab's vertical columns. We call this the 
columns object. These values are listed across the top of the crosstab.

An object for crosstab lines. We call this the rows object. These values are listed at the beginning 
of each line of the crosstab.

An object to be summarized in the cells of the crosstab. We call this the aggregate object.

The crosstab provides an aggregate calculation, such as total, minimum, average, etc., for the aggregate 
object for each different combination of values in the other two objects.

Crosstabs are stored in files separate from your design document.  This allows the same crosstab to be 
reused as a building block in additional design documents.

Activity:  FSC Inventory with output to include crosstab to illustrate graphically your data results.

Report Type:  FSC Inventory listing to include HRH Nbr with sum of property value.

Activity:  Student Hands-On with Instructor direction
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Instructions:

1. Create a new FreeForm report.

2. Select the crosstab icon  from the tool bar.
3. Insert the crosstab object into the detail area of your document.
4. Double-click on the crosstab icon.

5. Crosstab File Name:  Enter FSC Inven-
tory.  Eureka will automatically add the .iqr 
extension.

6. Click on the Columns tab  (if it isn’t already 
selected).

7. Scroll to the END ITEM SERIAL Business 
View.

8. Double-click on the Quick_Start! folder.

9. Click, drag and drop the FSC field to the Columns window.
10. Click, drag and drop the HRH Nbr Mjr field to the first Rows window.
11. Click, drag and drop the Acq Cost to the second Rows window.  The Aggregate radio button will 

default to Sum.

12. Column Title:  Enter FSC Inventory.
13. Row Title:  Enter HRH.
14. De-select the Scale to Object in the Appearance area.

NOTE:
Select objects within each entry box in 
the order they should be used.  To 
change the order, they must be 
removed and re-added.  To remove an 
object, select it and press Delete.

NOTE:
The Swap Axis button swaps the definition for columns and rows.  After clicking this button, 
the columns that were used to define crosstab columns are used for the crosstab rows.  The 
columns that were used to define crosstab rows are used for the crosstab columns.

NOTE:
If you want to include totals for the columns and/or rows, then check the appropriate box(es).  
This default is checked.
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15. Click on the Crosstab Styles button.
16. Select the style with the red border.

17. Click on the Filter tab.
18. Click on the Objects button in the Object 

directory.
19. Double-click on the Acq Cost field to move 

it to Object.
20. Set the Operator to > (greater than).
21. Set Value1 to 10000.
22. Click Add.
23. Double-click on the FSC field to move it to 

Object.
24. Set the Operator to Between.
25. Set Value1 to 3411.
26. Set Value2 to 3930.
27. Click Add.
28. Click OK.
29. If your default page setting is not already set 

to Landscape, change your page setup to 
Landscape.

30. Save your report as CROSSTAB.
31. Process your report.

Example of finished report:
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Three-Dimensional Crosstabs

Eureka can also create a three-dimensional crosstab.  Place a database column in the Sheet Groups control 
of the dialog box.  When Sheet Groups are used, Eureka outputs a separate crosstab (not necessarily a 
separate “sheet” or “page”) for each different value in the column.  For instance, using Manufacturer as 
the Sheets column will generate separate crosstabs for each manufacturer as well as combined totals for 
all manufacturers.

Using Multiple Column, Row, Cell, and Sheet Objects

More than one database column can be used in the above objects.  When multiple database columns are 
used, Eureka outputs a line (or column or sheet) for every combination of values.

Building and Using Crosstab Libraries

Each crosstab object refers to and/or creates a child object, allowing you to build a library of crosstab 
objects to use in different documents.

To use an existing crosstab design file as a crosstab object:

1. Open the crosstab dialog box.

2. Click the Browse button  next to the Crosstab File Name input box.  Eureka opens a file selection 
dialog box.

3. Select the file containing the crosstab you want to include.  Eureka reads the file and displays its val-
ues in the dialog box.

If a password was assigned to the document, Eureka prompts you for the password before loading the file.  
A password is assigned by opening the crosstab design (*.iqr) file in Eureka  Passwords cannot be 
assigned in the crosstab dialog box.  Make any desired changes to the crosstab object and click OK.  Be 
sure to change the file name shown at the bottom of the dialog, so you do not overwrite the file that was 
imported.

NOTE:
If you want to prevent sheets from being split between two pages, do not select the Scale to 
Object option for the crosstab.  When you select Scale to Object, Eureka will split sheets over 
pages (depending on the size of the object, the size of your page, and similar factors).
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Graphics

Unit of Study:  Graphics represent a type of output object that will be included in your document 
when it is viewed or printed.

Application:  This process is for adding graphics (output objects) to a new or existing document.

Report Type:  Open the FFACTY report.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Open your FFACTY report.

2. Select the graphic icon  from the tool bar.

3. Place the graphic object in the left-hand side margin of the Document Header area.
4. Double-click the graphic object.

5. Enter a label for your graphic object.
6. Set the Height to 1.04.
7. Set the Width to 1.04.

NOTE:
Use the Height and Width to make 
your graphic larger or smaller.

A graphic is only as big as the graphic object 
that is placed on your report.

You can also resize the object by clicking on the 
object once, and then grab the handles and 
drag the object to the desired size.
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8. Click on the Image/Border tab.
9. If you want a border around your graphic, 

click on the list box and select the desired 
Line Weight.  You can also set the point size, 
add shadowing and use customized settings.

10. If you want a background for your graphic, 
select a pattern; otherwise, check the 
Transparent check box.

11. If desired, change the border, shadow, fill, 
and/or pattern color(s).

12. Click on the browse button next to File 
Name.

13. Change Look In: to C:.
14. Double-click on Eureka.
15. Double-click on Reporter.
16. Double-click on Designer.
17. Double-click on the Sample folder.
18. Double-click on the World.bmp file.

You will notice that in the Sample area, a picture of your graphic is displayed.
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19. Click OK.

Example of the Design Document:

20. Click OK.
21. Save your report.
22. Process your report.

Example of the finished report:

23. DO NOT close the report – we will continue to use it in the next Unit of Study.
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Creating Icons For Your Desktop

Unit of Study:  This process will show you how to create a report icon for your desktop.

Application:  When you want your documents to be viewed, printed, or exported directly from 
Windows by creating a program item or shortcut represented by an icon that you designate to be in 
Start>Programs>Accessories.

Report Type:  Open the report FFACTY

Activity: Student Hands-On with Instructor direction

Instructions:

1. Open the FFACTY report.
2. Select Tools from the menu bar.
3. Select Auto Shortcut Builder… from the program group.

4. Description:  Eureka will default this field with 
your report title.  Depending on which radio but-
ton you select (View, Print, or Export), it will be a 
part of your Description.

5. Accept the default View.

6. Export Format:  If you selected Export, you will 
need to select the export format.

7. Click on the Program Group list box and select Accessories (All Users).  Your icon will be save to 
the Program Group that you specify.

8. Click on the list box for Current Icon.
9. Select your desired icon.
10. Click OK.
11. Save your report.
12. Close your report and return to your desktop.

NOTE:
You cannot create an icon for a NOT YET SAVED document!!!

View Select this if you want to view your report on the 
screen.

Print Select this to sent your report directly to your 
default printer.

Export Select this to export your report to another applica-
tion.
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13. Click on the Start button.
14. Select Programs.
15. Select Accessories.
16. Select Eureka-Reporter Designer View_FFACTY.

Your report will be automatically processed and displayed.

17. Close the output window.
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Creating Labels

Unit of Study:  To create labels in Eureka, you can use the Avery label templates.  Templates are 
predefined design documents that you can use as a model for a new document.  These templates include 
objects on them but are not linked to specific columns.  You also have the option of creating custom 
templates of your own.

Labels in are created with a new document from a template.  When you select New From Template from 
the File menu, Eureka opens a file selection dialog box.  Use the List Files of Type control to select the type 
of template you want to start with.  Select the template you want to use.  Most templates distributed with 
Eureka are installed into the template subdirectory of the Eureka directory.  Templates for use with Avery 
mailing labels are installed into template\avery.  When you click Open, the selected template is loaded and 
a new window for it is opened with the name Untitled.

Application:  This process involves the use of predefined design templates to specify specific data you 
want to appear on a label.

Report Type:  Label design listing Stock Nbr, Nomen, Bar Cd, Location, Serial Nbr, plus who the 
property is assigned to.

Activity:  Student Hands-On with Instructor direction

Instructions:

1. Click File>New From Template.
2. Look in:  Select C:.
3. Double-click on the Eureka folder.
4. Double-click on Reporter.
5. Double-click on Designer.
6. Double-click on Template.
7. Double-click on the Avery folder.
8. Change Files of type to Mailing Labels (*.iqm).
9. Select A4_I7160.iqm.

After choosing a label design, it will produce a screen similar to the above, depending on what label design 
was selected.
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10. Double-click on COLUMN.
11. Scroll to the END ITEM SERIAL business 

view.
12. Scroll to the Serial_Hand_Receipt folder.
13. Double-click on Bar Cd.
14. Click OK.  You are returned to the Design 

Document.
15. Click OK.
16. Using the table below, repeat the steps for 

the remaining label fields.

17. Save your report as Label.
18. Process your report.

19. Close the report viewer.
20. Close your report.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Catalog Stock Nbr
Nomen

Serial_Hand_Receipt Loc
Serial Nbr

Hand_Receipt_Holder HRH Nbr Mjr
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Creating A Personal Data Mart

INTRODUCTION

A Personal Data Mart (PDM) is intended for the user who wants to create a subset of data on his/her 
own machine and run queries against it.  While a user needs to define only one document in creating 
a PDM, that PDM may serve as a data source for multiple users with many documents.

The user will create a document that uses all of the rows and columns that he/she generally queries.  
It is important to remember that the PDM contains data for a particular query.  The data is local (on 
your PC or Local Area Network (LAN)) and it is permanent, i.e., it is NOT dynamic like the other .ipr 
documents we have created.  Once the PDM has been established, other design documents can use it 
as their data source.   Personal Data Marts are generally used to create relatively large local data 
stores that are refreshed on a set schedule.

OBJECTIVES

You will learn the fundamentals of creating your personal data set.  In this exercise, you will create a 
QuickQuery report with all of the data elements from the End Item Serial Business View, QuickStart! 
folder.  You will then export that report to your desktop as your Personal Data Mart. 

APPLICATION

The three main reasons that users develop Personal Data Marts are for speed in running reports 
against limited data; as an aid in development of reports; and to be able to work off-line with their 
specific set of data.  Creating a PDM is the first step in the process. 

PREREQUISITES

A familiarity with Eureka; all previous prerequisites.

ACTIVITY

Student Hands-On with Instructor direction
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STEPS TO PERFORM ACTION

1. Open a QuickQuery without the Wizard.
2. Select the fields from the table below:

3. Move the selected fields to the workspace.

4. Save the query as YOURNAME-PDM (for example, JOHN-PDM).

BUSINESS VIEW:  CATALOG

FOLDER(S) DATA ELEMENT(S)

Catalog ADP Cmpn Cd Stock Nbr
LIN Yr Svc Life
Nomen

Mfr._Model/Part_Nbr Mfr Name
Mfr Part Nbr

NOTE:
The reason that we are saving the PDM as a query/report is so that, if we choose, we can 
“refresh” the data for the elements we have selected.  There are two alternatives for updating 
your PDM from the larger database from which it was created.  One is to again run the report 
from which the data was created, and export it again as an *.iqd to the SAME NAME.  The 
second method would be to delete from your desktop, or the place where the PDM is stored, 
the *.iqd, rerun the query as above, and save the PDM again, either with the same name or a 
different name.  This prevents any possible confusion on which is the correct version of the 
PDM to use.
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5. Select File from the menu bar.
6. Select Export from the program group.

7. In Save in, change to Desktop.
8. Change Save as type to Personal Data Mart (*.iqd).

9. Click Export.
10. Close your report without saving.
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Using A Personal Data Mart

INTRODUCTION

This process will show you how to use your Personal Data Mart as your source of data for a report.

OBJECTIVES

You will learn the fundamentals of using your Personal Data Mart.  In this example, you will create a 
QuickQuery without the wizard, with six data elements drawn from those used in the PDM.

APPLICATION

The user has developed a report that has only those fields required to draw specific data wanted and 
designated the PDM.  As an example, a user can export the PDM to a notebook computer’s hard 
drive.  From there, the user can develop his/her report and run it against their PDM as the Knowledge 
Base rather than the dpas.iqk which is standard.  The resulting reports can be run against any Knowl-
edge Base, and the PDM can also be refreshed.

PREREQUISITES

The prerequisites found in Creating a PDM; a PDM has been created and named.

STEPS TO PERFORM ACTION

1. Open a new QuickQuery report without the wizard.
2. Select Tools from the menu bar.

3. Select Database Connection Defaults… from 
the program group.

4. Select (Personal Data Mart) from the Data 
Source list box.

5. Click the browse button for the Personal Data 
Mart.

6. Look in:  Select Desktop.
7. Click YOURNAME-PDM.iqd.
8. Click Open.
9. Click OK.
10. If your Object Directory is not displayed, depress 

the F2 Function Key.
11. Double-click on the YOURNAME-PDM.

CAUTION!!
Your PDM is only as good as the last database update!  Since your PDM is running from your 
hard drive, the data cannot be refreshed unless you export new data.
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12. You can now select the fields you want to use in your query.

13. Select from any or all of the fields from the PDM for your report.  NOTICE how quickly the data is 
added, since it is coming from your hard drive, and does not have to negotiate the Internet or your 
Local Area Network (LAN).

From this point, you can treat this report as you would any other report.  The only difference is the data 
source is your PDM rather than your activities’ database in Dayton, OH.

NOTE:
When you use a Personal Data Mart as the source for your data, the Object Directory lists 
columns from your PDM.  They are all grouped into a single folder that has the name of your 
data mart.
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Toolbars, Status Bars And Operators

QuickQuery Objects Toolbar

The QuickQuery Objects Toolbar provides shortcuts for adding objects to a report.

Column Object.  Inserts a database column object.

Custom Object.  This is used in order to create data fields that are needed but not in the 
database.  Examples would be calculations, substrings, or concatenations.

QuickQuery Queries Toolbar

The QuickQuery Queries Toolbar allows you to add attributes to your report.

Query Wizard Icon.  Creates or modifies a query using the wizard.

Requery Icon.  Allows you to run the query again.

Group By Icon.  Groups rows by the selected column(s).

Remove Groups Icon.  Removes all row groupings.

Sort Ascending Icon.  Sorts the rows by selected column(s) in ascending order.

Sort Descending Icon.  Sorts the rows by selected column(s) in descending order.

Apply Filter Icon.  Applies filter to the current section.

Clear Filter Icon.  Clears the current filter.

Quick Filter Icon.  Allows you to select a quick filter.
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Filter Icon. This is used to apply search criteria to your report.

Style Profiles Icon.  Add or modify QuickQuery styles.

Clear Object Style Icon.  Clears the formatting of the selected column(s).

Update/New FreeForm.  Update/new FreeForm with QuickQuery layout changes.

FreeForm Objects Toolbar

Select Object.  This is helpful when you want to terminate object placement.  You can also hit 
the <ESC> key to de-select or terminate an object placement.

Column Object.  This is the same as selecting it from the Objects Directory.

Text Object.  This is used to add text to your report, as well as modify Column headings or add a 
Report title.

Custom Object.  This is used in order to create data fields that are needed but not in the 
database.  Examples would be calculations, substrings, or concatenations.

Prompt Object.  This is used to prompt the report user for information such as UIC, Hand 
Receipt Number, etc.

Child Data Object.  This is used to return a specific piece of information from one document (the 
Child) and use it in another (the Parent or another child).

Date Object.  This is used to place the system date on the report.

Time Object.  This is used to place the system time to the report.

Page Number Object.  This is used to place page number(s) on your report.

Counter Object.  This is used to display the count of detail records or database rows output on 
your report.

Report Name Object.  This is used to place the name of the report file on your report.  This is 
not the title of the report.
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Graphic Object.  This is used to place a bitmap image on your report.

Chart Object.  This is used to place a chart on your report.  This includes Bar, Pie, and Scatter 
charts.

Crosstab Object.  This is used to provide an entire crosstab document in/on your report.

Object Linking and Embedding (OLE) Object.  This is used to embed objects that are created 
by another application to your report.

Child Document Object.  This is used to connect a Eureka document (child) that you include as 
part of another Eureka document (parent or another child).

FreeForm Queries Toolbar

Wizard Icon.  This is used to invoke the Wizard in FreeForm.

Sort Icon.  This is used to sort the report by whatever data field is chosen by the user.

Filter Icon.  This is used to apply search criteria to your report.

Group Header Icon.  This is used to add a data Group Header Area at the beginning of your 
report.  This is not accessible until you select a column or custom object.

Group Footer Icon.  This is used to add a data Group Footer Area at the end of your report.  
This is not accessible until you select a column or custom object.

Page Header/Footer Icon.  This is used to place data or text that will appear at the top or 
bottom of each page of your report.

Document Header/Footer Icon.  This is used to place data or text that will appear on the first 
or last page of your report.

Update FreeForm Layout Icon.  This rearranges all of your objects to form a neat, logical 
design after you have added columns to a FreeForm document by using a QuickQuery window.
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Menu Items

Menu items are grouped by functions; the File menu is for tasks such as opening and closing files, savings 
files and printing files.

File Menu

New – Opens a new report
Open – Opens an existing report
Close – Closes the active report
New From Template – Opens a template as model for new document
Save – Saves the active report
Save As – Saves the active report to a new name
Page Setup – Sets up the layout, margins, and point defaults
Page Border – Sets up the border parameters
Print – Prints using your Windows default dialog box
Print Setup – Sets up the print specification using the Windows dialog box
Print Preview – Generates all pages for the formatted report and gives the 
ability to view the document before it is printed
Export – Sends the report to a common separate file such as text, Excel, HTML
Report Server – Executes queries on a database server
Send Mail – emails the report to other users on the same mail server

Edit Menu

Undo – Reverses the last action
Redo – Reverses an undo
Cut – Removes a selected object
Copy – Copies a selected object to the clipboard
Paste – Places copied objects to the desired area
Paste Link – Places a linked OLE object by pasting a non-Eureka Reporter 
Designer object from the Clipboard
Delete – Removes the selected object
Select All Toggle - Selects all the objects for editing, or deselecting
Hide Toggle - Hides or reveals selected objects
Attributes – Selects the current objects format
Border – Displays border dialog box for the active window
Font – Displays the font dialog box for the selected object
Hot Object - Sets hot object attributes for selected objects
HTML - Sets HTML attributes for selected objects
Output When - Sets Output When attributes for selected objects
Translate Value – Invokes the translate value dialog for the active window
Prompt SQL – Edit the SQL query associated with a user prompt object
Prompt Connection - Changes the database connection for a selected 
user prompt object
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View Menu

Toolbars – Displays toolbar dialog box for selecting toolbar
Status Bar – Toggles on and off the display of the status toolbar
Object Directory – Toggles on and off the display of the object directory
Area Object List – Toggles on and off the display of the area object list
Freeze Columns – Keeps at least one column stationary at all times in order to 
help identify the content of the rows
Unfreeze Columns – Allows the frozen column to scroll
Margins - Controls the display of a document’s page margins.  Turning them off 
lets you see more of the document.  Margins are always shown in output 
windows.
Horizontal Ruler – Controls the display of a document’s horizontal ruler.
Vertical Ruler – Controls the display of a document’s vertical ruler.
Area Labels – Controls the display of a document’s area labels.
Grid – Controls the display of the document’s grid lines.
Show Object Format – Controls whether each object’s output format is shown
Show Object Colors – Controls whether each object’s name or format is shown:
In a “container” with the background differently colored for each type of object, 
or As black text with no background
Zoom In – Increases the magnification of QuickQuery
Zoom Out - Displays more of your QuickQuery screen at one time

100% - Displays the QuickQuery in normal view size

Insert Menu

Column – Inserts column objects that references an object defined in the knowledge 
base
Text – This is used to add text to your report, as well as modify Column headings or add 
a Report title
Custom – This is used in order to create data fields that are needed but not in 
the database.  Examples would be calculations, substrings, or concatenations
Prompt – This is used to prompt the report user for information such as UIC, Hand 
Receipt Number, etc
System – Inserts objects such as current date, time, page number, count, and report 
name
Graphic – This is used to place a bitmap image on your report
Chart – This is used to place a chart on your report.  This includes Bar, Pie, and Scatter 
charts
Crosstab – This is used to provide an entire crosstab document in/on your report
Child Document – This is used to connect a Eureka document (child) that you include as part of another Eureka 
document (parent or another child)
Child Data – This is used to return a specific piece of information from one document (the Child) and use it in 
another (the Parent or another child)
Area – Inserts area objects such as document header and footer, detail area, and page header and footer to the 
design window
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Query Menu

Wizard – Enables the query wizard
TM1 Cube Wizard – Creates TM1 Cubes
Sort Order – Displays the sort order/filter dialog box to set the sort order for the 
columns used in the query
Filter – Displays the sort order/filter dialog box for  setting the column filters 
used in the query
Quick Filters – Displays a pick list of saved filters
Setup – Displays a dialog box for setting the grid size, the password, units of 
measure, and row and time limits for the query
Default Font – Displays the dialog box for setting font attributes and alignment 
for new objects
Database Connection Override – Displays the dialog box that allows you to 
override the default options for connecting to the database
SQL Override – Displays the dialog box for creating a query from scratch or 
editing the queries that the user generates
Cache Override – Displays the dialog box for setting cache properties that are 
specific to your current document
QuickQuery Properties – Displays the dialog box for controlling the on-screen 
appearance or the row and column titles

View – Uses notepad to display the SQL syntax for the query
Refresh Cache - Empties the data cache and refills it from your database

Tools Menu

Preferences – Displays the preferences dialog box for setting the master data 
source
Database Connection Defaults – Displays default database connection options, 
login ID, password, and default metadata file and knowledge base
HTML Defaults – Controls default settings for creating HTML files
Cache Defaults – Enables cache and sets cache preferences to specify cache 
duration
Disconnect – Discontinues the current database connection
QuickQuery Styles Editor – Displays dialog box to define rules which control 
the font, color, borders, and text alignment of a specified document
Auto Shortcut Builder – Displays a dialog box to create an icon or program item 
to process your active design document
ODBC Data Source Administrator - Displays a dialog box used to add and 
modify the ODBC driver
Metadata Manager - You can have the Eureka Metadata Manager substitute pre-defined user-friendly column 
names for the actual column names used in your database.  This is only available to the database administrator
Cube Viewer – This option is disabled with the DPAS application
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Window Menu

Free Form – Shows a current QuickQuery document in a FreeForm window
QuickQuery – Shows a current FreeForm document in a QuickQuery window
Cascade – Rearranges and sizes all non-minimized windows so that they are next to each 
other
Tile – Rearranges and resizes all non-minimized windows so that they are next to each 
other within an objects window
Arrange Icons – Neatly arranges the icons for all minimized windows

Help Menu

Contents – Displays a list of topics in the help system
Search for Help On – Displays a search dialog box for key words
How to Use Help – Displays a dialog box to let you type the word you want to find
Obtaining Technical Support – States useful information for obtaining product 
technical support
About Eureka Reporter Designerer – Displays product information such as 
name, version, copyright information, and current system resources
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Changing Your Eureka Password

INTRODUCTION

This process will show you the procedures used to change your password in Eureka  Anytime you 
change your login or password for DPAS, you must also change them to the same for Eureka.  When 
you change your password in DPAS, you will get a pop-up message to change your password in 
Eureka.

OBJECTIVES

To allow the user to understand when and how to change the Eureka password.

APPLICATION

You have just changed your DPAS password and now you need to change it in Eureka

PREREQUISITES

Eureka Reporter Designer is correctly loaded and configured.

ACTIVITY

Instructor-led demonstration

STEPS TO PERFORM ACTION

1. Select Ad Hoc Reports icon or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

STEP 1:

• If you get the wizard, click Finish; other-
wise, go to the next step.
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STEP 2:

a. From the menu bar, select Tools.
b. Select Database Connection Defaults...

STEP 3:

a. Data Source:  Make sure that your DPAS Site 
ID is displayed.

b. Login ID:  Make sure that your DPAS User ID 
is displayed.

c. Password:  Enter your NEW DPAS password.
d. Server Name:  Leave this field blank.
e. Database Name:  Leave this field blank.
f. Prompt For Data Source at Runtime:  Do 

not check this box.  If checked, you will be 
prompted to enter your DPAS Site ID each time 
you run a report.

g. Default Metadata File:  Browse for where 
the DPAS programs reside on you workstation.  
If all the defaults were taken during installa-
tion, then the path is normally:  C:\Program 
Files\DOD\DPAS\DPAS.iqk.

If you are unable to locate the DPAS.iqk file, click on the START button, select Find (or Search if using 
Windows ME or 2000), Files or Folders..., enter dpas.iqk look in the Local Hard Drives.

h. Server Name:  Leave this field blank.
i. Host Name:  Leave this field blank.
j. Click OK.
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Installation Of The Eureka Reporter Viewer

INTRODUCTION

There are occasions when you may want to provide a report electronically to a person who does not 
have DPAS or Eureka installed on their own PCs.  In those cases, you have the choice of “exporting” 
your Eureka file in another format, such as Microsoft Excel (.xls), or text (.txt).  Another alternative 
available is for the people to whom you regularly submit reports to have the Eureka Reporter Viewer 
installed, instead of the full Eureka Reporter Designer.  (Note:  Eureka Reporter Viewer provides the 
QuickQuery tool set only.)  (dpaspr.exe, 9,448,006 bytes)

OBJECTIVES

The instructions below are general and provide the guidelines of how to install only the Eureka 
Reporter Viewer.  Whoever is responsible for installing DPAS and Eureka in your organization should 
still have the responsibility to install the Reporter Viewer.

APPLICATION

As described in the introduction section above, the Reporter Viewer is intended for those who do not 
want or need the full DPAS and Eureka Reporter Designer installation.

PREREQUISITES

A login and password for software downloads from the DPAS Homepage, similar to any other DPAS 
download.

ACTIVITY

None

STEPS TO PERFORM ACTION

As with SUPRA NT, the installation of Eureka Reporter Viewer is simply a matter of reading the screen 
prompts throughout the installation process and following the directions provided.

1. If installed, remove the existing version of Eureka Reporter Designer via the Control Panel “Add/
Remove Programs” applet prior to installing the Eureka Reporter Viewer program.

2. To install Eureka Reporter Viewer, click on the Start button.
3. Select Run from the program group.
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STEP 1:

a. Open:  Enter the full path of where you downloaded the 
“dpaspr.exe” file.

b. Click OK.

STEP 2:

• Click Yes.

STEP 3:

a. Installation Folder:  Accept the default of 
“c:\dpasinst”.

b.  Click Finish.

NOTE:
This window will prompt you to choose a directory in which to unpack the files that will be used 
to install Eureka.  The default unpacking directory is "c:\dpasinst", the same directory in which 
the DPAS GUI and Supra NT programs are normally unpacked).  The files begin unpacking in 

the directory specified.

If there had been DPAS GUI or Supra NT installations prior to running this installation, AND 
if the unpacking directory was not deleted, an "Overwrite Protection" window will appear at 
this time.  If this window appears, click on the "Yes to All" button to overwrite all temporary 
files left over from the DPAS GUI and/or Supra NT installations.
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Installation Of The Eureka Reporter Viewer
STEP 4:

• Click Next>.

STEP 5:

a. Enter the key that was given to you in the Installation 
Instructions.

b. Click OK.

STEP 6:

• Click Next>.

NOTE:
The Eureka key code IS case sensitive.

NOTE:
The default directory is 
C:\Eureka\Reporter\Viewer.  If 
you wish to install this program in 
the default directory, then click 
Next>.

If you want to specify a desired pro-
gram directory location, click on the 
Browse button and select the 
desired directory.
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Installation Of The Eureka Reporter Viewer
STEP 7:

• Click Next>.

STEP 8:

• Click Next>.

STEP 9:

• Click Install>.

The program files are now installed on the 
computer with a status bar to indicate setup 
progression.

NOTE:
Do not select any ODBC drivers.  
Leave the checkmark next the dBASE 
(it cannot be cleared and gets 
installed by default).

NOTE:
The default folder is Eureka! 
Reporter Viewer.  You may specify a 
different folder, if desired.
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STEP 10:

a. Uncheck the “Display the Release Notes” 
and “Launch EUREKA Reporter Viewer now” 
check boxes.

b. Click Finish.

This completes the installation of Eureka Reporter Viewer.

Notice for Windows NT users:

The administrator for the Windows NT client may, depending upon the permission settings, have to grant 
the user access to the executables that were installed with this process.  They are:

Eureka Reporter Viewer:  iqpersnl.exe

File Clean-up:

You have completed the installation and have determined that you no longer have a need for the software 
package(s).  You can delete the files that were downloaded from the Web site and the files that were 
unpacked during the installation process (all files located in the unpacked directory "c:\dpasinst").

NOTE:
Release notes are not available with 
this version.  Also, the Adobe Acrobat 
Reader was removed from this 
software bundle to reduce the size of 
the self-extracting executable for 
quicker downloads.  Therefore, 
leaving either of these boxes checked 
will result in an error message at the 
completion of the installation.
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Chart Types

Bar Chart

Bar Data - Place the object for which you want 
to summarize values in the Bar Data control.  
This object determines the height of the bars.
Bar Labels - Place the object for which you wish 
to see bars in the Bar Labels control.  A different 
bar will be calculated for each value in this 
object.
Group By - In the Group By control, place the 
object you wish to group by, if any.  Eureka 
creates a different group of bars for each value 
in this object.  Each group includes one bar for 
each value in the Bar Label object.  Each bar 
represents the calculated value for the Bar Data 
object for a single particular combination of Bar 
Label object value and Group By object value.

For instance, if the Bar Labels object is Class and the Group By object is Sport, there will be one group of 
bars for each sport.  Each of the groups will have one bar for each different Class value.  For two-
dimensional charts, the groups are placed next to each other.  For three-dimensional charts, the Group By 
object is used as the X-axis and the Bar Label object is used as the Z-axis.  If there were no Group By 
object, there would be a single group of bars.

Horiz Axis Title - Enter a label to describe the Bar Labels object or the Bar Labels and Group By 
objects.
Vert Axis Title - Enter a label to describe the Bar Data object.

Pie Chart

Pie Slice Values - This is the object that controls the 
size of the pie slices.
Pie Slice Labels - There will be a slice calculated for 
each value in this object.
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Scatter Chart

Line Data - Place the object for which you want 
to summarize values in the Line Data control.  
This object controls the point heights – it is the 
Y-axis object.
Line Labels - In the Line Labels control, place 
the object for which you wish to calculate points.  
The object is the X-axis object unless you use a 
Group By object, in which case it becomes the Z-
axis object.  (Since scatter charts are two-
dimensional, the Z-axis points are differentiated 
from each other by color.)

Group By - Add a Group By object if you want to chart three separate objects.  Eureka creates a 
different set of points on the chart for each value in this object.  This object is used as the X-axis object.
Horiz Axis Title - Enter a label to describe the Line Labels object or Line Labels and Group By objects.
Vert Axis Title - Enter a label to describe the Line Data object.

Area Chart

Area Data - Place the Y-axis object in the Area Data.  
This is the object for which areas are plotted (i.e., it is the 
object which you want to summarize).
Area Labels - Place the X-axis object in the Area Labels 
control.  If you are using a Group By object, place the Z-
axis object here.  There will be an area calculated for 
each value in this object.
Group By - In the Group By control, place the object you 
wish to group by, if any.  The Group By object is used as the X-axis object and the Area Labels object is 
used as the Z-axis object.
Horiz Axis Title - Enter a label to describe the Area Labels object or the Area Labels and Group By 
objects.
Vert Axis Title - Enter a label to describe the Area Data object.

Line Chart

Line Data - Place the object for which you want 
to summarize values in the Line Data control.  
This object controls the line height – it is the Y-
axis object.
Line Labels - In the Line Labels control, place 
the object for which you wish to calculate points 
along on the line(s).  There will be a separate 
point plotted for each value in this object.  This 
is the X-axis object unless you use a Group By 
object, in which case it becomes the Z-axis 
object.

Group By - When you place an object here, Eureka uses it as the X-axis object.  (A separate line is 
drawn for each value in the Line Labels Object; it becomes the Z-axis object.)  Each line has points 
plotted for each separate value in the Group By object.
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For instance, if the Line Labels object is Class and the Group By object is Sport, there will be one line 
for each Class value.  Each line will have points plotted bar for each Sport.  If there was no Group By 
object, there would be a single line that would have a separate point plotted for each Class value.

Horiz Axis Title - Enter a label to describe the Line Labels object or the Line Labels and Group By 
objects.
Vert Axis Title - Enter a label to describe the Line Data object.
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Style Profiles

INTRODUCTION

Style profiles allow you to control the appearance of your QuickQuery by defining rules that apply 
style attributes.

OBJECTIVES

You will demonstrate an ability to establish style profiles for your own QuickQuery Reports.

APPLICATION

Style Profiles is another tool to determine how your data will be represented on-screen or in print. 

PREREQUISITES

Complete Chapters 1 and 2 of this manual.

ACTIVITY

The Style Profiles Dialog Box - Using Style Profiles to Control the Appearance of a QuickQuery.  

STEP 1:

• Select the Style Profiles icon OR select Tools and 
then QuickQuery Styles Editor

This dialog box lets you define rules which control the font, color, borders, and text alignment of your 
document.  Each rule applies to those parts of your document which meet the condition (e.g., Even Rows, 
Odd Rows, Group Data, etc.) that you select for the rule.  One or more rules can be saved as a Style 
Profile, which can be applied to other documents.

When you first open this dialog box, the Rules section lists the rules which control text meeting these 
conditions: Even Rows, Odd Rows, and Detail Data.  (These conditions are always fulfilled in a QuickQuery 
document that has more than one detail row.)  If you open the Editor and select an existing Style Profile 
from the drop-down list at left, the Rules section displays a list of the rules that have been defined in the 
selected Style Profile.  Each rule is accompanied by a checkbox, which can be used to turn the application 
of the rule off or on.
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STEP 2:

a. Double-click on the rule that you 
want to set your attributes to.

b. Click Apply to assign your style.  
This only assigns the rule to the cur-
rent query.

c. Click Save As... to save this style to 
use in other queries.

STEP 3:

a. Define rules for Odd Rows, Even Rows, or Detail Data by 
double-clicking the rule name, or rule the condition and 
clicking the Edit button (located directly above the Rules 
list). This opens the Rule dialog box for the selected condi-
tion.  Add new rules by clicking the Add Rule button. This 
inserts an untitled entry in the rules list and opens the Rule 
dialog box, where you can select a condition and define the 
rules to apply to it.

b. Click the Font tab and change the attributes for your 
styles, such as font types, size, and effects.

c. Click on the other tabs to add borders, colors, etc.
d. Click OK.

As you define rules, the example QuickQuery in the Editor displays the cumulative effect of the defined 
and selected rules on the appearance of your document. 

You can apply the rules you have defined to your document at any time by selecting the Apply button.

STEP 4:

• Once you have completed your profile, click 
Save As...

Notice that this screen will show an example of 
your profile.
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STEP 5:

a. Save this profile as:  Give your profile a name.
b. Click OK.

Applying A New Style

When you create a new QuickQuery report, you can apply your new style for that report.

1. Click on Tools>QuickQuery Styles Editor from the menu bar.
2. Change the Profile to the style you want to use.
3. Click OK.
4. Create and process your report.

5. Save your report.
6. Close your report.
218



What If Statements
What If Statements

This report writer uses the document, filter to solve WHAT IF statements.  As long as the conditions in the 
IF statement or statements do not contradict one another one report may be used.  Otherwise, filters in 
child reports must be used, and their outputs may be placed on multiple detail lines.  (You can have more 
than one detail line.)

You need to consider how to solve the following WHAT IF statements:

If Acquisition Cost is greater than or equal to $10,000 and Effective Date is greater than or equal to 
19960101, and UIC starts with A (Army), then process the information.

A second statement: 

If Acquisition Cost is greater than or equal to $10,000 and the Effective Date is greater than or equal to 
19960101 and UIC starts with N (for Navy), than process information.

In addition, we want the Army information, and the Navy information to print out in separate groups.  We 
will use multiple filters to satisfy the WHAT IF statements. 

Creating What If Statements:

1. Create a new FreeForm report.
2. Add a Document Header area.
3. Add a report title to the Document Header 

area.
4. Add a Document Footer area.
5. Using the text object, add End of report 

to the Document Footer area.
6. Add the date and name of file to the Page 

Header area.
7. Add the page number to the Page Footer 

area.
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Adding from the Object Directory:

1. Select the following fields for your report and add to the Detail area of your report:

2. Right-click on the UIC data object (blue object) and select Hide Toggle.
3. Delete the UIC column heading (gray object) from the Page Header area.

Applying Multiple Filters:

1. Click on the Filter icon.
2. From the Objects tab, double-click on the Detail folder.
3. Double-click on AcqCost to move into the Object.
4. Set the Operator to >= (greater than or equal to).
5. Set Value1 to 10000.
6. Click Add.
7. Double-click on EffDate to move into the Object.
8. Set the Operator to >= (greater than or equal to).
9. Set Value1 to 19960101.

10. Click Add.
11. Double-click on the Hidden Detail Objects folder.
12. Double-click on UIC to move into the Object.
13. Set the Operator to Like.
14. Set Value1 to W*.
15. Click Add.
16. Double-click on UIC to move into the Object.
17. Set the Operator to Like.
18. Set Value1 to N*.
19. Change the OR’d Group to 1.
20. Click Add.
21. Click OK.
22. Save the report as What If.

BUSINESS VIEW:  END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Catalog Nomen

Serial Hand_Receipt Serial Nbr
Eff Dt
Acq Cost

Unit UIC
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Grouping Information by Creating a Custom Column:

1. Click on the Custom icon.

2. Type in Group for the Object Label.
3. Click on the Function button and scroll to 

SUBSTR.
4. Double-click on SUBSTR, to move into the 

Value area.
5. Remove everything except the left parenthe-

sis.
6. Click on the Objects tab.
7. Double-click on UIC, to place it next to the left 

parenthesis (no space).
8. After the UIC, type in “,1,1)” (without the 

quotes).  It should read SUBSTR (UIC,1,1).
9. Click OK.

10. Place the object in the Page Footer area.
11. Click once on the Custom field “Group” 

that we just created.
12. Click the Group Header icon.
13. Move the Custom Field “Group” into the 

Group Header area of the report.
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Structured Query Language (SQL)

SQL is the language the report writer uses to talk to the computer, to tell it to bring up the data that has 
been asked for in the report.  In older report writers the person writing the report had to write out the 
SQL.  In today’s report writers, the report writer constructs SQL.  Each time a block of data is added to the 
report, the report writer writes additional SQL.  When you tell the report how to sort, and what to filter on, 
it will add more SQL.

There are occasions with Eureka, that makes it necessary to actually go into the SQL language, which is 
called syntax, and change it.  There are two primary situations when the SQL will need to be edited.  One 
is when you wish to sort on a custom data field.  The second is if a compound statement is entered into 
the filter that includes AND, and OR.

Before examples are provided on how to modify the SQL for the two reasons mentioned above, it is 
necessary to have some understanding of how to read the SQL.

There are command words in the SQL.  The most often used commands are:

SELECT
FROM
WHERE

These must exist in every report.  The most common optional commands are:

ORDER BY
GROUP BY

SELECT Command

The SELECT command is constructed as you add data blocks to your report.  If it is desired to construct a 
report from the History file that will provide a list of all ADP equipment turned in for a specific time, such 
as a year, and be broken down into months.  First it would be necessary to select a data field that would 
indicate that an item is ADP, this data field would be the ADP RPTB CD.  Also, it would be necessary to pull 
the transaction date of the action, this data field is called LHAZ DT.

When these two data fields are added to the report, the report writer would construct the following:

SELECT
TO.”CTLG_ADP_RPTB_CD”,
T0.”LHAZ_DT”

To explain, it must be understood that DPAS system is a collection of files or tables.  They will be called 
files for this discussion.  Each file has a purpose:  there is the catalog file which houses basic catalog 
information, the end item serial file which houses the bulk of the equipment on your property book, the 
serial asset.  There is a component file, a hand receipt holder file, and a file for each specific job in the 
system.  In report writing, these files may or may not be joined together, or as it is called “linked” together.

Therefore in the SELECT statement the report writer indicates which file the data field is from.  Each of the 
files, such as end item serial, have a program name, it is like a short name for the file, for instance, the 
catalog file program name is LHAA.  The end item serial file is named LHAF.  The SQL uses these short 
names.  It is not necessary to memorize these short names, but it will be helpful if you construct very 
many reports.  The SELECT statement also further abbreviates the program name of files by assigning it a  
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“T” number.  If a report selects from two or three files, the first file you select a data field from will be “T0”, 
the second file you selected from, “T1”, and so on.  The data field itself has a naming convention that 
indicates the home file for the data field.  For instance, STK NBR, its home file is the catalog, it may also 
appear in the serial asset file, but the first part of its data field name will always start with CTLG, which 
indicates its home file is the catalog file.

So in the SELECT statement above, the first data field selected is home to the catalog file, the second from 
the history file, however, both are being selected from the History business view and pulled from the 
history file which is called LHAZ.  Therefore both have T0 assigned to them.  But notice the ADP RPTB CD 
has CTLG at the first of it indicating its home file is the CTLG file, LHAA.  Note there will be a comma after 
each data field selected, except the last one.

So the SELECT statement is saying:

“Computer” go pull the ADP RPTB CD and the LHAZ DT.  Go back and re-read the select 
statement.

FROM Command

This command word tells the computer from which file in the DPAS system it will find the data field 
desired.

From
“LHAZ” T0

The FROM statement indicates the data is to be pulled from the file LHAZ.  Note the LHAZ is in “ “, then T0 
follows outside of the quotes.  This is a statement that T0 is an abbreviation for LHAZ.  It should be noted 
that when reading and editing SQL, each comma, each period, each quote is critical, and must be in the 
correct place.  So now the report writer can tell the computer I want certain data fields, and where it gets 
those data fields from.

WHERE Command

The WHERE clause or statement has a two fold purpose.  In the business views of DPAS, there is a primary 
file, such as End Item Serial.  The primary file is the end item serial file, called LHAF.  But in the End Item 
Serial business view, there are “links” to other files.  To link files together, which makes the computer look 
at them like one large file, there is a linking statement in the WHERE clause.  The linking statement is the 
first of the two part WHERE clause.  To link files together, there is a requirement - there must be at least 
one data field that is common to both files.  Such as STK NBR is found both in the Catalog file and the End 
Item Serial file, so these two files could be linked together with the following linking statement in the 
WHERE clause:

Where
T0.”CTLG_STK_NBR” = T1.”CTLG_STK_NBR”

Do not forget the T0 and the T1 are short names for the file names.

The second part of the WHERE clause is what has been placed in the filter, and will usually be enclosed in 
parenthesis ( ).  These must be upper case 9 and uppercase 0, not brackets.  If it is just one simple 
statement in the filter, it may not be in parenthesis.
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In the report being constructed, if it was desired to prompt for a beginning date (BEGDT) and an ending 
date (ENDDT), the WHERE clause statement for the filter would look like this:

(T0.”LHAZ_DT between ‘BEGDT’and ‘ENDDT’)

The entire WHERE clause would look like this:

Where T0.”CTLG_STK_NBR” = T1.”CTLG_STK_NBR” ((the linking part of the statement))
And (T0.”LHAZ_DT between ‘BEGDT’ and ‘ENDDT’) ((the filter part of the statement))

ORDER BY Command

This is the command used when a sort is desired.  It is the last statement in the SQL.  It would look like 
this if it were to be sorted by date:

Order by
T0.’LHAZ_DT”

The entire SQL for the report would be:

Select
TO.”CTLG_ADP_RPTB_CD”,
T0.”LHAZ_DT”

From
“LHAZ” T0

Where
T0.”CTLG_STK_NBR” = T1.”CTLG_STK_NBR” 

And (T0.”LHAZ_DT between ‘BEGDT’ and ‘ENDDT’)

Order by
T0.’LHAZ_DT”

All of this is compressed more in the actual syntax.

To elaborate on one of the two occasions when it may be necessary to edit the SQL, sorting with a custom 
data field.  Suppose a report is desired from the History business view that list ADP equipment that has 
been turned in for the past year, but broken down into months.  All that is desired is a count of those items 
for each month, then a total at the end of the report.

First, the ADP RPTB CD will be used to indicate which items are ADP, secondly the LHAZ DT will be used to 
determine the date of the transaction, and last a data field called PGM DESC will be used to indicate the 
action was a turn in.  From experience it will be learned a turn in action will be a PGM DESC of EI DEC TI.  
This means End Item Decrease Turn In.
224



Structured Query Language (SQL)
The problem is to sort, or group by month.  It will be necessary to create a Group Header for Month.  
DPAS does not have a data field of MONTH.  It will be necessary to construct a Custom data field using the 
Substring method learned earlier in the course (refer to page XX).  The substring will use the LHAZ DT 
data field, and start at position 5 of the data field for a total of 2 spaces.  This custom data field will be 
called MONTH.  To create a MONTH group header, click on the data field, and click the group header icon.  
This causes an automatic sort by MONTH in the Order by clause.  The problem is this:  the Order By 
statement the SQL constructs will look like this:

Order by
SUBSTR (T0.”LHAZ_DT”,5,2)

When the report is started, the above statement will generate an error message of “Invalid Command 
End”.  To correct this problem, you must edit the SQL.  To do this, on the top of the screen, click QUERY, 
then click SQL OVERRIDE, click the button labeled GENERATE SQL, go to the bottom of the SQL and place 
the cursor to the right of the “y”, of Order by, delete out all of SUBSTR (LHAZ_DT,5,2), and replace it with 
the number 1.  The reason for this is the substring custom data field is the first item in the select list under 
the SELECT command.  If it had been the third item on the select list, a number 3 would have been 
inserted.  Now the report will run.  Now it is important to remember to go to the top of the box and put a 
check mark into the box labeled “Use SQL Override”, if you do not do this the change you made will not 
work.  Also, if the Generate SQL button is accidentally pressed after the changes to the SQL have been 
made, it will re-write the SQL back to what it was before the modification.  Incidentally, the SQL syntax is 
not space sensitive, nor is it important that a statement be on the same line or below the command words.

The second of the two reason why it may be necessary to edit the SQL is compound AND, OR Statement in 
the filter.  This report writer has a flaw of re-arranging filter statements.

Suppose a report was desired to list computers that cost $1000 or more for HR # 0101 or HR # 0102.

The following was entered into the filter, don’t forget the numbers on the left indicate whether an AND, or 
an OR is between two statements.

0  Acq_Cost Greater Than or Equal To 1000
0  Nomen is Like ‘*COMPUTER*’ (the single quotes will not be visible here)
0  HRHNbrMjr Equal To 0101
1  HRHNbrMjr Equal To 0102

This statement is saying all data must meet the criteria of costing $1000 or more, and having the word 
COMPUTER in its nomenclature, and be on the hand receipt of HR 0101 OR HR 0102.  It will look fine 
when you click OK.  Save the report, then go back and look at the filter, it will now look like this.

0  Acq_Cost Greater Than or Equal To 1000
0  HRHNbrMjr Equal To 0101
0  Nomen Is Like ‘*COMPUTER*’
1  HRHNbr Mjr Equal To 0102.

This rearranging of the filter desired has totally changed the results of the report.  The version that had 
been put into the filter would have pulled any data that had the word COMPUTER in its Nomen and cost 
$1000 or more, and from either HR 0101, or HR 0102.  Now the report will pull up data that is from HR 
0101 and cost $1000 or more and has the word COMPUTER in its Nomen, OR anything from HR 0102.

To correct this you must go into QUERY, SQL OVERRIDE, GENERATE SQL, then edit the SQL to look like 
what was placed into the filter, making sure to place in all commas, single or double quotes and periods.
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	c. Enter the condition that needs to be met under Value 1. If you are using the Between operator, then you will need to enter values in Value 1 and Value 2.
	d. Click Next>.
	a. From your list of selected fields, double-click on the data field(s) you want your query to be sorted by. To de-select a field, highlight the field you want to de-select and click on the arrow that points to the left.
	b. Click Next>.
	a. Click Entire Document. You will not be able to click any of the check boxes unless this step is performed.
	b. Check the field(s) you want to total.
	c. Click Next>.

	Saving Your Query
	1. Select File from the menu bar.
	2. Select or select Save… from the program group.

	Printing Your Query
	1. Open or create a QuickQuery.
	2. Select File from the menu bar.
	3. Select Print… from the program group.
	4. Select the print icon .

	Activity: QuickQuery With The Query Wizard
	Skill Builder: QuickQuery With The Query Wizard
	1. Name the type of queries you can select when building a QuickQuery with the Query Wizard?
	2. List the 6 steps of the Query Wizard (in order).
	3. The ____________ ___________ contains the business views, folders and data fields for building your report.
	4. All values entered in Eureka are case sensitive. (True or False)
	5. List five types of operators.
	6. What is a structured pathway for a new user to build a report?
	7. In Step 5 Select Columns to Aggregate name 3 aggregate functions you can perform.
	8. When working with QuickQuery, you can only work in one business view at one time? (True or False)

	Practical Exercise: QuickQuery With The Query Wizard
	1. Create a new report using the QuickQuery Wizard.
	2. Select the following fields for your QuickQuery Wizard report:
	3. Filter:
	4. Sort: Stock Nbr
	5. Click on Entire Document.
	6. Aggregate: Stock Nbr using Count

	Building A QuickQuery Without The Query Wizard
	1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group.
	3. If the Wizard is displayed, click Finish.
	4. Select New from the file menu.
	a. Uncheck the Use Wizard choice on the new document dialog box.
	b. Click OK.
	a. Depress the F2 Key on your keyboard to display your Object Directory (if it isn’t already displayed).
	b. Use the scroll bars to select the appropriate Business View from which you will select the columns you want displayed on your report.
	c. Select the following fields for your QuickQuery report:

	Changing The Name Of A Column Heading
	a. The current name of the column is displayed. Change the Object Label to Actual Cost.
	b. Folder: This displays the folder your data field was chosen from. This field cannot be changed.
	c. Business View: This displays the Business View your data field was chosen from. This field cannot be changed.
	d. Column: This displays the system column heading from the object directory. This field cannot be changed.
	e. Type: This field displays the characteristics of the data (string, numeric, or date).
	f. Format: If you selected to change a cost field, you can change the format of that field. Change the Format to Windows Currency.
	g. Charater Width: This field defaults to the actual field length, but can be changed. Keep in mind that if you make the length shorter that the actual field length, it will truncate the field.
	h. Aggregate Function: Select if you want to an average, count, maximum value, minimum value, or sum for your data field.

	Changing The Fonts
	a. Click on the column heading you wish to change. In this exercise, click on the Actual_Cost column heading.
	b. Using the Formatting toolbar, change the type of font you wish to use.
	c. You can also use the Formatting toolbar to change the size, alignment, style, and color of the font.
	1. Click on the Font tab to display the font attributes.
	2. Make any necessary changes. Notice that in the Sample box, a sampling will be displayed.
	3. Click OK.


	Moving Columns
	1. Highlight the UIC column by clicking in the UIC column heading. Your cursor will change to a black arrow when you place the cursor on the heading.
	2. Click and drag the column (while still holding the click) into the first position of your report. As you move across the screen, you will notice that there is a red line. Use this as a guide to where you want to position the column.
	3. Once you have positioned the red line to where you want the column to be located, release the click on the mouse.

	Deleting Columns
	1. Highlight the Bar Cd by clicking once in the heading area.
	2. Depress the Delete key on your keyboard.

	Freezing/Unfreezing Column Headings
	1. Using the table below, add the following fields:
	2. Highlight the HRH Nbr Mjr field by clicking once in the heading area.
	3. Right-mouse click to display the shortcut attributes menu.
	4. Select Freeze Column.
	5. Scroll to the right.

	Adding Custom Columns
	1. Select the custom column icon or select Insert from the menu bar, and then select Custom.
	2. Enter an Object Label of your choice.
	3. User Function: Check this box if you want to pull in calculations that are not defined by the database administrator.
	4. Double-click on the Detail folder.
	5. Double-click on the Actual Cost field. You can choose values for your custom column either by selecting the Columns tab (this is the Object Directory) or clicking on the Detail folder (these are the fields you selected for your report) or ...
	6. Click on the X (multiply) button.
	7. Enter .03 (this is just the inflation amount). If you want the total inflated cost, the formula must be Actual_Cost * 1.03.

	Applying Filters
	1. Click on the icon.
	2. Double-click on Actual_Cost.
	3. Set the Operator to <= (less than or equal to).
	4. Enter 5000 in Value1.
	5. Click Add to activate the filter. If you have an existing filter and you need to change it, highlight the condition, change the condition and then click Modify. If you have an existing filter that you no longer need, highlight the conditio...
	6. Distinct Values Only: Check this box when you want to eliminate any duplicate rows.
	7. Custom Override: This displays any overriden SQL statements.
	8. Click OK.

	Sorting Columns
	1. Highlight the Nomen field by clicking once in the heading area.
	2. Click on the (to sort in ascending order) or (to sort in descending order) from the toolbar.

	Grouping/Ungrouping Columns
	1. Highlight the HRH Nbr Mjr by clicking once in the heading area.
	2. Right-mouse click to display the shortcut attributes menu.
	3. Select Group.
	4. Click on the button from the toolbar. (If you want to ungroup, simply highlight the grouped column and click on the button.
	5. Save your report as QQGROUP.
	6. Close your report.
	Activity: QuickQuery Without The Query Wizard
	1. Open a new QuickQuery report without the Wizard.
	2. Select the following fields for your QuickQuery report:
	3. Change the name of Acq Cost to Actual Cost or a comparable term.
	4. Delete the ARC.
	5. Group on the Nomen.
	6. Count on the Nomen.
	7. Build a Custom Column labeled Over/Short.
	8. Subtract the Qty On Hand from Auth Qty, which will equal the Over/Short column.
	9. Filter for HRH Nbr Mjr Like W*.
	10. Sum on the Acq Cost.
	11. Save the report in the Eureka folder on your Desktop as QQACTY.
	12. Close the report.

	Skill Builder: QuickQuery Without The Query Wizard
	1. Outline the steps to perform when setting your preference for Manual Re-Query
	2. What action(s) take place when you depress the F2 key?
	3. You cannot change the name of a column heading. (True or False)
	4. To delete a column, you first ___________________ the column then depress the _______ key on your keyboard.
	5. When your query has too many columns, it may be impossible to view them all at one time. _______________________ a column helps you identify the content(s) of the row(s).
	6. ____________ _____________ are used when you want to apply values to a query that are not avail able in the database.
	7. You display the shortcut attributes menu by doing a ____________________ ______________________ with your ____________________.
	8. Where is the keypad located that enables you to create numerical calculations?

	Practical Exercise: QuickQuery Without The Query Wizard
	1. Open a new QuickQuery report without the Wizard.
	2. Select the following fields for your QuickQuery report:
	3. Change the name of the Acq Cost column.
	4. Delete the Local Use column.
	5. Group on Nomen.
	6. Build a Custom column labeled Total Cost.
	7. Multiply Qty On Hand by Acq Cost.
	8. Change the Format to Windows Numeric.
	9. Filter on HRH Nbr Mjr Like W*.
	10. Sum for on the Custom column.
	11. Save the report to the Eureka folder on your Desktop as QQPE.
	12. Close your report.

	Building A Summary QuickQuery
	1. Open a new QuickQuery report without the Wizard.
	2. Depress the F2 Function Key if your object directory is not open.
	3. Select the following fields for your QuickQuery report:
	4. Double-click on the Acq Cost column heading.
	5. Click on the drop down arrow for the Aggregate Function.
	6. Scroll and select Sum.
	7. Click OK.
	8. View report.
	9. Close the report.
	10. DO NOT save the report.

	Building A Quick Filter In QuickQuery
	1. Open a new QuickQuery report without the wizard.
	2. Depress the F2 Function Key if your object directory is not open.
	3. Select the following fields for your QuickQuery report:
	4. In the Fund Code Column, highlight one cell of Fund Code PA.
	5. Click on (Apply Filter Icon). This will apply a filter to the current section. This action will automatically filter your report to show only the assets with the fund code of PA.
	6. At the menu bar, select Query>Filter>Save As.
	7. The Filter Name Screen will come up. Enter Fund Code PA in the window.
	8. Click OK.
	9. Click on (Clear Filter Icon). This action will clear your document of the Quick Filter.
	10. At the menu bar select Query>Quick Filters…
	11. Highlight Fund Code 98.
	12. Click OK. Your document is now filtered again by the fund code of 98.
	13. Clear the filter by using the Clear Filter Icon.
	14. Repeat the process for Fund Code PA (start at Step 4 through Step 8).
	15. After filtering by PA, save your report as QQFILTER, we will be using it in the next exercise.

	Building Translate Values Using QuickQuery
	1. If closed, open QQFILTER report.
	2. Double-click on the Dollar Amt column heading.
	3. The Column Dollar Amt window will appear.
	4. Select the Translate tab.
	5. Double-click on the Detail folder in the Object Source.
	6. Double-click on Dollar Amt to move it to the Object field.
	7. Set the Operator to >= (greater than or equal to).
	8. Enter 100000 in Value1.
	9. Then Become: Enter “CAPITAL ASSET”.
	10. Click Add Case.
	11. Otherwise Become: Enter “NON-CAPITAL”.
	12. Click OK.
	13. Save your report.
	14. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Exporting Your Query
	1. If closed, open the report named QQFILTER.
	2. Select the Export icon .
	3. Select File from the menu bar.
	4. Select Export… from the program group.
	5. Change Save in to Desktop.
	6. Change Save as type to Excel File (*.xls).
	7. Click Export.
	8. Close your report.
	9. Double-click on QQFILTER.xls from your Desktop.

	Emailing Your Query
	1. Open the QQFILTER report.
	2. Select File from the menu bar.
	3. Select Send Mail… from the program group.

	Page Setup
	1. Select File from the menu bar.
	2. Select Page Setup… from the program group.
	a. Page Size: This option is not available in QuickQuery.
	b. Page Margins: Your page margins are defaulted to the current Windows settings, but you can change, if needed.
	c. Page Layout: Page layout controls how documents that are wider than your printer’s page size are printed (when they are not scaled to fit the page).
	d. Printing: This option is not available in QuickQuery.
	e. Center on Page: Select how you want your output displayed on you page.
	f. Orientation: This option is not available in QuickQuery.
	g. Grid: This option is not available in QuickQuery.
	h. Select the Header/Footer tab.
	a. Click the location where you want to insert the item (for example, if you want it centered on the first line of the header, select the header page and click in the first cell under Centered.
	b. Use the tools along the side of the screen to change the font, enter the application name, file name, add page numbers, and add the date to your report.
	c. Click the Footer tab.
	a. Delete the page number from Right Aligned.
	b. Click in the first cell of the Centered column.
	c. Enter Page and then add a space.
	d. Click on .
	e. Position your cursor after the $P.
	f. Enter Of and add a space.
	g. Click on . This will cause your page numbers to read: Page X of XX.
	h. Distance to Frame: To change the distance between the header or footer and the frame containing the QuickQuery, enter the distance you need in the Header and Footer boxes.
	i. Page Numbering: If you wish the page numbering to begin with a specific number other than 1, enter it in this box.
	j. Select the QuickQuery tab.
	a. Titles and Gridlines: Check or uncheck the desired title or gridline box to control the appearance of your query for printing.
	b. Save As Defaults: If you want to save your settings to use with future queries, click this button.
	c. Click OK.

	Introduction To FreeForm
	Getting Oriented With FreeForm
	a. Area Level: Change this when you use the same area multiple times. This will designate the process order. For example, you may have two detail areas.
	b. Area Description: This is the description of the area. This description does not print on the report.
	c. Print Options: This is used in conjunction with multiple area levels. This will tell when certain rows to print.
	d. Area Height: This sets the area height of your report.
	e. Reset Page Number to: This will reset the page number after each page break, area, or group. For example, if your report breaks for each Hand Receipt Holder Number, it would reset the page back to whatever page number you specify.
	f. Spacing: If you want to leave space before or after an area object, enter the amount of space you want.
	g. Page Skip: Use these controls to have Eureka skip to the top of the next page before or after this area is output. A value of 1 causes output to skip to the next page. A value of 2 causes a blank page to be output. A value of 3 causes 2 bl...
	h. Click OK.
	a. Select File from the menu bar.
	b. Select Page Setup from the program group.
	c. Page Size: Allows you to adjust the size of your page. Your page size is defaulted to the current Windows settings, but you can change if needed.
	d. Page Margins: Your page margins are defaulted to the current Windows settings, but you can change if needed.
	e. Page Layout: Allows you to use multiple columns.
	f. Center on Page: Select how you want your output displayed on your page.
	g. Orientation: This will allow you set how you want your page to print.
	h. Scale to Fit: Controls what happens when you print your document to paper with different dimensions than are specified for your document. When Scale to Fit is checked, Eureka scales the document to fit the page. It either enlarges or reduc...
	i. Scale: Allows you to select al exact scaling percentage.
	j. Use Grid: To assist in creating FreeForm documents with a neat appearance, you can specify that objects are to be placed on an alignment grid which appears only in the FreeForm window (and not in output).
	k. Cell Height: You can enter the vertical spacing for objects.
	l. Cell Width: Enter the horizontal spacing.
	m. Save As Defaults: To have your changes from the Page tab apply to future documents as well as to the current document, select Save As Defaults after making your changes. To have your changes apply only to future documents, select Cancel af...
	n. Click OK.

	Building A FreeForm With The Query Wizard
	1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group.
	a. Select Detail.
	b. Click Next>.
	a. Select the following fields from the table below:
	b. Click Next>.
	a. We are going to filter on a field that we are not dis playing in our report. To do this, click on the icon.
	b. Scroll up to the END ITEM SERIAL Business View.
	c. Open the Unit Folder.
	d. Select the UIC field.
	e. Make sure that the operator is set to equal (=).
	f. Filter on UIC W0U6AA. Remember to turn your CAPS LOCK on!
	g. Click Next>.
	a. Double-click on Nomen.
	b. The sort order defaults to Ascending, but if you want to change it, click on the A->Z but ton.
	c. Click Next>.
	a. Click on Entire Document.
	b. Sum on the Acq Cost.
	c. Click Finish.
	a. Delete the UIC column heading.
	b. Click the Print Preview button to process your report.
	a. Click on the to close your output window.
	b. Close your report without saving it.

	Designing A Customized FreeForm Report Without The Query Wizard
	1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group or from you computer desktop, double-click the Eureka Reporter Designer icon.
	3. If the Wizard displays, click Finish.
	4. Select Tools from the menu bar.
	5. Select Preferences… from the program group.
	6. Uncheck Use Query Wizard and Default To QuickQuery View.
	7. Click OK.
	8. Select File from the menu bar.
	a. Make any necessary changes.
	b. Click Save As Defaults.
	c. Click OK.
	d. If your Object Directory is not displayed, depress the F2 Function Key to display it.
	e. Select the data fields from the table below. Click, drag, and drop the field(s) to the Detail Area of your FreeForm report. Remember, if the tip of the arrow is not inside the Detail Area, a column header will not be produced.
	a. After you have selected your data objects, depress the F2 Function Key to remove the object directory because it covers part of your design document.
	b. Save your report as FFQUERY before pre viewing it.
	a. Close the output window by clicking on the icon.
	b. DO NOT close the report - we will continue to use it in the next Unit of Study.


	Page Header/Footer Areas
	1. Click in the area. The area will be surrounded in blue with black handles (small blocks).
	2. There is one handle that is solid in color. Click on that handle (it will change to a two-way arrow).
	3. Hold the click, and the drag down to make as large as you want. If you do this, you will need to move your objects to where you want them.

	Selecting Multiple Objects
	Adding Document File Name Objects
	1. Click on the Document Name icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Report Name from the program list.
	5. Place the object on the left side of the Page Footer area.
	6. Double-click on the report name object.
	7. Make any necessary changes.
	8. Click OK.
	9. Process your report.
	10. Save your report.

	Changing Column Headings
	1. Double-click on the Acq Cost field.
	2. Enter Actual Cost over the displayed value.
	3. Import File: Click this button to import text into the value field.
	4. Appearance: Select the appearance option(s) for your report. Refer to Adding Document File Name Objects for defini tions of the Appearance options.
	5. Click OK.
	6. Process your report.
	7. Save your report.

	Changing Fonts
	1. Click on the Actual Cost column heading.
	2. Using the Formatting Toolbar change the font, point size, color, alignment, and characteristics of your font.
	3. Process your report.
	4. Save your report.
	5. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Document Header/Footer Areas
	1. Click on the Document Header/Footer icon.
	2. Select Insert from the menu bar.
	3. Select Area from the program group.
	4. Select Document Header or Document Footer from the program list; this will allow you to insert either the document header or the document footer, depending on which area you selected.

	Adding Text Objects
	1. Click on the text icon.
	2. Select Insert from the menu bar.
	3. Select Text from the program group.
	4. Do not change the Object Label.
	5. In the Value window, enter the desired title for your report.
	6. Click OK.
	7. Place the text object in the center of the Page Header area of your report.
	a. Click the text object once. Notice the solid black box in the center of the bottom of the box.
	b. Place the tip of your mouse arrow on the black box until you get a two-way arrow.
	c. Hold down the left mouse button and pull down, enlarging the box until the lower lines are dis played. If Word Wrap was not selected, then doing this will only enlarge the font of your text.
	4. Save your report.
	5. DO NOT close the report -- we will continue to useit in the next Unit of Study.


	Adding Date Objects
	1. Click on the date icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Date from the program list.
	5. Place the date object on the left side of the Page Header area.
	6. Process your report.
	7. Close the report viewer.
	8. Save your report.
	9. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Adding Time Objects
	1. Click on the time icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Time from the program list.
	5. Place the time object below the date object in the Page Header area.
	6. Process your report.
	7. Close the report viewer.
	8. Save your report.
	9. DO NOT close the report -- we will continue to use it in the next Unit of Study.

	Adding Page Number Objects
	1. Click on the page number icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Page Number from the program list.
	5. Place the page number object in the center of the Page Footer area.
	6. Process your report.
	7. Close the report viewer.
	8. Save your report.
	9. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Adding Counter Objects
	1. Since we are going to add the counter object in the first column, you will need to move all of your col umn headings and detail objects over to the right.
	2. Click on the counter icon.
	3. Select Insert from the menu bar.
	4. Select System from the program group.
	5. Select Count from the program list.
	6. Place the counter object to the left of your columns in the Detail area.
	7. Delete the Counter column heading.
	8. Process your report.
	9. Close the report viewer.
	10. Save your report.
	11. Close your report.
	Activity: Designing A Customized FreeForm Report Without The Query Wizard
	1. Create a new FreeForm report.
	2. Enlarge your Page Header.
	3. Using the counter icon insert counter in the Detail area.
	4. Delete the Counter column heading.
	5. Select the following fields for your FreeForm report:
	6. Insert the date and time in the Page Header area.
	7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in the Page Header area.
	8. Add a Document Footer area.
	9. Add “End of Report” in the Document Footer.
	10. Insert the document name, using the document name icon, in the Page Footer area.
	11. Using the page number icon, insert a page number in the page footer.
	12. Save your report as FFACTY for later use.
	13. Close your report.

	Skill Builder: Designing A Customized FreeForm Report Without The Query Wizard
	1. Name any two features that distinguish FreeForm from QuickQuery.
	2. FreeForm is a powerful tool set that allows you to: (Circle all that apply)
	a. Use multiple areas of the same type.
	b. Specify Output when conditions that determine, row by row, when objects (and areas) should or should not be included in your output.
	c. Add date and time to your reports
	d. All of the above
	e. None of the above
	3. The F4 Function Key opens the ________________ ______________ ______________.
	4. Folder Names are at the top level of the tree and are indicated in all caps? (True or False)
	5. Why is it important when dropping data objects inside the detail area to make sure the tip of the arrow is inside the detail area?
	6. Name the three areas your FreeForm window defaults to when it is opened.
	7. Eureka will not allow you to change the column headings of your data objects. (True or False)
	8. Match the Tool Bar Icons with the correct definition. Insert the alpha character on the blank line.
	1. Discuss the advantages of using FreeForm.
	2. Summarize the process of the report you completed in the previous activity.
	3. What types of reports are needed at your facility?


	Practical Exercise: Designing A Customized FreeForm Report Without The Query Wizard
	1. Create a new FreeForm report.
	2. Enlarge your Page Header area.
	3. Using the counter icon, insert the counter object in the detail area
	4. Delete the Counter column heading.
	5. Select the following fields for your FreeForm report:
	6. Insert the date and time in the Page Header area.
	7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in the Page Header area.
	8. Add a Document Footer.
	9. Add “End of Report”. in the Document Footer.
	10. Insert the document name, using the document name icon, in the Page Footer area.
	11. Using the page number icon, insert page number in the page footer.
	12. Save the report as FFPE1 for later use.
	13. Print (if a printer is available) the report for the Instructor.
	14. Close your report.

	Building A Sort Order In A FreeForm Report
	1. Create a new FreeForm report.
	2. If your object directory is not open, depress the F2 Function Key.
	3. Select the following fields for your FreeForm report:
	4. Process report for viewing.
	5. Close the output window.
	6. Click .
	7. Highlight the HRH Nbr Mjr field.
	8. Click the arrow to move the field into the Ordered Objects window.
	9. Click OK.
	10. Process the report for viewing (go to the second page of the report; this is where the HRH Nbr Mjr starts).
	11. Try sorting on different fields and processing the report to see how your report will look.
	12. Close and DO NOT save the report.

	Group Header/Footer Areas
	1. Open the FFACTY report.
	2. From the Detail Area, click once on the field you want to group. We will be grouping on the UIC.
	3. Select Insert from the menu bar.
	4. Select Area from the program group.
	5. Select Group Header from the program list.
	6. Select the Group Header icon .
	7. Move the field(s) that you want in the Group Header from the Detail area. We will be grouping by UIC.
	8. Move the UIC column heading to the far left of the Group Header area.
	9. Move the UIC data object (blue object) next to the UIC column heading (gray object).
	10. Process the report and view.
	11. Close the report viewer.
	12. Save the report.
	13. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Building A Page Break In A FreeForm Report
	1. Each HRH Report or UIC report starting at the top of a new page.
	2. Each time a new UIC is reached, page numbering re-starting from one.
	1. If closed, open the FFACTY report.
	2. Double-click in the blank portion of the UIC Group Header area.
	3. In the Page Skip group, change Before Area from 0 to 1.
	4. Click OK.
	5. Save your report.
	6. Process your report to view the results.
	7. Close your report.

	Inserting A Filter In A FreeForm Report
	1. Open a new FreeForm report.
	2. In Page Setup, make sure that the Height is set to 8.5 and the Width is set to 11.
	3. Enlarge the Page Header area an additional 3 blocks.
	4. Select the following fields for your FreeForm report:
	5. Add a title for your report, date, and time for your report to the Page Header area.
	6. Add the document name and the page number to the Page Footer area.
	7. Add a Group Header for the MfrName.
	8. Move the MfrName column heading and data object into the Group Header area.
	9. Select the filter icon to display the filter dialog box.
	10. Double-click on the Detail folder.
	11. Double-click on UIC to move it to the Object Window.
	12. Select the drop down arrow and chose “like” for the operator.
	13. Enter W* for the value. Remember to turn your Caps Lock on.
	14. Click Add.
	15. Double-click on MfrName Group Header.
	16. Double-click on MfrName to move it to the Object Window.
	17. Select the drop down arrow and chose “like” for the operator.
	18. Enter *DELL* for the value. Remember to turn your Caps Lock on.
	19. Click Add.
	20. Click OK.
	21. Save your report as FFFILTER.
	22. Process and view your report.
	23. Close the output window.
	24. Select the filter icon to display the filter dialog box.
	25. Double-click on UIC, from the Detail folder, to move it to the Object Window.
	26. Select the drop down arrow and chose “like” for the operator.
	27. Enter W* for the value. Remember to turn your Caps Lock on.
	28. Change the OR’d Group from 0 to 1. This will set an OR condition.
	29. Click Add.
	30. Double-click on MfrName, from the MfrName Group Header, to move it to the Object Window.
	31. Select the drop down arrow and chose “like” for the operator.
	32. Enter *GATEWAY* for the value. Remember to turn your Caps Lock on.
	33. Click Add.
	34. Click OK.
	35. Save your report.
	36. Process and view report.
	37. Close your report.

	Hiding An Object In A FreeForm Report
	1. Select the Prompt object in your Page Footer area as the object to be hidden.
	2. Right-mouse click to display shortcut commands.
	3. Select Hide Toggle.
	4. You can see the hidden prompt by displaying your Area Object List by depressing the F4 Function Key.
	5. Click on Hidden Document and your prompt will display in the Hidden Document area of your design document.
	6. To hide it again, simply click on Hidden Page in the Area Object List.
	7. Save your report.
	8. Process your report.
	9. Close your report.

	Inserting A Prompt In A FreeForm Report
	1. Open a new FreeForm report.
	2. Enlarge the Page Header area.
	3. Select the following fields for your FreeForm report:
	4. Add a title, date, and time for your report to the Page Header area and customize with fonts, etc.
	5. Add the document name, using the document name icon, to the Page Footer area.
	6. Add the page number to the Page Footer area.
	7. Add a Document Footer area.
	8. Add “End of Report” in the Document Footer area.
	9. Save your report as FFPROMPT.
	10. Select the prompt icon from the tool bar.
	11. Object Label: Enter HRH Prompt in the Object Label. This is where you would enter the descriptive name for your prompt.
	12. Sequence Number: Accept the default of 1. If you have more than one prompt, you can designate the order in which it will run by changing the sequence number.
	13. Prompt: Enter “Enter HRH”. This is the prompt instruction.
	14. Type: Accept the default of String. If you selected a cost or date field, you can change the format of that field.
	15. Format: The field displays the characteristics of the data (string, numeric, or date). These come from the database file structure.
	16. Character Width: Select the amount of characters you want to display.
	17. Choice Value To Add: Leave this field blank. This field will allow you to enter the fields that the user will select. The choices will display in the window to the left.
	18. Use Choices Only: Do not select this radio button for this report. Use this field to only select choices from a choice list. You cannot type an entry for the prompt. The choice list will consist of the entries you add to the Choice List.
	19. Allow User Input: Accept this default radio button for this report. This radio button allows you to type an entry for the prompt or make a selection from a drop down box. If you have defined a choice list, you can choose from the choice l...
	20. Allow Multiple Choices: Do not check this box for this report. Check this box to select multiple items from the choice list. Each choice is added to the value of the user prompt object. Choices are separated by semi-colons (;) or commas (...
	21. Require Input: Do not check this box for this report.
	22. Appearance: Refer to Designing A Customized FreeForm Report Without The Query Wiz ard for definitions for the appearance options.
	23. Default Choice: Leave the Default Choice blank for this report. If you want a specific value to be defaulted in the prompt, enter the default choice.
	24. Click OK.
	25. Place the prompt in the Document Footer area.
	1. Select Filter icon.
	2. In the Objects window, double-click the Detail folder.
	3. Double-click on HRHNbrMjr to move it to Object.
	4. Set the Operator to = (equal).
	5. In the Objects window, double-click on the Document Footer folder.
	6. Double-click HRH_Prompt to move it to Value1.
	7. Click Add.
	8. Click OK.
	9. Save your report.
	10. Process your report.
	11. When prompted, enter W1NW54.
	12. Click OK.
	13. Close the output window.
	14. Save your report.
	15. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Designing A FreeForm Report Using Double Detail Areas
	1. Create a new FreeForm report.
	2. Save your as FFDOUBLEDETAIL.
	1. Insert a Document Header area.
	2. Insert a Document Footer area.
	3. Insert a Detail Area:
	a. Click on Insert from the menu bar.
	b. Click on Area from the program group.
	c. Click on Detail Area from the program list.
	4. Enlarge the Page Header area 2 more blocks (for a total of 5 blocks).
	5. Enlarge the first Detail area 3 more blocks (for a total of 4 blocks).
	6. Enlarge the second Detail area 2 more blocks (for a total of 5 blocks).
	7. Click on the text icon and type a title that will go in the Document Header area; remem ber, to use the font tab and enlarge and bold the text plus add any other preferences you may want.
	8. Repeat Step 7 for the Page Header area.
	9. Add “End of Report” in the Document Footer area.
	10. Insert the date in the Page Header area.
	11. Insert the page number in the Page Footer area.
	1. Make sure your Object Directory is displayed (F2 Function Key). Use the screen print on the first page of this handout for placement reference.
	2. Select the data fields listed below: You will be inserting these data fields in the 1st Detail area on the top line of that detail area, so the gray box is in the page header.
	3. Close the Quick_Start! folder.
	4. Open the Serial Hand Rcpt.-Auth folder.
	5. Select the data fields listed below: Insert Auth Qty in the 1st Detail area.
	6. Move Auth Qty object (blue object) down one row and bring the Auth Qty column header (gray object) down to the row above the detail object.
	7. Insert Qty On Hand in the 5th row of the 2nd Detail area, positioned in line with Auth Qty.
	8. Move the column header (gray object) to be above the detail object (blue object).
	9. Open the Quick_Start!folder.
	10. Select the data fields listed below: You will be inserting these data fields in the 2nd detail area, lining them up under the 1¹” margin.
	11. Bring the detail object (blue object) down to the 5th line.
	12. Bring the column header (gray object) and line it up above the 4th line.
	1. Insert a Prompt.
	2. In the Prompt Label, enter “HRH Prompt”.
	3. In the Prompt line, enter “Enter HRH Mjr Nbr”.
	4. Click OK.
	5. Insert the prompt in the Page Footer area.
	6. Click once on the prompt.
	7. Right-mouse click and select Hide Toggle.
	8. Insert a filter.
	9. In the Object area pull from the Detail(1) folder the HRH Nbr Mjr.
	10. Select = (equal) for the Operator.
	11. From the Hidden Page folder, select HRH Prompt for Value1.
	12. Click Add.
	13. Click OK.
	14. Save your report.
	15. Process your report.
	16. At the prompt, enter one of the following HRH numbers:
	17. Click OK.


	Using Translate Values In A FreeForm Report
	1. Open FFPROMPT.
	2. Scroll over to the right of your report to display the last field.
	3. Click on the Custom icon.
	4. Double-click on the Detail folder.
	5. Double-click on the AcqCost field to move to the Value window.
	6. Using the calculator on the right of the window, click on x (multiply).
	7. Click on 1.
	8. Change the Character Width to 15.
	9. Click OK.
	10. Place the custom object into the detail area.
	11. Change the Custom column heading to Capital/Non-Capital.
	12. Double-click on the CUSTOM field.
	13. Select the Translate tab.
	14. Double-click on the CUSTOM field in the Detail folder.
	15. Set the Operator to >= (greater than or equal to).
	16. Enter 100000 in Value1.
	17. Enter CAPITAL in then Become.
	18. Click Add Case.
	19. Change Otherwise Become to NON-CAPITAL.
	20. Click OK.
	21. Save you report.
	22. Process your report (using S701 in your HRH prompt).
	23. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Using Output When In A FreeForm Report
	1. If closed, open FFPROMPT.
	2. Double-click on the AcqCost data object (blue color).
	3. Select the Output When tab.
	4. Set the Operator to <= (less than or equal to).
	5. Enter 5000 for Value1.
	6. Insert Space When Not Output: Check this box to determine whether or not Eureka inserts a space in your output when the object for which you are setting the condition is not output.
	7. Click OK.
	8. Save your report.
	9. Process your report using S701 at the prompt.

	Skill Builder: Introduction To FreeForm And Designing A Custom ized FreeForm Report
	1. Filters are used to (Please choose one):
	a. Generate duplicate records.
	b. Control which rows of detail data for output.
	c. Include spaces in your report.
	2. Is it possible to build a Prompt without a Filter? (Yes or No)
	3. I am a prompt and I allow the user only to select choices, which prompt type am I?
	4. I am a prompt and I allow the user to select from a choice list, which prompt type am I?
	5. I am a prompt and I allow the user to select multiple choice items, which prompt type am I?
	6. Translate Value is similar to a CASE structure of "If - Then - Else" logic? (True or False)
	7. When you do not set any Output When condition, every object is output all the time? (True or False)
	8. The F2 Function Key provides information regarding hidden objects? (True or False)
	9. You must be in a FreeForm window to add or edit a user prompt object? (True or False)
	1. Discuss the Prompt process:

	a. Object label, what goes there. Why is it important to signify it is a prompt?
	b. Prompt label, what is entered here?
	2. Why do you insert prompts in a report?


	Practical Exercise: Introduction to FreeForm And Designing A Customized FreeForm Report
	1. Open a new FreeForm report.
	2. Expand the Page Header area an additional 4 blocks.
	3. Select the following fields for your FreeForm report:
	4. Add a title, date, time for your report and place the objects in the Page Header area (you can custom ize with fonts, etc.).
	5. Add a page number to the Page Footer area.
	6. Add a prompt for UIC and HRH Nbr Mjr and place in the Page Footer area.
	7. Click on the UIC Prompt object.
	8. Right-mouse click and select Hide Toggle to hide the prompt object.
	9. Repeat to hide the HRH Prompt object.
	10. Select the filter icon.
	11. If the Detail folder is not open, double-click on it to open it.
	12. Double-click on the UIC object.
	13. Set the operator to = (equal).
	14. Double-click on the Hidden Page folder to open.
	15. Double-click on the UIC_Prompt to place it in the Value.
	16. Click Add.
	17. Repeat steps 12 through 16 for the HRH_Prompt.
	18. Double-click on the Acq_Cost field.
	19. Set the operator or <= (less than or equal to).
	20. Set the value to 1 (for $1.00).
	21. Click Add.
	22. Click OK.
	23. Click on the Print Preview icon.
	24. Enter S710 for the HRH Nbr.
	25. Enter HQ1010 for the UIC.
	26. Click OK.
	27. Save your report as FFPE2.
	28. Close your report.

	Building A FreeForm Query Using The Parent/Child Function
	1. Child Document Objects. Each of these represents an entire document.
	2. Child Data Objects. Each of these represents a single object from a document.
	Child Document Objects

	1. Create a new FreeForm report.
	2. In the parent document, add the name of report and the date to the Page Header.
	3. Add the page number and the document name of the report to the Page Footer.
	4. Select the following fields for your Parent report from the table below. Make sure that you put them to the left side of your design document:
	5. Save the parent report as PC-Parent.
	Child Document

	1. Create a new FreeForm report. If the parent report has been set to landscape, the child report must be set to landscape also. Otherwise, when you attach the Child to the Parent, it will not show up.
	2. Select the following fields for your Child report from the table below. Make sure that the fields are placed approximately to the right of where the last field in parent was placed:
	3. Using the document name icon, insert the report name to the Page Footer.
	4. Save the report as PC-Child.
	5. Process the report.
	Child Prompts

	1. Click on the Prompt icon.
	2. For the Object Label, enter Serial Number Prompt.
	3. For the Prompt message, enter “Enter Serial Number”.
	4. Change the Character Width to 20.
	5. Click OK and place anywhere in the Page Footer.
	6. Right-click on the Prompt object.
	7. Select Hide Toggle. Hiding the Prompt is optional. If you want it displayed on the report, do not hide.
	Child Filters

	1. Click on the Filter icon.
	2. Click on the Columns tab, scroll to the HISTORIES Business View.
	3. Double-click on the History folder.
	4. Double-click on Serial Nbr to move it to the Object field.
	5. Set the Operator to = (equal).
	6. Click on the Objects tab.
	7. Double-click on Hidden Page Folder.
	8. Double-click on Serial_Number_Prompt to move it to Object 1.
	9. Click Add.
	10. Click on the Columns button.
	11. Scroll to the HISTORIES business view.
	12. Double-click on the History folder.
	13. Double-click on PgmDesc to move it to Object field.
	14. Set the Operator to = (equal).
	15. For Value 1, type in EI INC RCPT. Remember to turn your CAPS LOCK on.
	16. Click Add.
	17. Click OK.
	18. Save the report.
	19. Close the child report.
	Inserting the Child Document

	1. If closed, open the Parent document.
	2. From the menu bar, click Insert>Child Document.
	3. Click on the child document icon .
	4. Place the child document object in the Detail area, to the right of the other objects.
	5. Double-click on the Child Document icon in the detail area.
	6. Object Label: You can label your object if you wish.
	7. Click the drop down box under File Name and click the Child Document that you cre ated.
	8. Under Parent Objects, click the drop down box and select SerialNbr on Detail[Area]. This is telling you what data fields the Parent document is selecting. It is also the common field between the parent and child docu ments. If there are an...
	9. Select the radio button, Merge Child. This insures the data from the child document will use the same size and font style as the parent.
	10. Click OK.
	11. Save your report. The child document is now attached.
	12. Click on the Text Box icon and add a column heading for the Acquisition Date and place it in the Page Header area at around the same place as where you placed it in the child document.
	13. Repeat for the User ID.
	14. Save your report.
	15. Process your report.

	Activity: Designing A Parent/Child FreeForm Report
	1. Open a new FreeForm report.
	2. Save your report as PC-Acty-Parent in the folder designated by your instructor.
	3. Click to select the Page Header area. Widen the Page Header Area area to 3 blocks high.
	4. Add the Name of report (text) and the Date to the Page Header area.
	5. Add the document name to the Page Footer area.
	6. Select the following fields for your report from the table below. (Place to the left as far as possible).
	7. Save your report.
	1. Click on the Filter icon.
	2. Click on the Objects Tab.
	3. Double-click on the Detail Folder.
	4. Double-click on AcqCost to place it in the Object cell.
	5. Set the Operator to >= (greater than or equal to).
	6. Enter 100000 in Value1.
	7. Click Add.
	8. Click OK.
	9. Save your report.
	10. Remember where the last data field is on your report.
	1. Create a new FreeForm report.
	2. Save your report as PC-Acty-Child in the same folder as the PC-Acty-Parent document.
	3. Select the following fields from the table below. (Place these objects in the Detail area begin ning at the 6” mark on the ruler. Otherwise, when you attach the Child to the Parent, it will not show up.
	4. Right-click on the Stock Nbr data field (blue object).
	5. Select Hide Toggle. This will be used for our Prompt and Filter.
	6. Delete the column heading for Stock Nbr.
	7. Double-click on each data object (blue object).
	8. When the Attributes box comes up, check the Suppress Duplicates box.
	9. Save your query.
	1. Click on the Prompt icon.
	2. Enter StockNbrPrompt for the Object Label.
	3. Enter “Enter Stock Number” for the Prompt message.
	4. Change the Character Width to 15.
	5. Click OK.
	6. Place the prompt object anywhere in the Page Footer area.
	7. Right-click on the prompt.
	8. Select Hide Toggle to hide your prompt.
	9. Save your report.
	1. Click on the Filter icon.
	2. Click on the Columns tab.
	3. Scroll to the ACCOUNTING TRANSACTIONS business view.
	4. Double-click on the Accounting folder.
	5. Double-click on Stock Nbr to move it to Object.
	6. Set the Operator to = (equal).
	7. Click on the Objects tab.
	8. Double-click on Hidden Page.
	9. Double-click on StockNbrPrompt to move to Object.
	10. Click Add.
	1. Double-click on the Detail Folder.
	2. Double-click on DollarAmt to move it to Object.
	3. Set the Operator to >= (greater than or equal to).
	4. Enter 100000 in Value1.
	5. Click Add.
	6. Click OK.
	7. Save your report.
	8. Close your report.
	1. Open the Parent Capital document.
	2. Click Insert>Child Document from the menu Bar.
	3. Place the Child Document object in the Detail area, to the right of the other objects.
	4. Double-click on the Child Document icon.
	5. Click the drop down button under File Name and select the Child Document that you created.
	6. Click the drop down box for Parent Objects.
	7. Select StockNbr on Detail (Area). This is what the Parent will answer with when the Child asks the Prompt.
	8. Select the radio button Merge Child. This will maintain the font style and size between the Parent and Child.
	9. Click OK.
	10. Save and view the report. Do not click on the last page icon as this report is very long.
	11. Close the report.
	1. Open the parent report.
	2. Click on the text icon and add headers for the following:
	3. Process your report.
	4. To place columns where you want them to print out on the parent document, go to the child document and move the data fields to the left or right on the detail line. You may need to re- align the headers after processing the report.
	5. Save your report.
	6. Process your report to view.
	7. Close your report.

	Skill Builder: Building A Parent/Child FreeForm Report
	1. Child Documents are used almost exclusively for:
	2. Each document always pulls from different business views. (True or False)
	3. If you place the object in Document Header or Document Footer area, the child object will appear only_________at the _____________or _____________of the report.
	4. Insert the Child document object in the desired area. (Circle all that apply)
	a. If you place the object in the Page Header or Page Footer area, the child will appear once at the begin ning or end of each page.
	b. If you place the object in the Group Header or Group Footer areas, the child will appear once for each row that appears on your document.
	c. If you place the object in the Document Header or Document Footer area, the child object will appear on every page of the document.
	d. If you want the child to show only certain rows, place it in its own detail area, separate from the other columns in the parent document and set the Output When conditions for the area.
	5. It is recommended, but not mandatory, for Parent/Child reports that you change the orientation to ___________.
	6. How do you insert the Child Document in the Parent Document?
	7. To make sure the child document returns information for the same row that the parent is looking at, a _______________ is placed in the child document.
	8. When you select the radio button Merge Child, this insures the data from the child document will use the same size and font style as the parent. (True or False)


	Practical Exercise: Designing A Parent/Child FreeForm Report
	1. Create a new FreeForm report.
	2. Save your report as PC-PE-Parent in the folder designated by your instructor.
	3. Expand the Page Header area an additional 2 blocks.
	4. Using the document name icon, add the report name to the Page Footer area.
	5. Select the fields from the table below and place them to the left in the detail area.
	6. Expand the Detail area to 2 blocks.
	7. Save your report.
	8. Using the text icon, enter “Detail Report” (enhance the title using the font, border, etc. tabs).
	9. Double-click on each data object (blue object) and check the check box for “Suppress Dupli cates”.
	10. Highlight the HRH Name (blue object), go to the tool bar and click on group header icon.
	11. Move both HRH Name objects into the HRHName Group Header area.
	12. Expand the HRH Name Group Header area to 6 blocks.
	13. Move the HRHName data object (blue object) below the HRHName text object (gray object).
	14. Move all of your object boxes over to the right where the HRHName stops.
	15. Rubberband all the object boxes (gray objects) and move into the HRHName Group Header area.
	16. Rubberband all the data objects (blue objects) that are in the Detail area and move them up to the top of the Detail area.
	17. Double-click in the blank area of the HRHName Group Header area.
	18. In the Page Skip group box, set Before Area to 1.
	19. Click OK. This will create a page break.
	20. Add a Document Header area.
	21. Add a second Document Header area.
	22. Expand the new Document Header area to a total of 8 blocks.
	23. Save your report.
	1. Create a new FreeForm report.
	2. Save your report as PC-PE-Child in the same folder as PC-PE-Parent.
	3. Select the data elements from the table below:
	4. Widen the Detail area to 2 more blocks.
	5. Double-click on each data element (blue object) and check the check box for “Suppress Dupli cates”.
	6. Double-click on the blue Acq Cost.
	7. Click on the drop down box for the Aggregate function and select sum.
	8. Click OK.
	9. Save your report.
	10. Close your report.
	1. Open PC-PE-Parent.
	2. Click on Child Document icon.
	3. Insert the child document icon in the Document Header(1) area.
	4. Double-click on the Child Document icon.
	5. In the File Name, click the browse button and go to the directory where the child report is saved.
	6. Select the PC-PE-Child document to insert your Child Summary report.
	7. Click radio button for Merge Child.
	8. Click OK.
	9. Save your report.
	10. Process your report.

	Child Data Objects
	1. Create a new FreeForm report.
	2. If not the default, change the orientation to Landscape.
	3. In the parent document, add the name of report and the date to the Page Header.
	4. Add the page number and the document name you will assign to the report to the Page Footer area.
	5. Select the following fields for your Parent report from the table below. Make sure that you put them to the left side of your design document:
	6. To limit the information to the HRH Nbr Mjr of choice, we will filter on the HRH Nbr Mjr.
	7. Click on the Filter icon.
	8. Open the Detail folder.
	9. Double-click on HRH Nbr Mjr to move it to the Object field.
	10. Set the Operator to “Like”.
	11. Enter W* (cap locks on) in Value1.
	12. Click Add.
	13. Click OK.
	14. Save your report as PC-CDO-Parent.
	15. Process your report.
	1. Create a new FreeForm report. If the parent report has been set to landscape, the child report must be set to landscape also. Otherwise, when you attach the Child to the Parent, it will not show up.
	2. Select the following fields for your Child report from the table below. Make sure that the fields are placed approximately to the right of where the last field in parent was placed:
	3. Add the file name you will assign to the report to the Page Footer area.
	4. Save your report as PC-CDO-Child.
	5. Process your report.
	1. Click on the Prompt icon.
	2. For the Object Label, enter HRH Nbr Mjr Prompt
	3. For the Prompt message, enter “Enter HRH Nbr Mjr”.
	4. Change the Character width to 6.
	5. Click OK and place anywhere in the Page Footer area.
	6. Right-click on the Prompt icon and Hide Toggle.
	7. Click on the Prompt icon.
	8. For the Object Label, enter “Stock Nbr Prompt”.
	9. For the Prompt Message, enter “Enter Stock Nbr”.
	10. Change the Character Width to 15”.
	11. Click OK and place anywhere in Page Footer area.
	12. Right-click on the Prompt and Hide Toggle
	1. Click on the Filter icon.
	2. If not open, click on the Objects tab and open the Detail and Hidden Page folders.
	3. In the Detail folder, double-click on the HRH Nbr Mjr to move it to the Object field.
	4. Set the Operator to = (equal).
	5. In the Hidden Page Folder, double- click on HRH Nbr Mjr Prompt to move to Value1.
	6. Click Add.
	7. In the Detail folder, double-click on Stock Nbr to move it to the Object field.
	8. Set the Operator to = (equal).
	9. In the Hidden Page folder, double-click on Stock Nbr Prompt to move it to Value1.
	10. Click Add.
	11. Click OK.
	12. Save your report.
	13. Close the Child report.
	1. If closed, open the Parent document.
	2. From the menu bar, click Insert>Child Document OR Click on the child document icon .
	3. Place the child document object in the Detail area, to the right of the other objects.
	4. Double-click on the Child Document icon in the Detail area.
	5. Click the drop down box under File Name and click the Child document that you created.
	6. Under Parent Objects, click the drop down box and select HRH Nbr Mjr on Detail (Area). This is telling you what data fields the Parent document is selecting.
	7. In the Child’s User Prompts window, highlight Stock Nbr Prompt.
	8. Under Parent Objects, click the drop down box and select Stock Nbr on Detail (Area). This is tell ing you what data fields the Parent document is selecting.
	9. Mark the radio button, Merge Child. This insures the data from the child document will use the same size and font style as the parent.
	10. Click OK, it is now attached, save the report.
	1. On the parent report, highlight the child document icon, right click and select Hide Toggle.
	2. Select Insert>Child Data from the menu bar or click on the Child Data icon from the menu bar.
	3. The Child Object window appears. In the child document area, click on the drop down arrow and select the child report you designed. This will open up the Object In Query Area.
	4. In the Object Label, enter “Doc Nbr”.
	5. Change the Character Width to 14”.
	6. For the Object Query, click on the drop down arrow and select Doc Nbr on Detail (Area).
	7. Click OK.
	8. Your cursor becomes a precision pointer. Drop the pointer in the detail area next to the last data object.
	9. Click on the text icon (abc).
	10. Enter “Document Nbr”. In the Font tab, check the radio buttons for bold and underline.
	11. Place in the Page Header area above the Child Data Object.
	12. Save your report.
	13. Process your report.

	Hot Objects
	1. Open or create a FreeForm report.
	2. Expand the Page Header area 2 more blocks.
	3. Select the following fields for your FreeForm report:
	4. Using the text icon, add the title of the report and date to the Page Header area.
	5. Using the Document Name icon, add the document name to the Page Footer area.
	6. Add the page number to the Page Footer area.
	7. Process your report.
	8. Save the report as PC-HOTOBJ-Parent.
	Creating a Child for Hot Objects

	1. Open a new FreeForm report.
	2. Select the following fields for your FreeForm report:
	3. Drag Document Number to the Detail area.
	4. Using the text icon, add a title for your report and place in the Page Header area. Enhance your title using the font, border, etc. tabs.
	5. Add the date to the Page Header area.
	Creating a Prompt for a Hot Object Child

	1. Click on the prompt icon.
	2. Enter “SerialNbrPrompt” in the Object Label.
	3. Enter “Enter Serial Number” in the Prompt.
	4. Change the Character Width to 20.
	5. Click OK.
	6. Place the prompt object in the Page Footer area.
	7. Right-click on SerialNbrPrompt and click Hide Toggle.
	Adding a Filter to the Hot Object Child

	1. Click on the filter icon.
	2. From the Object directory, click on the Columns tab.
	3. Scroll to the HISTORIES business view.
	4. Select the History folder.
	5. Double-click on Serial Nbr to move it to the Object.
	6. Set the operator to = (equal).
	7. Click on the Objects tab.
	8. Double-click on the Hidden Page folder.
	9. Double-click on SerialNbrPrompt to move it to Object1.
	10. Click Add.
	11. Click OK.
	12. Save your report as PC- HOTOBJ -Child.
	13. Close the report.
	Creating the Hot Object

	1. Open the Parent report, if you previously closed it.
	2. Double-click on the Serial Nbr object in the Detail area.
	3. Click on the Hot Object tab.
	4. File Name: Click the drop down box and select the Hot Object child that was created.
	5. Parent Objects: Click the drop down box and select SerialNbr on Detail (Area).
	6. Click OK.
	7. Save your report.
	8. Process your report.
	9. Click on a BLUE serial number to obtain additional information about the item.

	Introduction To Enhanced Eureka
	Charts
	1. Create a new FreeForm report.
	2. Select the following fields for your FreeForm report:
	3. Save your report as CHART.
	4. Process your query.
	5. Close the report viewer.
	6. Select the chart icon from the tool bar.
	7. Place the chart object into the Page Footer area of your document.
	8. Click on the chart object and drag out to enlarge the icon to about half a page.
	9. Double-click on the chart icon.
	10. Select the Chart Types button.
	11. Select 3D Pie.
	12. Title: Enter $ By HRH Nbr Mjr.
	13. Click on the Objects button.
	14. Double-click on the Detail folder.
	15. Click, drag and drop the Acq Cost field to the Pie Slice Values. This field is grayed out, but you will still be allowed to drag the object into the field.
	16. Click, drag and drop the HRH Nbr Mjr to Pie Slice Labels. This field is grayed out, but you will still be allowed to drag the object into the field.
	17. In the Chart Attributes group, check Display Legend.
	18. In the Gradient group, accept the default of None.
	19. In the Summary group, select Sum.
	20. Do not change Appearance.
	21. Select the Filter tab.
	22. Click on the Objects tab.
	23. Double-click on the HRH Nbr Mjr to add to the Object.
	24. Set the Operator to Between.
	25. Set Value1 to W1DC03.
	26. Set Value2 to W1NW54.
	27. Click Add.
	28. Click OK.
	29. Save your report.
	30. Process your report.
	31. Close your report.

	Crosstabs
	1. Create a new FreeForm report.
	2. Select the crosstab icon from the tool bar.
	3. Insert the crosstab object into the detail area of your document.
	4. Double-click on the crosstab icon.
	5. Crosstab File Name: Enter FSC Inven tory. Eureka will automatically add the .iqr extension.
	6. Click on the Columns tab (if it isn’t already selected).
	7. Scroll to the END ITEM SERIAL Business View.
	8. Double-click on the Quick_Start! folder.
	9. Click, drag and drop the FSC field to the Columns window.
	10. Click, drag and drop the HRH Nbr Mjr field to the first Rows window.
	11. Click, drag and drop the Acq Cost to the second Rows window. The Aggregate radio button will default to Sum.
	12. Column Title: Enter FSC Inventory.
	13. Row Title: Enter HRH.
	14. De-select the Scale to Object in the Appearance area.
	15. Click on the Crosstab Styles button.
	16. Select the style with the red border.
	17. Click on the Filter tab.
	18. Click on the Objects button in the Object directory.
	19. Double-click on the Acq Cost field to move it to Object.
	20. Set the Operator to > (greater than).
	21. Set Value1 to 10000.
	22. Click Add.
	23. Double-click on the FSC field to move it to Object.
	24. Set the Operator to Between.
	25. Set Value1 to 3411.
	26. Set Value2 to 3930.
	27. Click Add.
	28. Click OK.
	29. If your default page setting is not already set to Landscape, change your page setup to Landscape.
	30. Save your report as CROSSTAB.
	31. Process your report.
	1. Open the crosstab dialog box.
	2. Click the Browse button next to the Crosstab File Name input box. Eureka opens a file selection dialog box.
	3. Select the file containing the crosstab you want to include. Eureka reads the file and displays its val ues in the dialog box.

	Graphics
	1. Open your FFACTY report.
	2. Select the graphic icon from the tool bar.
	3. Place the graphic object in the left-hand side margin of the Document Header area.
	4. Double-click the graphic object.
	5. Enter a label for your graphic object.
	6. Set the Height to 1.04.
	7. Set the Width to 1.04.
	8. Click on the Image/Border tab.
	9. If you want a border around your graphic, click on the list box and select the desired Line Weight. You can also set the point size, add shadowing and use customized settings.
	10. If you want a background for your graphic, select a pattern; otherwise, check the Transparent check box.
	11. If desired, change the border, shadow, fill, and/or pattern color(s).
	12. Click on the browse button next to File Name.
	13. Change Look In: to C:.
	14. Double-click on Eureka.
	15. Double-click on Reporter.
	16. Double-click on Designer.
	17. Double-click on the Sample folder.
	18. Double-click on the World.bmp file.
	19. Click OK.
	20. Click OK.
	21. Save your report.
	22. Process your report.
	23. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Creating Icons For Your Desktop
	1. Open the FFACTY report.
	2. Select Tools from the menu bar.
	3. Select Auto Shortcut Builder… from the program group.
	4. Description: Eureka will default this field with your report title. Depending on which radio but ton you select (View, Print, or Export), it will be a part of your Description.
	5. Accept the default View.
	6. Export Format: If you selected Export, you will need to select the export format.
	7. Click on the Program Group list box and select Accessories (All Users). Your icon will be save to the Program Group that you specify.
	8. Click on the list box for Current Icon.
	9. Select your desired icon.
	10. Click OK.
	11. Save your report.
	12. Close your report and return to your desktop.
	13. Click on the Start button.
	14. Select Programs.
	15. Select Accessories.
	16. Select Eureka-Reporter Designer View_FFACTY.
	17. Close the output window.

	Creating Labels
	1. Click File>New From Template.
	2. Look in: Select C:.
	3. Double-click on the Eureka folder.
	4. Double-click on Reporter.
	5. Double-click on Designer.
	6. Double-click on Template.
	7. Double-click on the Avery folder.
	8. Change Files of type to Mailing Labels (*.iqm).
	9. Select A4_I7160.iqm.
	10. Double-click on COLUMN.
	11. Scroll to the END ITEM SERIAL business view.
	12. Scroll to the Serial_Hand_Receipt folder.
	13. Double-click on Bar Cd.
	14. Click OK. You are returned to the Design Document.
	15. Click OK.
	16. Using the table below, repeat the steps for the remaining label fields.
	17. Save your report as Label.
	18. Process your report.
	19. Close the report viewer.
	20. Close your report.

	Creating A Personal Data Mart
	1. Open a QuickQuery without the Wizard.
	2. Select the fields from the table below:
	3. Move the selected fields to the workspace.
	4. Save the query as YOURNAME-PDM (for example, JOHN-PDM).
	5. Select File from the menu bar.
	6. Select Export from the program group.
	7. In Save in, change to Desktop.
	8. Change Save as type to Personal Data Mart (*.iqd).
	9. Click Export.
	10. Close your report without saving.

	Using A Personal Data Mart
	1. Open a new QuickQuery report without the wizard.
	2. Select Tools from the menu bar.
	3. Select Database Connection Defaults… from the program group.
	4. Select (Personal Data Mart) from the Data Source list box.
	5. Click the browse button for the Personal Data Mart.
	6. Look in: Select Desktop.
	7. Click YOURNAME-PDM.iqd.
	8. Click Open.
	9. Click OK.
	10. If your Object Directory is not displayed, depress the F2 Function Key.
	11. Double-click on the YOURNAME-PDM.
	12. You can now select the fields you want to use in your query.
	13. Select from any or all of the fields from the PDM for your report. NOTICE how quickly the data is added, since it is coming from your hard drive, and does not have to negotiate the Internet or your Local Area Network (LAN).

	Toolbars, Status Bars And Operators
	Menu Items
	Changing Your Eureka Password
	1. Select Ad Hoc Reports icon or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group.
	a. From the menu bar, select Tools.
	b. Select Database Connection Defaults...
	a. Data Source: Make sure that your DPAS Site ID is displayed.
	b. Login ID: Make sure that your DPAS User ID is displayed.
	c. Password: Enter your NEW DPAS password.
	d. Server Name: Leave this field blank.
	e. Database Name: Leave this field blank.
	f. Prompt For Data Source at Runtime: Do not check this box. If checked, you will be prompted to enter your DPAS Site ID each time you run a report.
	g. Default Metadata File: Browse for where the DPAS programs reside on you workstation. If all the defaults were taken during installa tion, then the path is normally: C:\Program Files\DOD\DPAS\DPAS.iqk.
	h. Server Name: Leave this field blank.
	i. Host Name: Leave this field blank.
	j. Click OK.

	Installation Of The Eureka Reporter Viewer
	1. If installed, remove the existing version of Eureka Reporter Designer via the Control Panel “Add/ Remove Programs” applet prior to installing the Eureka Reporter Viewer program.
	2. To install Eureka Reporter Viewer, click on the Start button.
	3. Select Run from the program group.
	a. Open: Enter the full path of where you downloaded the “dpaspr.exe” file.
	b. Click OK.
	a. Installation Folder: Accept the default of “c:\dpasinst”.
	b. Click Finish.
	a. Enter the key that was given to you in the Installation Instructions.
	b. Click OK.
	a. Uncheck the “Display the Release Notes” and “Launch EUREKA Reporter Viewer now” check boxes.
	b. Click Finish.

	Chart Types
	Style Profiles
	a. Double-click on the rule that you want to set your attributes to.
	b. Click Apply to assign your style. This only assigns the rule to the cur rent query.
	c. Click Save As... to save this style to use in other queries.
	a. Define rules for Odd Rows, Even Rows, or Detail Data by double-clicking the rule name, or rule the condition and clicking the Edit button (located directly above the Rules list). This opens the Rule dialog box for the selected condi tion. ...
	b. Click the Font tab and change the attributes for your styles, such as font types, size, and effects.
	c. Click on the other tabs to add borders, colors, etc.
	d. Click OK.
	a. Save this profile as: Give your profile a name.
	b. Click OK.
	1. Click on Tools>QuickQuery Styles Editor from the menu bar.
	2. Change the Profile to the style you want to use.
	3. Click OK.
	4. Create and process your report.
	5. Save your report.
	6. Close your report.


	What If Statements
	1. Create a new FreeForm report.
	2. Add a Document Header area.
	3. Add a report title to the Document Header area.
	4. Add a Document Footer area.
	5. Using the text object, add End of report to the Document Footer area.
	6. Add the date and name of file to the Page Header area.
	7. Add the page number to the Page Footer area.
	1. Select the following fields for your report and add to the Detail area of your report:
	2. Right-click on the UIC data object (blue object) and select Hide Toggle.
	3. Delete the UIC column heading (gray object) from the Page Header area.
	1. Click on the Filter icon.
	2. From the Objects tab, double-click on the Detail folder.
	3. Double-click on AcqCost to move into the Object.
	4. Set the Operator to >= (greater than or equal to).
	5. Set Value1 to 10000.
	6. Click Add.
	7. Double-click on EffDate to move into the Object.
	8. Set the Operator to >= (greater than or equal to).
	9. Set Value1 to 19960101.
	10. Click Add.
	11. Double-click on the Hidden Detail Objects folder.
	12. Double-click on UIC to move into the Object.
	13. Set the Operator to Like.
	14. Set Value1 to W*.
	15. Click Add.
	16. Double-click on UIC to move into the Object.
	17. Set the Operator to Like.
	18. Set Value1 to N*.
	19. Change the OR’d Group to 1.
	20. Click Add.
	21. Click OK.
	22. Save the report as What If.
	1. Click on the Custom icon.
	2. Type in Group for the Object Label.
	3. Click on the Function button and scroll to SUBSTR.
	4. Double-click on SUBSTR, to move into the Value area.
	5. Remove everything except the left parenthe sis.
	6. Click on the Objects tab.
	7. Double-click on UIC, to place it next to the left parenthesis (no space).
	8. After the UIC, type in “,1,1)” (without the quotes). It should read SUBSTR (UIC,1,1).
	9. Click OK.
	10. Place the object in the Page Footer area.
	11. Click once on the Custom field “Group” that we just created.
	12. Click the Group Header icon.
	13. Move the Custom Field “Group” into the Group Header area of the report.

	Structured Query Language (SQL)


